Introduction to GIS with QGIS
for geologists
Clare Gordon
January 2024
Table of Contents

Learning GIS with this workbook
Last Modified: 25 Sep 23, 12:36:05
This workbook contains the exercises for a GIS course in the School of Earth and Environment at University of Leeds.
This workbook is provided in Word format. You can download alternative formats via Minerva, e.g. pdf or epub. Look for the link after the download. These alternative formats are not available directly from Clare.
You are welcome to keep your own notes within your copy of the workbook. An up-to-date version will always be available to you within Minerva. Updates may be made during the module based on questions from students and whether anything appears to be unclear. The date that each chapter was last updated will be just under the chapter heading.
If you are working with both Word and GIS open, you may find it easier to use the instructions if you use Reading view in Word. To try this go to View > Read Mode (Word Desktop app) or View > Reading View in Word online. The View menu will then let you change the background colour, the column width, and some other options. You will be able to change the width of Word and the text and images will scale properly.
To exit reading view, press the Esc key on your keyboard, or the Print Layout button at the bottom of the Word window. Hover over buttons to see a tooltip.
[image: images/svg/videocam-black-24dp.png] Office365 - assistive viewing features
This video clip can be found in the module area of Minerva or in the full list of video clips.
Software
The exercises in this workbook are written using QGIS and instructions for gaining access to the software are available in the software document in Minerva.
This workbook acknowledges use of QGIS: QGIS Development Team, 2023. QGIS Geographic Information System. Open Source Geospatial Foundation Project.
How to use these exercises
The following conventions are used:
Video clips of techniques are available in Minerva or in the list of videoclips. They aren’t fancy, just what you’d see if I gave a demonstration in class, but you may find them useful as a supplement to the written instructions.
They are shown as follows in the worksheets:
[image: images/svg/videocam-black-24dp.png] Spatial bookmarks in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Information boxes point out techniques that you may already know about. They are here as reminders, or as quick tips:
[image: images/svg/info-black-24dp.png] Adding a folder connection in the Catalog pane
If you can’t see your network drive or USB device in the list of folders when adding data or viewing the catalog you need to Connect to folder
For something you should do following previous instructions:
[image: images/svg/create-black-24dp.png] Change page size and orientation
Have a look for each of the tools suggested below and try them out to see what they do. Make notes in the spaces provided.
For a question:
[image: images/svg/help_outline-black-24dp.png] Question title
What do you think of this? Make your own notes either in the document (if you’re using the Word version) or in your own notebook.
For a warning - take note of these, they can often save you time and trouble:
[image: images/svg/warning-black-24dp.png] Warning
If you do x it won’t always work! Make sure that you do y.
For recommended reading related to the current section:
[image: images/svg/library_books_black_24dp.png] Recommended reading
Recommendations will usually be to books from the module reading list which is linked from Minerva.
Contact me
If you find any problems with these instructions, please get in touch with me giving full details of the section and the problem and I will do my best to correct it.
Email me at: c.e.gordon@leeds.ac.uk
Clare Gordon © 2023 The University of Leeds.
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Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
Introduction to GIS with QGIS
Last Modified: 08 Jan 24, 17:13:37
The background to GIS and why you are studying it will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate how to open a map project in QGIS
· select appropriate tools to navigate efficiently in a map project
· use layers to organise and display information on a map
· add information to a map layout and prepare it for printing or display
· demonstrate different ways of finding help when using GIS
Introduction to exercises for GIS with QGIS
As a GIS specialist you have been asked by the Yorkshire Dales National Park to produce a geological map of the area around Malham Tarn National Nature Reserve (NNR).
[image: images/introduction/MalhamTarn_small.jpg]
View towards the boat house over Malham Tarn.
For this first set of exercises I have created a basic geological map of the Malham Tarn area so that you can explore the GIS application and get used to the basic navigation and functions. In future sessions you’ll be learning how to prepare the data and setting up the basics for yourself.
Obtaining and opening the sample map
The sample map is based on British Geological Survey (BGS) data covering Malham Tarn in North Yorkshire and uses data from a range of sources with which you will become familiar during this module.
· Download the MalhamQMinerva.zip file from Minerva and save it so that you can remember where it is located.
· Create a new folder called gis on your computer - look at the box below to see where to create it.
[image: images/svg/info-black-24dp.png] Where to save your work
If you are on a University cluster machine you can create the folder on your m: drive. This includes your username in its title in the list of available locations.
You can create your folder in OneDrive, but you need to have this set up to sync to the computer you are using.
If you are on your own computer choose a location where you usually save your files. This could be on an internal drive such as c: or on a cloud drive. Note that if your location is automatically synced to a cloud drive, such as iCloud or OneDrive this may cause some problems with GIS, but we’re still working this out.
If you are using the University Virtual Windows Desktop create the new folder on the desktop. You will then need to remember to move it to your network drive or back it up to OneDrive before you log off the VWD.
To create the folder:
· Once you are in the right location right-click and choose New folder...
· Make sure you are inside the folder then unzip the MalhamMinervaQ.zip file.
· On Windows:
· In My Computer right-click on the zip file
· If you have 7zip installed go to 7-zip > Extract here - select the location to save the files to and click OK.
· If you don’t have 7zip [footnoteRef:60], right click then Extract here - select the location to save the files to and click OK. [60:  7zip tends to be more reliable for unzipping all files from the archive, but the internal Windows unzip usually does the job. Just be aware that you may find that some files are missing. If you do, try unzipping again. 7-zip is freely available to download and install on Windows computers. It is also available via appsanywhere] 

· The YouTube video on Zip files and QGIS by BurdGIS gives you more information about zip files for QGIS with Windows.
[image: images/svg/videocam-black-24dp.png] Using zip archives - viewing, unzipping and zipping (Windows)
This video clip can be found in the module area of Minerva or in the full list of video clips.
· On MacOS:
· See the YouTube video on How to Extract (Unzip) files on a Mac.
· Or see this Dummies article on How to Zip and Unzip files on your Mac.
[image: images/svg/warning-black-24dp.png] Warning
Zip files are compressed archive files often used for sharing multiple files as a single package.
You may be able to see the files inside of a zip file in your file manager or in QGIS, but if you don’t unzip the files at some point you will get stuck or be unable to do something.
If you are looking for a file in QGIS, or something isn’t working properly, always check via your file manager that the file isn’t inside a zip or 7zip archive.
Once you’ve unzipped the file you should have a folder called MalhamQ. Enter that folder and have a look at the contents. They should look something like the following image with two folders called vmd-raster_clb and vml-raster_bwr, and two files, one called Malham.gpkg and the other Malham.qgz.
[image: images/introduction/FolderContents_small.png]
The data inside the folder in the zip file for this project.
[image: images/svg/info-black-24dp.png] Enabling file extensions
You may find that you are not able to see file extensions on your computer, that is the .qgz or .gpkg that I mention above. It can be really useful to be able to see these so that you know what sort of files you are working with.
To turn the extensions on for a Windows computer do the following: Open the File Explorer; Click on the View tab and go to Show; Click the box next to File name extensions to be able to see file extensions.
For a Mac computer: Go to the Finder > Preferences menu; Select the Advanced tab; Tick the Show all filename extensions box.
Open the sample map
· If you are on a University of Leeds computer, start QGIS by going to Appsanywhere - instructions on using this will be given in class or you can find them in the Software document in Minerva.
· If you are on your own computer, or a non-University computer, open QGIS by searching for QGIS in the start menu of your computer.
· Once QGIS opens go to Project > Open.
· Navigate to where you unzipped the project files and select Malham.qgz.
· Click Open.
If you are on a computer with QGIS installed, or have already run it via Appsanywhere, you can also open QGIS by double-clicking on the .qgz file in the folder.
Be patient - it can take a while to open QGIS, particularly the first time you run it.
The image below shows how the project will look in QGIS when you first open it. Note that your version may look slightly different to mine as buttons and toolbars can vary in location and the colours of the contents of your map may look different too. If you are using a different version of QGIS to me, you may find that you get a notice at the top warning you about that. If that happens just ignore it or close it, it shouldn’t be a problem for you.
[image: images/introduction/QGISOpenProjectAnno.png]
The QGIS windows when you first open the Malham project. Your toolbars and buttons may look a bit different to mine.
The Browser Panel
The browser panel usually appears on the left of your map. In the image above it appears above the Layers panel, but this can vary.
If you can’t see the Browser panel in QGIS at the moment you just need to do the following:
· In the menu go to View > Panels
· Put a tick next to Browser in the list.
The browser panel allows you to explore spatial data, add data to your map, open projects and view the properties of files. You will find out more about how to use this as you go along, but for now make sure that you know where to find it.
The Layers panel
A lot of the work that you do in GIS will be layer-based. Each file that you add is a layer and will appear in the Layers panel on the left.
If you can’t see the Layers panel in QGIS at the moment you just need to do the following:
· In the menu go to View > Panels
· Put a tick next to Layers in the list.
The Layers panel allows you to see the contents of your map, turn them on and off, and control the order in which they draw. You will find out more about this later in this chapter, but for now make sure that you know where to find it.
Navigation in QGIS
Once you have data on a map in QGIS there are various tools which allow you to zoom in and out and move around the map view.
[image: images/svg/videocam-black-24dp.png] Map navigation tools in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Watch the video clip on “Map navigation tools in QGIS”. Then get used to moving around your map by following the suggestions below.
The Map Navigation Toolbar
Tools for zooming in and out and for moving around the map are available on the Map Navigation Toolbar and you can also use the buttons and wheel on your mouse.
[image: images/introduction/MapNavigationToolbarAnno.png]
The Map Navigation Toolbar.
If the toolbar isn’t already visible in QGIS go to:
· View > Toolbars
· Put a tick in the box next to Map Navigation Toolbar
[image: images/svg/create-black-24dp.png] Trying out navigation
Try out the following tools in turn on your map so that you are aware of what they do.
Pan - use the hand cursor to “grab” the map and move it around. You can also pan by holding down the mouse wheel, if you have one, and dragging the map.
Zoom in - click on the button, then on the map. Alternatively use the cursor to draw a rectangle over the map defining the area to zoom to. You can also use the middle mouse wheel to zoom in and out of your map.
Zoom out - click on the button, then on the map. You can also use the middle mouse wheel to zoom in and out of your map.
Full extent - click on this to see the whole map (if you have layers with lots of data you may need to be patient while the map loads again). You can zoom in on your map again if you wish.
Zoom to Layer
Zoom to Layer(s) is an extremely useful command to know and you’ll probably find yourself using it a lot. For example, if you have layers in the Layers panel but your map just looks like a white screen, try clicking on Zoom to Layer(s) to check that the layers are still visible.
· Right-click on the heading for ew060_settle_bedrock in the Layers panel.
· Select Zoom to Layer(s).
Your map should zoom out so that you can see a much bigger area. This will show all the data in the bedrock layer.
[image: images/introduction/ZoomToLayer_small.png]
The result of zooming to layer on the Bedrock geology layer. You should be able to see all the data in that layer now and some white space around it.
Changing the scale
Instead of zooming with the mouse wheel or the tools you can change to a specific scale, e.g. 1:100 000, using the scale box at the bottom of the window to select the scale you want.
This box always shows the current scale of the map and you can use the dropdown arrow to select preset scales. You can also type a scale in this box, particularly if the scale you want isn’t in the list.
[image: images/svg/help_outline-black-24dp.png] Finding the current scale
Look at the Scale dropdown at the bottom of the window. What is the current scale of your map?
· Click in the scale box at the bottom of the window and select 1:50000.
The map should zoom to the correct scale.
· Click in the scale box again, but this time type 10000 into the box, replacing the scale that is already there.
· Press Enter
Again, the map should zoom to the correct scale.
Spatial bookmarks
Spatial bookmarks enable you to go back to a view of your map that you have set up earlier.
[image: images/svg/videocam-black-24dp.png] Spatial bookmarks in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Using a spatial bookmark to move to a new location
The map of Malham has a bookmark set up to zoom and pan in to the area of Malham Tarn.
· In the Browser panel find the Spatial bookmarks subheading and drop it down by clicking on the small arrow to the left.
· Drop down the Project Bookmarks subheading.
· You should find a bookmark called Malham Tarn - double-click on that to zoom to the preset location and scale.
[image: images/introduction/BookmarksExisting_small.png]
The Browser showing Spatial Bookmarks > Project Bookmarks. Double-click on Malham Tarn to zoom to the bookmark.
Creating your own spatial bookmarks
To set up your own bookmark:
· Pan the map (i.e. move it) to a different location.
· Either right-click on the Project Bookmarks heading in the Browser or use the keyboard shortcut Ctrl+B to bring up the Bookmark Editor
· Give your bookmark a Name - something that will remind you of why you are creating it.
· The Extent should be correct, but click on Map Canvas Extent to be sure.
· Check that Saved in is set to Project Bookmarks
· Then click on Save.
[image: images/introduction/BookmarkEditor_small.png]
Setting your own bookmark in the Bookmark Editor.
Once you have saved your bookmark it should be listed in the Browser.
[image: images/svg/create-black-24dp.png] Check your new bookmark
Pan to a different area of the map and zoom in or out.
Now double-click on your new bookmark. Does it take you back to the correct area and scale?
Removing a spatial bookmark
To remove a bookmark that you no longer need just right-click on it in the Browser and click on Delete Spatial Bookmark.
· Delete your new bookmark now - you won’t need it again. Don’t delete the Malham Tarn bookmark, though.
Working with map layers in QGIS
Layers are an essential part of any GIS. As you build up the data for your projects you will be adding layers and carrying out operations on them, either individually or together, so it’s important that you understand how to control them.
[image: images/svg/info-black-24dp.png] Layers are a reference to a particular data source
An important concept to grasp is that each layer is a reference to a particular data source.
In practice the most obvious signs of this are that if you remove a layer from your map, you are not deleting it from your computer, it still exists there, but you are removing the reference to it from your GIS project.
There are other signs, but I’ll point those out as we go along. For now, remember that if you want to move the map project or share it with anyone else, the data sources on your computer need to stay with the map project. For example, if you want me to look at your map, but then just send me the qgz file, I won’t be able to see anything when I open the file. The data will not be present. If you need help from me, it is usually more effective to send a screenshot than try to send the whole project.
The layers in your map project are controlled from the Layers panel to the left of the main map window. Look at that now, following the video clip and instructions below.
[image: images/svg/videocam-black-24dp.png] Working with layers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
In the Malham project the layers include:
· ew060_settle_linear
· Contours
[image: images/svg/help_outline-black-24dp.png] Layers in the Malham map
What are the names of the other layers that you can see in the Malham map?
Viewing contents of layers
In the Layers panel:
· Click on the small arrow next to a layer to open and close the layer contents
· The Layers panel also acts as a key to your map and shows the symbols for map features.
[image: images/introduction/OpenLayerContentsAnno.png]
Clicking on the little arrows to open and close the layers.
[image: images/svg/help_outline-black-24dp.png] Looking at layer symbols
Have a look at the ew060_settle_linear layer in the Layers panel.
How many different symbols are shown, and what do they look like?
Can you link any of the symbols in the Layers panel with the equivalent symbols on the map?
Renaming layers in the Layers panel
You can make the layer names more useful by changing them in the Layers panel. This also means that names will be clearer later, when you generate legends prior to printing or exporting maps.
When storing GIS data on computer you usually need to make names short with no spaces, this makes them difficult to read. It’s good practice, therefore, to change this in the Layers panel so that the names become more “user friendly”.
Note that you are not renaming the original data file by doing this, but just how the name appears in QGIS.
· Select ew060_settle_linear in the Layers panel. You’ll see that the name includes underscores instead of spaces, this won’t look great in the legend on your map.
· To make this more readable press F2 on the keyboard, or right-click on the layer name and select Rename layer.
· Type the new name, e.g. Geological lines, and then press Return.
[image: images/svg/create-black-24dp.png] Renaming layers
Repeat this with the bedrock geology layer as well. Rename it to something like Bedrock geology.
Making layers visible and invisible
There will be times when you don’t want all the layers to be visible on your map, but you won’t necessarily want to remove them completely. It is simple to make layers visible and invisible.
· Click in the little box next to the Bedrock geology layer - the tick will disappear and so will that layer in your map.
· To make the layer visible click in the little box again.
[image: images/introduction/LayersVisibilityAnno.png]
The ticked layers are visible on the map. To make the layers invisible, untick the box next to the name.
You’ll notice in layers with multiple symbols that you can turn each symbol on and off individually too. For example:
· Fold down the linear geology layer (Geological lines), if it isn’t already opened out, so that you can see all the symbols.
· If you go to the Malham Tarn bookmark there are pink lines on the map to the south-west of Malham Tarn (you may need to make the bedrock layer invisible to be able to see them clearly). Also note the black and blue lines on the map.
· Untick the box next to Algal_band.
The lines showing the Algal bands should disappear from your map, but the other lines should still be visible.
· Make sure you tick in the box to make the Algal bands visible again. Also make sure you make the Bedrock geology layer visible again if you made it invisible.
Adding new layers
There are two simple ways to add new layers. Below I’ll show you how to use both with different types of data.
[image: images/svg/videocam-black-24dp.png] Adding new layers to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
But first, a warning…
[image: images/svg/warning-black-24dp.png] Warning
While it is possible to add data by dragging and dropping it from your file explorer it really isn’t a good idea to do that unless you really can’t add it any other way.
It might look as if it has worked at first, but things can go horribly wrong later. Instead use one of the following methods.
Adding layers to QGIS with the Browser panel
Have another look at the Browser panel on the left of the QGIS window.
Remember, if you can’t see the Browser panel do the following:
· In the menu bar go to View > Panels and tick in the box next to Browser.
Using the Browser panel you should be able to navigate to the folder in which you saved and unzipped your downloads.
If you have saved your data in the same folder as the map (which you should do) you should be able to find everything under the Project Home heading. Otherwise you’ll have to browse through the files on your computer.
Note that Project Home is different from the heading that just says Home. Make sure that you are looking in the former not the latter.
· If you can’t see any files under Project Home right-click on the Project Home heading and select Set Project Home... to browse to the correct folder. That should be the folder which contains the .qgz file that you currently have open.
Refreshing the contents of the Browser panel
Sometimes you can’t see all your files in the Browser even if you know they are there. This often happens if you have added or unzipped new files after opening the project in QGIS.
If this happens, don’t panic, you probably just need to Refresh the browser.
· At the top of the Browser panel look for the Refresh button and click on it. Remember that you can use tool tips to help you find the right button by hovering over the buttons.
[image: images/introduction/BrowserRefreshAnno.png]
The button to refresh the file list in the Browser panel.
Adding a different background to your map
We’ll see how to add a new layer by adding a different background map to the data that we can already see on the map.
· In the Browser panel in QGIS browse to your downloaded files and look for a folder called vml-raster_bwr
· Inside that folder there should be a file called vml-raster_4100507.tif
· Use the mouse to drag and drop that file from the Browser to the Layers panel.
The new layer will usually come in at the top of the Layers panel and you should be able to see a black and white map in the map area now.
If you can’t, try right-clicking on the new layer in the layers panel and Zoom to Layer(s).
[image: images/introduction/NewLayer_small.png]
The new vml-raster layer in the Browser and now added to the Layers panel and showing in the map.
Reordering layers for visibility
The new layer was probably added to the top of the list in the Layers panel and is covering up all the other layers.
The order of layers in the Layers panel affects how they appear on the map. Layers at the top of the list appear on top of the layers lower down. If you can’t see a layer and you’re sure it should be visible one thing to check is that it isn’t being covered up by another layer.
· To allow the other layers to show as well drag and drop the new vml-raster layer so that it is below the Contours layer, but above the vmd-raster layer in the Layers panel.
Your Layers panel should now look like the image below and the geological layers should be visible on your map.
[image: images/introduction/NewLayerOrder_small.png]
The layers panel showing the order of the layers. With the background layer below the geology layers, the geology will show on your map.
Using the Data Source Manager to add data
Dragging and dropping from the Browser panel is probably the easiest way to add data to your maps but as with so many tasks in GIS there is more than one way to add data to QGIS.
We’ll use the Data Source Manager to add some vector data, but the raster data that you added in the previous section could also be added this way [footnoteRef:148]. [148:  You’ll find out more about vector and raster data types as you go through this course and get more used to handling different datasets.] 

To use the Data Source Manager you do need to know what type of data you are adding, so as I said above, this will be vector data.
The vector layers in this map are all stored in a Geopackage called Malham.gpkg which is located in the same folder as the .qgz file that you opened.
[image: images/svg/info-black-24dp.png] Geopackage format
A Geopackage is a form of database specifically designed to store and retrieve spatial data efficiently. It has been relatively recently developed but it’s use as a GIS format has spread very quickly. QGIS encourages the use of geopackages and it is increasingly possible to use them in other GIS software.
During this course you will frequently use geopackages to store your spatial data. If you want more information about the format there is a lot on the GeoPackage website.
If you look at a geopackage in your file explorer outside of QGIS you’ll note that it looks like a single file, though if it is open in QGIS you’ll see a couple of “side-carriage” files with the same name but different extensions. If you look at the geopackage in the Browser in QGIS you’ll see that there is a little arrow next to it and you can drop that down to see the contents.
This is a big advantage to using the Browser in QGIS. It is specifically designed to work with spatial data and hides the side-carriage files.
[image: images/introduction/GeopackageInBrowser_small.png]
The Malham geopackage viewed in the Browser panel. There are five layers within the single geopackage.
To add the data via the Data Source Manager instead of using drag and drop:
· On the menu bar go to Layer > Data Source Manager or find the button on the toolbar by looking at the tool tips. You can also use the key combination Ctrl-L on your keyboard.
· Click on Vector in the list on the left.
· Then click on the button with three dots (ellipsis) next to the Source box
· Navigate to the Malham.gpkg geopackage and click on Open then on Add
· You’ll get a choice of vector layers to add - select National_Nature_Reserves_England
· Then click on OK. If the dialog is covering your map you won’t see any difference at this stage, but click on Close and you should be able to see that the layer has been added to the Layers panel and to your map.
[image: images/introduction/DataSourceManager_small.png]
Adding a vector layer from a geopackage with the Data Source Manager.
As before with the raster layer, this should appear in the layers panel and you should be able to see the Malham Tarn NNR covering your map. If you can’t use the spatial bookmarks to go to Malham Tarn and ensure that the new layer is on top of the raster-vml and raster-vmd layers in the layers panel.
You have quite a few layers on your map now, so if it’s getting a bit difficult to see what you are doing remember that you can make layers temporarily invisible by turning them off in the layers panel.
[image: images/svg/create-black-24dp.png] Add another layer to your map
Use your choice of either drag and drop from the browser or the Data Source Manager to add the ew060_settle_superficial vector layer to your map from the Malham geopackage.
The superficial layer should be above the bedrock geology and geological lines layers in your Contents pane so drag it there if it isn’t.
When you’ve checked that all your new layers are on your map make sure that you make the other layers visible again.
Removing layers
Your map may be looking rather a mess by now, so let’s clear it up. It’s always a good idea to remove layers that you don’t need as it keeps your Layers panel less confusing.
You won’t need the ew060_settle_superficial layer again so it can be removed.
[image: images/svg/info-black-24dp.png] Removing layers doesn’t delete the data
Note that removing layers from your map does just that. You are not deleting data from your computer. The data still exist but you are removing the link between the map and your data.
To remove data:
· Either right-click on the ew060_settle_superficial layer in the layers panel and Remove layer...
· Or select the layer in the Layers panel and use the keyboard shortcut - Ctrl+D.
· You’ll be asked to confirm that you want to remove the layer, click on OK.
This process is identical for both raster and vector layers.
[image: images/svg/create-black-24dp.png] Remove a raster layer
Use the instructions above again to Remove the vmd-raster_4100506 layer from your map. This is the background layer that was in your map originally, not the one you’ve just added.
Grouping layers
The Geological lines and Bedrock geology layers are related to each other and could be grouped together to organise the layers panel. Amongst other advantages this would make it easier to turn all the geological layers on and off together.
· Select both the Geological lines and Bedrock geology layers in the Layers panel by clicking on them with the Ctrl key held down on your keyboard.
· Right-click and Group selected.
· You’ll then get a chance to give the new group a name - type Geology as the new group heading. If you can’t type it, select the group heading and press F2 or click twice slowly to be able to type.
· Try making the new Geology group invisible to check that the layers are actually grouped. You should see both of the geology layers disappear from your map. Don’t forget to make them visible again!
[image: images/introduction/GroupedLayers_small.png]
The grouped geological layers in the Layers panel.
Repairing missing file links
If you are working on different computers or moving data around for some reason, missing file links within QGIS maps can become a problem. This section explains what that looks like when you open a map, how you can fix it, and possible ways to avoid it.
I’ve already said above, that “each layer is a reference to a particular data source on disk”. This has implications for how you manage your data, particularly if you are going to be moving your project from one computer to another or moving data around within your folders.
What happens if you move your data?
If you’ve followed the instructions above, you’ll be able to see several layers in your map and in the Layers panel.
What happens if you move these layers outside of QGIS? Let’s have a look.
· Save your map (Ctrl-S or Project > Save) and close QGIS.
· In your system file explorer, navigate to where you have saved the files for this project and go into the folder named MalhamQ.
· Create a new folder inside this one and call it Data.
· Move the Malham.gpkg file into the new folder.
· Also move the vmd-raster_clb folder into the new folder.
· Now reopen your map in QGIS.
[image: images/svg/help_outline-black-24dp.png] What happens when you open your map in QGIS?
What the first thing that happens when you try to open your map? Do you get a pop-up message?
You will probably get a popup window titled Handle Unavailable Layers which lists the layers QGIS can no longer find in their original location. (Don’t worry if you don’t get the popup, sometimes it doesn’t appear!)
[image: images/introduction/HandleUnavailableLayers_small.png]
The Handle Unavailable Layers popup showing the layers from your map which QGIS can no longer find.
It is possible to repair the broken links using this dialogue, but I find it easier to do so in the main map.
· Click on Keep Unavailable Layers on the popup to close it.
Your map should open, but will be blank. Have a look at the Layers panel and you should see small warning triangles on the right next to each missing layer.
[image: images/introduction/MissingLayers_small.png]
The warning triangles on the right of the missing layers in the Layers panel.
At this stage, don’t panic! As long as you know where the data files are stored on your computer, you can repair the links from QGIS.
Repairing broken links to data
[image: images/svg/videocam-black-24dp.png] Repairing broken links to data in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To repair the broken links in the Layers panel and restore the layers on your map:
· Click on the warning triangle next to the ew060_settle_linear layer.
The Repair Data Source window should open.
[image: images/introduction/RepairDataSource_small.png]
The Repair Data Source window. The Original Source URI at the bottom shows where QGIS thinks the data layer should be.
· Have a look at the bottom of the window - it shows you the Original source URI: - that’s where QGIS is looking for your layer.
· If you don’t know where your data has gone, use the Original source URI as a starting point to look for it. This will also tell you the name of the data file you are looking for.
Once you do know where your data is now located on your computer, you can easily repair the link by navigating to the data in the list of locations provided.
· In this case you moved your data into a folder called “Data”, so navigate to that in the Repair Data Source window and look for the Malham.gpkg file.
· Click on the little arrow next to Malham.gpkg and then click on the correct layer - ew060_settle_linear.
· Click OK.
[image: images/introduction/RepairDataSourceSelected_small.png]
Selecting the correct data source from within the Malham geopackage.
Once you click OK, you should find that the layer loads as expected and the warning triangle disappears. If you are selecting a layer from a geopackage, you may even find that all the layers from the same geopackage load. In this case, hopefully, the bedrock geology and contours should also appear on your map.
[image: images/svg/create-black-24dp.png] Repair the link for the final layer
The vector layers in your map should be loaded now. If not, repeat the process to load them.
You also have a raster layer on your map, and that won’t have loaded along with the vector layers. Look for vmd-raster_4100506. That will still have the warning symbol.
Use the same instructions as above to load the raster layer, but this time you’ll need to look in the vmd-raster_clb folder for the data, instead of inside the geopackage.
Once you’ve done this your map should be complete again and there should be no further warning symbols in the Layers panel.
Avoiding missing file links
If you know where your data files are located, you should be able to fix missing links now, but it would be better to avoid needing to in the first place if possible.
These are a few things to keep an eye on.
· Check Save paths are set to Relative:
· Go to Project > Properties and make sure you’re on the top tab - General settings.
· In the top section look for Save paths and check it is set to Relative not Absolute.
· Click on OK
This is usually set correctly by default, but it’s worth checking.
[image: images/svg/info-black-24dp.png] Relative file paths
Setting the save paths to relative instead of absolute means that if the drive letter changes, or if you work on a different machine, QGIS still looks for the data in the same relative location compared to the map, rather than expecting them to still be on the original machine.
When you download data or set up a new project, make sure you start with a single folder for the project and save everything for that project into that folder. Be disciplined. If you download something, move it to the project folder straight away or you’ll forget and lose it.
When you downloaded the Malham project, all the files are stored in the same folder. This means that if you want to move the project or save it to another drive, all the data is together.
You can move the main folder, or zip the whole thing and move that or upload it to OneDrive. You don’t need to worry about losing files.
[image: images/svg/warning-black-24dp.png] Warning
Please bear in mind that you need to be aware of where you are saving your files and take responsibility for that yourself. If you lose your files, I probably can’t help you to find them again as I don’t know where they are likely to be.
Changing the style of vector layers
At the moment your National Nature Reserves layer will be a default colour and will probably cover up other layers in your map because it isn’t possible to see through it.
Let’s change the styling of this layer and make the features transparent so that other layers are visible even if they are below them in the Layers panel.
Make sure that you can see the Malham Tarn NNR on your map by using the Malham Tarn spatial bookmark.
Changing the colour of a vector layer
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To change the colour of a layer:
· Select the National_Nature_Reserves_England layer in the Layers panel.
· Either press F7 on your keyboard, or click on the Open the Layer Styling Panel button at the top of the Layers panel - remember to use tool tips to find it.
The Layer Styling Panel should open to the right of your map.
· At the top of the Layer Styling Panel check that Single Symbol is selected.
· Underneath that click on Simple Fill to get full Fill and Stroke options.
[image: images/introduction/LayerStylingPanel_small.png]
Changing colours in the Layer Styling Panel.
· Click on the coloured box next to Fill color and select a new colour - use the sliders etc to “mix your own” or select one of the preset colours. You should see the fill of the NNR on your map change as soon as you click on a new colour, if not, check that Live update is ticked at the bottom of the Layer styling panel.
· Click on the back arrow button at the top of the panel to go back to the full options.
· Now click on the coloured box next to Stroke Color and select a new colour for the outline.
· Again, click on the back arrow button at the top of the panel to go back to the full options.
· You can also try changing some of the other options to see what effect they have.
When you’re happy with the general colours leave it at that for now.
· You can close the Layer styling panel either by clicking on the little cross in the top right or by pressing F7 on your keyboard again.
You’ll find out more about styles and colours later in the course.
Making a vector layer transparent
You now have your choice of colours, but the NNR is still covering the layers beneath it on the map.
We need to make the layer transparent by changing the opacity so that it is possible to see the detail of the layers beneath it.
[image: images/svg/videocam-black-24dp.png] Making vector layers transparent in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the National Nature Reserves layer in the Layers panel
· If the Layer Styling panel isn’t already open, open it by pressing F7 on your keyboard or clicking on the Open Layer Styling Panel button at the top left of the Layers panel.
[image: images/introduction/LayerStylingOpacity_small.png]
Changing opacity / transparency in the Layer Styling Panel.
· Make sure that Fill is selected.
· You should be able to see the Opacity slider - this controls the transparency. Move the slider to about 60% or type 60 into the box to the right.
· If you have Live update ticked at the bottom of the panel you should see the difference immediately, otherwise you’ll have to click on Apply.
You should now be able to see the background map through the National Nature Reserve polygons.
Feel free to try different settings of opacity to see how it works.
[image: images/svg/warning-black-24dp.png] Warning
It is also possible to change the transparency by using the Opacity setting in the Layer Rendering section of the Layer Styling panel, but I’ve found that if you do that the features don’t always remain transparent when you export your map to pdf.
Locating features in vector layers
Some of the layers in your map are vector feature layers and are searchable, for example, the National Nature Reserves and the linear and bedrock geology layers.
[image: images/svg/videocam-black-24dp.png] Locating features in vector layers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To search the features in a vector layer:
· Click in the Type to locate box at the lower left of the QGIS window or use Ctrl+K on the keyboard.
· Have a look at the list of options that pops up - it looks a bit confusing to start with but is simple to use.
[image: images/introduction/TypeToLocate_small.png]
Click in the Type to Locate box or use Ctrl+K on your keyboard to get a list of options.
· Type the following in the box: af Malham.
The af shows that you want to search for Features in all layers.
· As you type, a list of results will appear - double-click on New House Farm, Malham to go to the feature that you want to look at.
Note that Malham Tarn is in the list too, but see how clicking on the other result pans and zooms to the location, and makes the feature flash.
[image: images/introduction/TypeToLocateResults_small.png]
Clicking on one of the Type to locate results should take you to the feature that you chose. In this case a feature from the National Nature Reserves layer.
This can be a very useful way of finding things on your map if you are using vector layers.
[image: images/svg/create-black-24dp.png] Search and return to Malham Tarn NNR
Use Type to Locate to search for Malham Tarn and use the results to return to Malham Tarn NNR.
Identifying features in layers
It can be very useful to be able to click on a layer and find out the values of the area underneath the cursor. To do this you can use the Identify features tool.
[image: images/svg/videocam-black-24dp.png] Using the Identify Features tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Check that the Attributes toolbar is visible by going to View > Toolbars and checking that there is a tick next to Attributes toolbar.
[image: images/introduction/AttributesToolbarIdentify_small.png]
The Attributes Toolbar. The Identify Features button is highlighted.
· In the Layers panel click on the bedrock geology layer
· Click on the Identify Features button (highlighted in the image above), or use the keyboard shortcut Ctrl+Shift+I.
· Then click somewhere on the map.
· You may get a choice of layers from which to identify a feature, if so, choose the bedrock geology layer.
The Identify Results window should pop up showing a tree view of the value of the feature at the point you clicked on.
[image: images/introduction/IdentifyResults_small.png]
The Identify Results window showing the values for the feature that you clicked on from the bedrock geology layer. Note the dropdown next to Mode at the bottom which allows you to change how layers are selected.
If you don’t get the expected result, then the Mode may be set differently to the default. You can change this using the Mode dropdown at the bottom of the window.
· Set the Mode to Current layer and click on your map again. Your result should show just the layer that is selected in the Layers panel.
· Try setting the Mode to Layer Selection and click on your map again. Note that you now have to select the layer from a small pop-up menu.
· Now try setting the Mode to Top Down and click again. This time you should be able to scroll down and see results for all the layers which have data at that point.
[image: images/svg/help_outline-black-24dp.png] What is the bedrock geology at the point you clicked on?
Saving your map
Save your map projects at regular intervals.
You will be doing a lot of work on them and can lose a lot of time and effort if you have to do that work again because the program has crashed.
To save your map project:
· Project > Save or alternatively the keyboard shortcut is Ctrl+S
· If this is the first time you have saved a particular project, make sure that you remember where you save it to and give the file a name which will help you to remember what it is.
It is a good idea to save all your files to the same gis folder and make subfolders for each project which contain the map and all the data. The aim is to be able to find your maps and data again if you come back to them weeks or months in the future!
Backing up your work
It is also a good idea to keep back up copies of your map project along with its data files. Very occasionally problems can corrupt the whole file, particularly once you start editing so having a copy that you can go back to is invaluable.
The best idea is to zip (i.e. archive) your whole folder, assuming all the files related to your Malham project are in the same folder - one called MalhamQ.
· Make sure that your project isn’t open in QGIS first.
· Right-click on the folder - the command that you use to zip the folder will vary depending on your computer
· On Windows, if you have 7-zip installed you’ll be able to select 7-zip > Add to "MalhamQ.zip"
· If you are on Windows and don’t have 7-zip installed select Send To > Compressed (zipped) folder.
· On Mac see this Dummies article on How to Zip and Unzip files on your Mac.
· Once you have a zip archive file, e.g. MalhamQ.zip, select it and press the F2 key, or right-click and Rename and add the date to the filename, e.g. MalhamQ_2021-07-08.zip. The extension needs to remain as .zip.
· Now upload the zip file to your OneDrive or other cloud storage.
Selecting and intersecting two different layers
Now that you have your data in a GIS, why not take advantage of the power it provides you with? You can use GIS to answer questions about your data. For example:
Which bedrock geology features appear within 2 km of, and within, Malham Tarn NNR?
We can use Select by location and a couple of other tools to find the answer.
Selecting part of a feature class (layer)
Make sure that both the bedrock geology and the National Nature Reserves (NNR) layers are visible in your map.
Zoom to Layer on the NNR layer and you should be able to see that it covers the whole of England, not just the area we’re looking at.
[image: images/introduction/NNRFullLayer_small.png]
The NNR layer zoomed out to full coverage - it covers the whole of England.
To start with here we’ll create a new feature class which just includes the Malham Tarn NNR. This will make the next steps simpler and save time as you won’t be processing data that you don’t need. This is always a good thing to do if possible.
[image: images/svg/videocam-black-24dp.png] Select by Expression in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure that you have selected the National Nature Reserves layer in the Layers panel.
· Use the selection toolbar to choose Select by Expression (see image below) or use Ctrl-F3 on the keyboard
[image: images/introduction/SelectionToolbarAnno.png]
The Select by Expression button on the selection toolbar.
A new panel should open. Use the tools on the panel to fill in an expression to search for data.
· You will build the expression in the left-hand area, but start by going to the centre area. Find the Fields and Values heading and click on the little black arrow next to it to see the full contents.
· This gives you a list of the fields in the selected layer. Find nnr_name and double-click on it. The field name should appear on the left.
· Now click on the equals (=) button under the left-hand panel to add that to the search expression.
· Next go to the right-hand panel and type Malham into the Values search box and click on All Unique. You should find that there are two possible results.
· Double-click on the result which says Malham Tarn to add it to your expression.
The expression in the left-hand panel should now read:
"nnr_name" = 'Malham Tarn'
At this stage the Select by Expression panel should look like the image below.
[image: images/introduction/SelectByExpression_small.png]
The Select by Expression dialog showing the full expression in the left-hand panel.
· To check the result click Zoom to features at the bottom - if you move the window aside and have a look at your map you should have zoomed to the Malham Tarn NNR
· Click on the Select Features button at the bottom, that should make the Malham Tarn NNR be highlighted in yellow, then Close the Select by Expression dialog.
Export selection as new feature class
At the moment the selection is temporary. To make it permanent you need to export the selection as a new feature class.
· Right-click on the National Nature Reserves layer in the Layers panel.
· Go to Export > Save selected features as ...
· You’re going to save the new layer to the existing geopackage so next to Format check that GeoPackage is selected [footnoteRef:250]. [250:  You’ll find out more about geopackages and other GIS file formats later, so don’t worry if you don’t understand this yet.] 

· Click on the three dots button (ellipsis) at the right-hand end of the File name box and select Malham.gpkg, the existing geopackage which should be in your MalhamQ folder. Then click on Save. Never just type a new name in this box - you may never find the file again as you won’t be in control of where QGIS saves it to.
· Next to Layer name give the new layer a name that will remind you what it contains in future, in this case MalhamNNR should be good. Don’t use any spaces or unusual characters in the layer name.
· Check that Save only selected features is ticked.
· At the bottom of the dialog check that Add saved file to map is ticked.
· You don’t need to worry about any of the other settings now.
· Click on OK to export the selection.
[image: images/introduction/SaveSelectionAs_small.png]
Saving a selection as a new layer and adding it to your map.
The new layer should automatically be added to your map. To check this has worked properly Zoom to Layer on your new layer and check that the outline of the Malham Tarn NNR fills the map area.
[image: images/introduction/MalhamNNRzoom_small.png]
The map zoomed to layer on the new MalhamNNR layer. Note that your feature will probably be a different colour.
Now remove the original national nature reserves layer from the Layers panel so that it doesn’t confuse you later.
[image: images/svg/create-black-24dp.png] Change the style of the new NNR layer
The new Malham NNR layer has probably been added to your map with a solid fill. Go back to the instructions on how to change the style of vector layers and change the transparency and colour of the new layer so that it shows up well on your map, but the underlying layers are still visible.
Using the buffer tool
Now that you have a feature class or layer which contains just the Malham National Nature Reserve you can use that to select just those features from the bedrock layer which are within and close to the reserve.
First let’s have a look at the existing extent of the bedrock layer.
· Zoom to Layer on the bedrock layer.
You should find that you zoom so far out that it’s difficult to see Malham Tarn. The final map that you’ll produce will only need to show the area around the nature reserve, so you don’t need all the geological data.
To select only the bedrock data covering the area within 2 km of the NNR we’ll need to start by defining the enlarged area. To do this we’ll create a buffer using one of the many analysis tools in QGIS.
[image: images/svg/videocam-black-24dp.png] Using the buffer tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu select Vector > Geoprocessing Tools > Buffer...
As you go through this workbook you’ll get used to filling in the dialogs for the processing tools and they usually have various fields in common.
· The Input layer in this case will be your MalhamNNR layer - the one which only shows the Malham Tarn NNR. As that is already a layer in your map you should be able to just drop down the box and select it.
· The Distance will be 2 kilometers - use the two boxes to set this up correctly.
· You don’t need to worry about most of the other fields, but go to Buffered and click on the three dots button (ellipsis) at the end of the line.
· Click to Save to GeoPackage
· Select your existing Malham.gpkg geopackage and click on Save
· Type in a new Layer name - something which will make it clear in the future what this layer contains, e.g. in this case MalhamBuffer and click OK [footnoteRef:262] [262:  Note that if you tell QGIS where to store the output via the ellipsis button, the full file path is put into the Buffered box. If you just type your output name into the box QGIS will save your output to a default location and you will have difficulty finding it. Make sure you keep control over where you save your output so that you can find it again.] 

· Check that Open output file after running algorithm is ticked
· Then click on Run.
[image: images/introduction/BufferTool_small.png]
Filling in the dialog for the Buffer tool.
When the tool finishes running, Close it and zoom to your new layer - MalhamBuffer. You should have a roundish shape covering most of your map. If you drag it to below the MalhamNNR layer in the Layers panel you should be able to see that it covers an area around your original shape.
[image: images/introduction/BufferMalham_small.png]
The buffer covering an area extending 2 km beyond the original NNR.
You don’t actually need to be able to see this layer so just untick it in the Layers panel to make it invisible.
Intersecting two different layers
Now you can select the bedrock polygons (shapes) which cover the area extending 2 km around the nature reserve.
· Start by clearing any existing selections, just in case - just click on the Clear selections button on the selection toolbar (see the image below).
· Click the Select by Location button on the selection toolbar or go to Vector > Research Tools > Select by Location on the menu bar.
[image: images/introduction/SelectionToolbarAnno.png]
The Deselect features and Select by Location buttons on the selection toolbar.
In the dialog which opens:
· Select features from the bedrock layer on your map
· Where the features - tick next to intersect
· By comparing to the features from - enter your buffer layer using the dropdown box
· Check that Modify current selection by is set to creating new selection
· Now click on Run, then Close when it finishes.
[image: images/introduction/SelectByLocation_small.png]
Filling in the Select by Location dialog.
A large number of the bedrock areas should be selected - as shown by a bright yellow colour.
· As we did before, to save this selection we need to export it to a new feature class, so right click on the bedrock layer in the Layers panel and choose to Export > Save selected features as...
· Fill in the details for the file and layer name, selecting the existing geopackage.
· Check that it is set to Save only selected features then click OK
· Now turn off the original bedrock layer and zoom to layer on the new version.
[image: images/introduction/ExportedBedrock_small.png]
The exported bedrock layer.
You’ll see that this still covers quite a large area. Polygons or shapes are not clipped, so if a polygon is partially within your buffer, the whole of it will have been selected and exported. This can still save you a lot of data storage space and processing time if you are working with a lot of data though.
Copying styles from one layer to another
Unfortunately, the styling of the original layer has not been applied to the new layer, but it is possible to copy and paste styles from one layer to another.
· Right-click on the original bedrock geology layer and go to Styles > Copy Style > All Style Categories
· Now right-click on the new bedrock geology layer and this time go to Styles > Paste Style > All Style Categories.
The new layer should immediately be styled with the same colours and styles as the original layer.
[image: images/svg/create-black-24dp.png] Select, export and style the linear layer
Carry out the steps above again to restrict the linear geology layer to the area 2 km around the NNR.
Again, copy and paste the style to make the output look the same as the original layer.
You now have a map which shows only the types of bedrock which occur within 2 km of the Malham Tarn NNR.
Laying out a map for printing or exporting
So far we have been working on the map view. If you print or export the map from here you have little control over its appearance. To produce a professional-looking map you need to use a layout. The information given here is just a quick introduction, you’ll cover layout and presentation in more detail in a later chapter.
I’ve set up a basic layout for you. To open it:
· In the menu bar click on Project > Layouts > Malham Tarn A4
The layout should open in a new window and look something like the image below.
[image: images/introduction/Layout_small.png]
The Layout window showing the Malham Tarn National Nature Reserve layout.
The main area shows the “page” with the current layout. On the right you’ll see the Item Properties which depend on which item from the layout is selected.
The current layout includes three items, the main map, the scale bar and the key.
· Click on the map frame, i.e. the area of the actual map, to see the Properties, such as the scale.
· The map frame can reflect the layers and view on your main map so go back to that and go to the Malham Tarn spatial bookmark.
· Return to the layout and with the map frame selected click on the left-hand button at the top of the Item Properties to Update Map Preview - the button has a tooltip.
· Try out some of the tools from the toolbar on the left (yours may be at the top of the map). Remember you’ll see a tool tip if you hover over the button.
[image: images/introduction/LayoutToolbox_small.png]
The Layout toolbar - it could be either to the left of the map or above it.
· The first four tools control how you select and move items on the layout - the Select/Move Item button is probably already selected, so try using your cursor to drag the map on the layout.
· If you wish to undo an action either click Ctrl-Z on your keyboard or Edit > Undo... on the menu bar.
[image: images/svg/help_outline-black-24dp.png] What happens if you try to do the same thing with the Move Item Content button selected?
A lot of the other tools add a new map element. You’ll get instructions for many of these later.
Don’t worry if you make a mess of the map! This chapter is just about learning the basics so explore and see what happens. If you want to, you can always delete the whole folder and download another copy from Minerva.
Adding elements to the layout
Most of the maps that you create will need to be printed out or exported with additional elements such as a title, a key or legend, a scalebar and some text. I’ve already added a measured grid and a scalebar to this layout. You’ll add a title and copyright text to this map, but you’ll learn more about layout in a later chapter.
To add text to a layout
The most obvious thing missing from this layout is probably a title. Let’s add one now.
[image: images/svg/videocam-black-24dp.png] Adding text to a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Either find the button for Add Label on the toolbar, or in the menu bar go to Add Item > Add Label
· Click and drag somewhere on the top of the page to create a text box.
· In the properties on the right click in the box which currently says Lorem ipsum
· Type the following text as a title
The geology of the Malham Tarn National Nature Reserve
· Use the buttons below the box on the Item Properties to change the font and make it larger
· change the Horizontal alignment to Center
[image: images/introduction/TextProperties_small.png]
The text properties panel - type in your text and then change the font size etc with the options below.
Try out some of the other options to make the title clear on your layout. This is a great opportunity for you to make your own decisions about how your map will look.
Copyright acknowledgement
Copyright acknowledgement is important! Always check the terms and conditions for any data that you use. Most will tell you the wording that you should use - though it can take a bit of finding sometimes!
The National Nature Reserves data is under the Open Government Licence[footnoteRef:297]. So add the text below to your map. [297:  More information about the Open Government Licence is available on the National Archives web site.] 

Contains public sector information licensed under the Open Government Licence v. 3.0.
The background map is from the Digimap service (you’ll find out more about this later in the course). For this you need to add the following acknowledgement:
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
The geological data is also from Digimap, but this time provided by British Geological Survey. The following acknowledgement is correct for this data:
Geological Map Data BGS © UKRI year.
Again, year should be replaced by the current year.
[image: images/svg/create-black-24dp.png] Adding copyright information
Add both of those bits of text in a small font size near the bottom of the layout. You start with the same button you used to add the title above.
To add the © symbol (on Windows) put the number lock on the keypad, hold down the Alt key, type 1 6 9 then let go of the Alt key.
Note that while you do have to include data acknowledgements for any data that you use on your maps, the text does not have to be very obvious. You should use a small font size and tuck the text in an unobtrusive corner of your layout.
Adding your name / ID and the date
You should always add your name to your maps as the Creator. In the case of assessments, you should add your Student ID instead. Remember that your ID should be on every page of any submissions.
In addition it is a good idea to add the date. Features “on the ground” will inevitably change and it will be useful to know when your map was created.
[image: images/svg/create-black-24dp.png] Adding a name and date
Using the instructions for adding text add your name and the date to your layout.
Printing or exporting a map
To export the map to pdf or an image
· Go to Layout on the menu bar and select either Export as image... or Export as pdf...
· Choose where to save your export and what to call it
· Click on Save - for now just accept the defaults and click Save again.
Have a look at your exported layout and check that you are happy with it. If not, go back and make any alterations that you want to make and export it again.
To print your layout (don’t worry about doing this now, it’s just here in case you need to later):
· Layout > Print... from the menu bar
· Set up the printer as you would normally and click on Print
Suggested final layout
Your final map could look something like the image below. It is unlikely to look identical as you should make your own decisions about where to place elements and how to display your map.
Don’t forget to check that you have all the correct layers switched on in the Layers panel. The easiest to forget is the contour layer.
[image: images/introduction/FinalMap_small.png]
Possible layout for the Malham Tarn map. Your map probably won’t look identical to this as you should make your own decisions about how to lay it out.
[image: images/svg/create-black-24dp.png] Getting feedback on your map
Export your final layout and upload it to your Class Notebook personal GIS portfolio as instructed in class. If it is uploaded before the next class I will give brief feedback on your work.
If you have any questions about what you have done you can ask them in the class, in the drop in class or via email.
Recommended reading: Introduction to GIS
Many of the books in the reading list[footnoteRef:314] have a general introduction to GIS which explain what it is and how it is used. Suggestions include the following: [314:  The reading list is available in Minerva and from the library (search for the number of this module - SOEE1630).] 

· Chapter 1, What is GIS? in Heywood, I., Cornelius, S. and Carver, S. (2011), pp. 2-30
· Chapter 1, Systems, Science and Study in Longley, P.A. et al. (2011), pp. 3-37
Finding help for QGIS
There is a lot of help available for QGIS online.
The obvious place to start is the Documentation section of the QGIS website. Select the documentation appropriate to the version of QGIS that you are using, e.g. 3.16. The page includes links to:
· User guide / Manual
· QGIS Training manual
· A gentle introduction in GIS
These go into different levels of detail but all are very useful to have bookmarked.
If you go on to YouTube there are a lot of videos showing techniques in QGIS. Search for QGIS then whatever you are trying to do. Keep an eye on which version of QGIS the clips show as techniques can change with the version. Particular recommendations include videos by the following:
· Klas Karlsson
· Hans van der Kwast
· Digital Geography
Finding spatial data to use in GIS
Last Modified: 08 Dec 23, 12:33:48
The background to finding data will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· find suitable data for GIS projects from a variety of sources.
· acknowledge and cite the data that you use in your maps in a suitable fashion.
Introduction
Being able to find, download and prepare your own data is an essential part of using GIS. While the data will be provided for you for many of the exercises in this module, you will find it useful to have some idea of where the data comes from, and what there is available for you to use for your own maps.
While downloading shouldn’t take too long, don’t leave it until the last minute before you have to produce a map. Websites can become unavailable either permanently or temporarily, or computers can crash.
Digimap
Digimap is a service provided to Higher Education in the U.K. by EDINA at Edinburgh University. Digimap provides a front end to digital maps and data of Great Britain from the Ordnance Survey and British Geological Survey, amongst others. The University of Leeds subscribes to the collections and as a student you have access to maps and data for use as part of your studies.
Logging in to Digimap
If you have not used Digimap before you will need to register and log in using your University ID, that is the username and password that you use to access University systems such as Minerva.
Full instructions for logging in are on the Digimap help pages.
· Go to the Digimap Collections page at https://digimap.edina.ac.uk
[image: ../../shared/docs/images/finding_data/login2023_small.png]
The Digimap initial page - note the “Log in” button at top right.
· Click the Log in button at the top right of the screen.
· type Leeds in the box and select University of Leeds from the list of available institutions.
· You should get the familiar University of Leeds log in page, so type your University username and password into the appropriate boxes and then click the Log in button. If you are already logged in to Minerva, you may find that you don’t have to enter your login details again.
If this is the first time that you’ve logged in to Digimap you’ll be asked to register for each collection separately, though you can do all at one go. You won’t need to use all the collections during this module, but it’s worth registering for all that are available to you so that you can explore them for yourself.
· Go through the list of collections, read and accept the conditions for each one, selecting Academic Works (coursework, projects, dissertations etc.) in the Purpose dropdown for each.
Once you submit all those, you should be taken to the Digimap initial page again, as shown below, but this time you should see your name at top right rather than the log in button.
[image: ../../shared/docs/images/finding_data/ChoosingDataCollection2023_small.png]
The Digimap main page again, this time with your name at the top right. You can now select a collection from the menu across the top.
The list includes options for several collections. In this workbook we’ll only be looking at the collections that are the most relevant for creating the maps you’ll need during your course, but if you are interested in any of the others feel free to explore them. EDINA have worked to make all the tools similar across each collection, so just have a go!
Browsing maps on screen
Digimap has recently changed the interface (Summer 2023) so the previous separate links for browsing (Roam) and downloading are now combined. If you used the previous version of Digimap, the new interface offers all the same functions but in a slightly different way.
· As an example of the Digimap interface, which is similar in all collections, click on Ordnance Survey on the menu at the top of the main screen.
· Then select OS Digimap under View maps and download data on the right.
[image: ../../shared/docs/images/finding_data/OSDigimap02_2023_small.png]
Click on OS Digimap to enter the application.
[image: ../../shared/docs/images/finding_data/OSDigimap01_small.png]
The OS Digimap interface for Ordnance Survey data.
Now try browsing the maps.
· Have a go at zooming in and out and exploring the map at different scales.
· Try searching for a location in the Search places, coords, postcodes... box at the top left, for example type in Leeds and press <Enter>. From the list that appears click on Leeds (Leeds) then use the cross at the top of the list to close it.
In this module we’ll be making most use of the Download functions, but it’s worth knowing how to browse the maps too, so have a quick go with a few of the tools on the left before continuing with the next exercise.
If you want more information about using the browsing interface have a look at the Digimap Help Centre which is linked from Help on the main page.
Downloading data from Digimap
As well as browsing data on screen you can download data from Digimap for use in GIS or CAD software. The format that the data is delivered in will determine whether you will be able to open it directly in a software package or whether you will need to convert it.
We’ll be using data from Digimap in QGIS for various exercises in the rest of this module, so you need to know your way around this section. Instructions for converting, importing and viewing file types that need it will be given later in the workbook.
As an example of the download interface, we’ll download some Ordnance Survey data but all the collections work in a similar way.
· If you’re not already in the OS Digimap interface, start from the Digimap main page (you can get back to it by clicking on the icon at the top left of any of the maps - hover over to see a tool tip).
· click on Ordnance Survey in the menu at the top of the page.
· from the right-hand side of the Ordnance Survey page choose OS Digimap.
[image: ../../shared/docs/images/finding_data/OSDigimap02_2023_small.png]
Click on OS Digimap to enter the application.
You’ll be in the same map as the one in which you were able to browse maps.
· To get to the download options, click on the Download Data option at the bottom of the left-hand menu.
The options will change to those for downloading data.
[image: ../../shared/docs/images/finding_data/OSDigimap03_small.png]
The download interface to download Ordnance Survey data.
Selecting an area
On the left there is a menu panel with options for selecting an area, with a search box above it.
[image: ../../shared/docs/images/finding_data/DownloadSearch2023_small.png]
Digimap Download - search for and select an area.
· Click in the Search places, coords, postcodes... box and type Otley, then press <Enter> or click on the magnifying glass to search.
· When you get the results click on Otley (Leeds) to zoom to the correct area, then close the search results.
· Under Draw click on the rectangle and use the mouse to draw a box around the area shown by an orange box in the image below, clicking once to start and again to finish the box. It doesn’t matter if the box you draw is a bit bigger but try not to make it any smaller.
[image: ../../shared/docs/images/finding_data/DownloadArea.png]
The minimum area to select using the rectangle tool.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Area view
Note that the map you see on the screen only shows the area that you will be downloading data for, not the actual data that you’ll be downloading. You’ll select the data in the next section so don’t worry what it looks like for now.
Selecting data sets
Now that you have selected an area you have to select the data that you need.
· Back in the panel on the left, under Select Data Products, drop down each of the headings, e.g. Backdrop Mapping, in turn by clicking on the arrow next to them.
[image: ../../shared/docs/images/finding_data/DownloadChoices.png]
The list of data products - click the arrow next to each subheading to see the full list.
· There are a lot of different data sets here and most of them won’t mean anything to you. For now select the following data sets when you find them, by putting a tick in the box next to them.
· Backdrop mapping > VectorMap Local Raster
· Land and Height data > OS Terrain 5 Contours
You can get more information about the data sets by clicking on the arrow next to them. This includes information on licences - which you will need to know later.
The number on the right in brackets under Order Size shows how many tiles your selected area uses out of the maximum downloadable number. If you have chosen a slightly different area to me your number may be different, but you should still be well within the limit.
[image: ../../shared/docs/images/finding_data/DownloadDatasetsInfo.png]
Selecting datasets. The image shows the information for the VectorMap Local Raster dataset and that I am going to download one tile out of the maximum limit of 400.
· When you have selected the data you require click on Add to Basket (Don’t worry, despite the Basket and Checkout you won’t be charged. The University has already paid the subscription.)
Your basket should appear with details of your order.
[image: ../../shared/docs/images/finding_data/DownloadBasket2023_small.png]
Details of your order in the Basket. Yellow highlights show choices that you need to make before you can request download.
· Some datasets will give you an option to change the format. In this case click on Select Format next to the OS Terrain 5 Contours. The choices are Shape, GML3 or DWG. Choose Shape in this case.
· You may also need to select a theme. For the VectorMap Local Raster there is a choice of themes - pick Black and white for this exercise, though it is worth downloading the others to have a look at them too.
· Some items will have a Clip option. This means that the data will be sent to you clipped to the area outline that you requested. If you are short of disk space this is very useful as it restricts the amount of data you need to download, but otherwise it doesn’t hurt to have extra data around the outside of your study area. I prefer to untick this box and download full map tiles.
· Give the order a name, e.g. OtleyOS (for Ordnance Survey). This will be part of the file name of the zip file that you download, so try to make it short but helpful!
· Click on Request Download
Downloading your data.
You’ll receive an email confirming your order, then another with a download link. This can sometimes take a while to arrive, depending on how busy the service is.
Make sure that you are still logged in to Digimap before you click on the download link.
[image: ../../shared/docs/images/finding_data/DownloadLink.png]
The download link in the email - click on this to download your data, not on any of the other links in your email!
Once you have clicked on the link a browser window should open telling you that your order is ready to download.
[image: ../../shared/docs/images/finding_data/DownloadDownload2023_small.png]
Order ready to download, showing the name and size. Click on the Download button.
· Click on Download
You’ll download a zip file. Make sure you save it to your computer.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
• Make sure that you remember where you have saved the zip file.
• Don’t run or open the file directly from your browser, and make sure that you DON’T save your zip file to a temp folder where you will probably be unable to unzip it.
Now open File Explorer (in Windows) and navigate to the location where you saved the zip file.
· Right-click on the compressed map data file that downloaded and choose to Extract files... - or 7-zip > Extract files... if you have 7-zip available.
· Select where you want to save the extracted files, and make a note of where you save them to
You should end up with a folder for each dataset that you requested plus text files showing citations and contents. The folders will also have the order number as part of their name.
[image: ../../shared/docs/images/finding_data/DownloadUnzipped.png]
The unzipped Ordnance Survey data showing the folder for each dataset and text files containing citations and contents lists.
Viewing your data
In this case the files that you have downloaded are either tiff graphics files or shapefiles.
· Navigate to the data that you downloaded in the file explorer and find the folder called something like vml-raster_bwr_3612556 (your order number will be different).
· You may also need to go into a folder with the OS grid letters - in this case for Otley it will be se
· Open one of the .tif files by double-clicking on it - the file should open in a graphics program, but that depends what you have set up on your computer. Don’t worry if it doesn’t!
You should be able to see that this is basically a “picture” of a map.
· Try opening one of the .shp files from the terrain-5_3612555 folder too. It’s unlikely that you’ll be able to. Just cancel that and don’t try finding software that will open it!
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Both folders will contain files that have similar names to the .shp and .tif files, but different file extensions. These are known as “side-car files”.
They won’t open in any programme but are essential for using the data in GIS programs such as QGIS, so make sure that you always keep these files together.
Both of these formats will open in QGIS in the same way that you added data to your map in the Introduction to GIS.
This time you don’t need to keep the files that you have just downloaded, just remember how you downloaded data from Digimap. You’ll get used to doing that for future exercises.
Copyright acknowledgements for Digimap data
Copyright is important. Remember that most data providers ask you to sign up to conditions that include an obligation to add a copyright acknowledgement to your map. Check what that copyright statement is and add it.
When you signed up to use the Digimap collections you agreed to add copyright acknowledgements whenever you created a map with the data. The wording does change from time to time so it’s worth knowing how to check it for yourself.
To find these copyright acknowledgements:
· go back to the main Digimap home page
· go to the Digimap Help Centre (Help at the top of the main Digimap page)
· Click on the link to Copyright and Licensing from the Help page.
· In the list on the left click on the Educational User Licence for the data that you’ve used - in this case the Ordnance Survey Educational User Licence.
· then look for the information under In return, you must: - that gives you the acknowledgement text.
For example, as of September 2023, when you use Ordnance Survey data obtained from Digimap you are expected to add the following text to your maps.
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
This changes from time-to-time, so it’s worth checking when you’re using it for maps for coursework etc.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Adding the copyright symbol to your text
To add the copyright symbol - © - to your text (on a Windows computer)
• check that the Num lock is on on the keyboard
• hold down the Alt key on the keyboard
• then use the number pad to type 0169
• release the Alt key
Remember that you do have to acknowledge each different dataset that you use and will have signed up to that when you registered.
If you are not using U.K. Ordnance Survey data, this is not the correct copyright acknowledgement to use. For example, if you are using data for Spain or the United States, or indeed UK data that you haven’t downloaded from Digimap. You’ll need to find the correct copyright acknowledgement for yourself.
Citing maps and data from Digimap
Advice on citing Digimap data, as opposed to the copyright acknowledgement is given in the Copyright and Licensing section of Digimap Help.
The Digimap page says the following about when you should cite your data using the citations from the text file included in any download:
The citations in this document should be used to reference the maps and data when they have been included in any essays, dissertations or other academic works. You should cite the data even if it doesn’t appear as an image or map in your work if it has been used to generate findings or a new dataset that is used. (Citing Digimap Collections. Last accessed: 19th September 2023.)
The GIS Lounge page on How to cite GIS materials gives some information about citing the software as well as the data. Have a look at that and follow the suggestions to cite non-Digimap data.
Other Digimap collections
In addition to Ordnance Survey Digimap you will also find that you’ll make use of some of the other collections, in particular Geology Digimap and Aerial Digimap. The Roam and Download interfaces work in a very similar way to the Ordnance Survey collection so you should find that you already know how to use them.
You have access to all these collections so feel free to have a look at what is available and to make use of any of the data or maps in your work in the future.
Try exploring the suggested collections to answer the following questions:
[image: images/svg/help_outline-black-24dp.png] What was on the site of the University of Leeds back in the 1890s?
• Go into the Historic Digimap Collection to look up the University of Leeds (search for the postcode LS2 9JT) using old maps.
• Try the 2 up view to see how you can compare old and new mapping of the same area.

[image: images/svg/help_outline-black-24dp.png] What is the bedrock geology under the Student Union Building at the University of Leeds?
• Go into the Geology Digimap collection to find the Student Union (search for coordinates 429306,434578 to get a marker on the map.)
• Click on the feature information button at the top of the map, then on the marked building on the map.
A Feature information window should pop up. What Rock Unit does it give?
Digimap Collections online help
Digimap help is available from each of the collection pages. Click on the Question mark button at the top of the map to go directly to the Help pages.
You may find the Learning Materials particularly useful if you want to know more about how to download and use different formats of data. This section includes some case studies and webinars.
Data from the web
EDINA Digimap provides a wide range of useful data covering the UK, but you are also likely to need data from outwith the UK, or UK data that isn’t provided by Digimap. It isn’t possible to cover everything in this session, but I will show you a couple of sources which you should find useful. You’ll discover others as you go through the rest of this course.
Natural Earth Data
Natural Earth is a free, public domain dataset consisting of raster and vector data that will allow you to make maps at general scales. If you want a map of the World, or a general map of a particular country, this is a good starting point.
· Start by going to Natural Earth in your browser.
[image: ../../shared/docs/images/finding_data/NaturalEarth01.png]
The Natural Earth front page. Free vector and raster map data at three general scales.
The front page gives an overview of the principles behind the data and an idea of the scales at which it is available. You can find more information under the Features tab, including the file formats and the coordinate system - both important for using the data within GIS.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Natural Earth data
Go to the Features page and make a note of the file types of both the raster and vector data provided by Natural Earth and of the coordinate system that the data comes in.
To download data either
· Click the Get the Data green button on the front page.
· or click on the Downloads tab at the top of the site.
· Choose the scale that you want to download and the type of data that you want, e.g. cultural, physical or raster.
For this exercise download the following data:
· Medium scale data, 1:50m > Cultural > Admin 0 - Countries - click on the Download countries button to download a zip file. Make a note of where this file is saved to on your disk.
· Medium scale data, 1:50m > Raster > Natural Earth 1 - click the Download small size button under Natural Earth 1 with Shaded Relief and Water. Again, make a note of where the zip file is saved.
Keep these data layers for later exercises. Make sure you put the zip files into your GIS folder.
Have a look at the summary of the data on the Features page. If you wish, try downloading other datasets. You can try adding them to a blank map in QGIS in the same way that you added data in the Introduction to GIS.
Natural Earth data copyright
Finding and acknowledging the copyright of data is very important.
· Return to the Natural Earth front page
· Look at the text in the box next to the Get the Data button. One of the links there is to the Terms of Use page. Click on that now.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Acknowledging Natural Earth data
Read the Terms of Use of Natural Earth data
How should you acknowledge the Natural Earth data if you use it in one of your maps?
The terms of use do say that “Crediting the authors is unnecessary”, however, it is still a good idea to add the data acknowledgement to your map to avoid any possibility of plagiarism. You can choose whether to use the short or long text listed on the page. Adding the url of the data can also be a very good idea.
XYZ Tile maps in QGIS
If all you need is background map and you don’t need to be able to make changes to it then QGIS XYZ Tile maps are probably the easiest solution. They make use of OpenStreetMap (OSM) data - be aware that this is crowd-sourced, and quality and coverage vary.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding an XYZ Tile Layer to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open QGIS - you can leave it on the welcome screen or open a new blank map by clicking on the New Project button on the toolbar or pressing Ctrl-N on your keyboard.
· In the Browser panel look for the XYZ tiles heading.
· Double-click on the OpenStreetMap layer to add it to the new map.
You should find that you have a World map and can now zoom in to wherever you want and pan around. Try that now to see the level of detail that you can get. Note that the level of mapping does depend on how actively particular areas have been mapped.
Adding XYZ tile layers with an API key - Thunderforest API
By default the XYZ Tile choices include OpenStreetMap and maybe a couple of others (don’t worry if it doesn’t!). OpenStreetMap doesn’t need an API key and won’t have a watermark across it, others may do.
By signing up for an API key (API = Application Programming Interface, but don’t worry, we won’t be doing any programming!) you can extend the number of possible background layers you can use.
To add an API key:
· Sign up for one on Thunderforest website. You can do so for free as Hobby Project (free), but get a limited quota of views. This shouldn’t be a problem if you are just using it as a map background on your desktop.
· Once you have an API key you can see list of urls at bottom of page. Select and copy one of these, e.g. Outdoors. There is a gallery of the map styles you can check.
· In QGIS look for the XYZ Tiles subheading in the Browser panel.
· Right-click on XYZ Tiles and select New connection...
· Give the new layer a Name, e.g. Outdoors (API).
· Next to URL paste in the url that you copied, which should include your personal api key, then click OK.
[image: ../../shared/docs/images/finding_data/XYZConnection_small.png]
Setting up the XYZ tiles connection using the link from Thunderforest.
· Now you should be able to find the layer in the list of XYZ Tiles and drag and drop it into the Layers panel as you would any other layer to add it to your map.
· If you wish to edit the settings for any of the XYZ Tile layers right-click on them in the Browser and select Edit....
[image: ../../shared/docs/images/finding_data/XYZTiles_small.png]
Loading XYZ tiles - the Thunderforest Outdoors layer is displaying in the map window.
[image: images/svg/create-black-24dp.png] Add the Thunderforest Atlas layer to QGIS
Now that you have signed up for a Thunderforest api key, look for the URL for the Thunderforest Atlas layer. This is a nice clear layer that you should find useful as a background map.
Adding a Bing Aerial layer
Tile layers are becoming more widespread, and you may be able to find other data to add to the list. If you do, there should be a URL which you can add in the same way as the Thunderforest urls above.
For example, it is possible to add a Bing aerial layer as XYZ tiles. I found this URL by searching for Bing satellite tile maps qgis then browsing some help pages.
· Try adding the following URL to the same map as the OpenStreetMap layer you added above.
       http://ecn.t3.tiles.virtualearth.net/tiles/a{q}.jpeg?g=1
If you need to change an entry later simply right-click on it in the Browser panel and click on Edit.
Once you’ve added a layer it should stay in the list in your Browser panel for you to use again in future.
Finding other data online
These are just a few examples of finding useful data for GIS. Throughout the rest of the workbook you’ll be downloading your own data from Digimap. If you need data from elsewhere, I’ll either give full instructions or provide the data for you, but tell you where I got it from.
If you are looking for data for a particular project it is well worth searching online using your favourite search engine (e.g. Google). Put the words “gis” and “data” into your searches and it should help you to find relevant data.
I have put together a short list of possible data sources which you are welcome to use to find data and maps.
Optional section: ArcGIS Living Atlas of the World
This section is optional. You can work through it to find out about some more layers you can add to your maps in QGIS.
If you don’t have time to do this section now, you can come back to it later if you wish to.
The ArcGIS Living Atlas of the World is an extensive collection of map layers and maps curated by a company called ESRI. ESRI produce commercial GIS software, ArcGIS, which is similar to QGIS but is not Open Source. Some of the data is only available if you subscribe to ArcGIS Online, but even without subscribing there are a lot of datasets available to use as background layers. This section will give you an idea of what is available and how you can use the layers in your maps in QGIS.
Finding ArcGIS Living Atlas layers
The ArcGIS Living Atlas is online at https://livingatlas.arcgis.com/en/home/
The first page gives you an overview of the atlas. It’s worth having a look at this to see what new layers and maps have been added.
Once you’ve done that:
· Click on the Browse tab at the top of the page.
[image: ../../shared/docs/images/finding_data/LivingAtlasBrowse_small.png]
The Browse page for the Living Atlas. Note the search box at the top, and the filters below that. The main part of the page is the full list of maps and layers.
The Browse page allows you to use filters to limit the data, as well as to search.
I’ll start by showing you how to find and add layers to QGIS, then you can do some searches for yourself and see what you can find.
We’ll start by finding a background map of the Oceans and adding it to QGIS. This could be useful if you need to produce a map for a report showing a particular area of the ocean floor with some of your own data on top of it.
· Type World Ocean Base into the search box on the Browse page.
The list of results will appear below the filters. Have a look at the options you are given.
Make sure the option to view the List is selected from the three buttons above the list. You’re given more information in a clearer format if you select this.
[image: ../../shared/docs/images/finding_data/LivingAtlasResults_small.png]
Viewing the results of your search in List format.
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] What types of layers are available?
Look at the information next to each of your results. You’ll get a summary of what the layer or map shows, but you’ll also be shown the Type and the Contributor.
What types of layers do you have available to you?
Not all the layer types are suitable for use in QGIS. You will be able to use layers which have the type:
· Feature Layer
· Tile Layer
· Map Image Layer
You should also see the word Authoritative next to some of the layers. This indicates that ESRI have checked the data and consider it to be reliable. Even so, remember that it’s always a good idea to check who is the creator of any data, and which organisation it comes from.
Seeing full information about ESRI Living Atlas Layers
There should be in your list of results, a Tile Layer called World Ocean Base, for which the contributor is ESRI.
· Click on the title for this Tile Layer.
You’ll be taken to a full page of information about the layer. It’s worth looking at this information as it will give you a better idea of whether this is a good layer to use.
· If you want to check what the layer looks like, click the Open in Map Viewer button at top right. Zoom in and out and pan around to check the map.
· Once you are happy that this is the layer you want to use, return to the page containing the information about the layer.
· Look for the URL field, which is usually at the bottom right of the page.
· Hover over the right-hand side of the URL box and click to copy the URL.
Now you are ready to add the layer to QGIS.
Adding an ArcGIS Living Atlas layer to QGIS
Start by opening QGIS. You can add ArcGIS Living Atlas layers to existing maps, but in this case we’ll start with a blank map.
As usual, there are multiple ways to add the layer to QGIS. You can use either of the following:
Via the Browser panel
In the Browser panel, scroll down to find ArcGIS REST Servers heading. Right-click on the heading and choose New Connection....
This will open a dialog box.
· Fill in the Name as World Ocean Base (or something which will remind you what the connection is in future).
· In the URL box paste the URL you copied from the Living Atlas web page.
· You don’t need to fill in any further information.
· Click on OK to add the server connection to QGIS.
[image: ../../shared/docs/images/finding_data/LivingAtlasNewConnection_small.png]
Creating a new ArcGIS REST Server Connection to add a layer from the ESRI Living Atlas.
The new connection should appear under the heading in the Browser panel.
· Drop down the small black arrow next to your new connection. This will show any layers available on the server. For the World Ocean Base there is only one available.
· Double-click on the layer you want to add to your map.
Be patient, some layers can take a while to load, particularly if you have a slow internet connection.
Zoom in and out and have a look at the data you have added.
Via the Data Source Manager
· Alternatively, go to Layer > Data Source Manager.
This will open the Data Source Manager.
· Find the ArcGIS REST Server tab on the left and click on it.
· Click on New under the box at the top.
This opens the same form as the method above, so refer to the image under those instructions.
· Fill in the Name as World Ocean Base (or something which will remind you what the connection is in future).
· In the URL box paste the URL you copied from the Living Atlas web page.
· You don’t need to fill in any further information.
· Click on OK to add the server connection to QGIS.
· The name of your new connection should appear on the dropdown at the top.
· Now click on Connect to actually connect to the server.
· Drop down the small black arrow next to your new connection. This will show any layers available on the server. For the World Ocean Base there is only one available.
· Select the layer you want, then click the Add button at the bottom of the window.
You can also Close the Data Source Manager if you wish.
Be patient, some layers can take a while to load, particularly if you have a slow internet connection.
Zoom in and out and have a look at the data you have added.
Trying out other ESRI Living Atlas layers
Once you have added a layer, you can combine it with other data from other sources to produce your own maps.
· Return to the Living Atlas browse page.
Look for another layer to add to your map. Is there a country you are particularly interested in, or a subject you’d like to see on a map?
· Use the Filters at the top of the page to select the country.
· Search for the subject you want to investigate.
Example searches could include:
· Earthquakes
· Land use or Land cover
· Hurricanes
· Traffic
· Imagery (for aerial photography)
You’ll need to look for layers which don’t say Subscriber or Premium, and which are one of the following types:
· Feature Layer
· Tile Layer
· Map Image Layer
In addition, some layers which look as if they will be OK, may not work. This can be because a server somewhere isn’t working and there isn’t much you can do about it, unfortunately.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Find a layer and add it to your map in QGIS
Find a layer showing something you are interested in and add it to the same map as the World Ocean Base.
Zoom in to an area you are interested in, and export the map using the instructions below. Upload your map to your OneNote Class Portfolio to get feedback on it.
Exporting your map
It is possible to set up a layout and export that, but I’m not expecting you to spend extra time on this exercise.
Instead, so you have something I can give you feedback on in OneNote:
· Make sure your map looks as you want it to in the map window in QGIS.
· Go to Project > Import/Export > Export Map to Image.
· In the form which appears, click on Map Canvas Extent.
· Untick Append georeference information
· The other settings will be fine for now, so click on Save.
· Give your export a name and choose where to save it.
[image: ../../shared/docs/images/finding_data/SaveMapAsImage_small.png]
Saving a map as an image directly from map view.
QGIS will export a .png image which you can open in a photo editor, or upload to OneNote.
I’d be interested to know what you think of the ESRI Living Atlas layers, so if you want to add any comments or questions in your portfolio, that is absolutely fine.
Using spatial data in GIS: Coordinate systems, projections and transformations
Last Modified: 15 Jan 24, 16:16:29
The background to using spatial data in GIS, coordinate systems and projections will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes for using spatial data in GIS
When you have completed this section of the workbook you should be able to
· describe the main types of data used in GIS
· find out essential information about the data and apply that to your use of the data in GIS
· set the correct coordinate reference system (CRS) for your project and for each layer in your map
Data to download and prepare
Being able to find, download and prepare your own data is an essential part of using GIS. For the exercises in this chapter, you will need to download several datasets. While these should not take too long to download and prepare, don’t leave it until the last minute. Websites can become unavailable either permanently or temporarily, or computers can crash.
If there are problems with a website, then try again later. If the problems persist please get in touch with me (c.e.gordon@leeds.ac.uk) and I will try to contact the site or find an alternative source of data.
Data required
Download and prepare the following data. If you can do this before the start of the class you will be able to get started on the exercises as soon as they have been introduced.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Summary of data to download
Full instructions for obtaining these datasets are in the sections below.
• CoordSystems.zip from Minerva
• European River Catchments from the web
• SRTM height data for part of Skye, off the West coast of Scotland
CoordSystems.zip
CoordSystems.zip can be downloaded from Minerva. Please unzip it to your GIS folder. Instructions for using this file will be given in the exercises in this chapter.
You should end up with a folder within your GIS folder which is called CoordSystems_Q. Make sure that you put the rest of the data for this project inside this folder.
European data from the web
Inevitably the web is an extremely rich source of spatial data. A lot of government and related bodies make data publicly available online. Sometimes you have to register first even when the data is available without charge, but the European source below allows you to download many datasets without registering.
· European Environment Agency Datahub.
It’s worth having a look at the wide variety of data that is available from this hub, but for this chapter we’ll use a dataset showing Regional Seas around Europe.
Downloading Regional Seas dataset
· Go to the European Environment Agency Datahub.
· The Datahub page allows you to browse data by categories, but also has a search box - where the page says Search Datahub... type Regional Seas and press enter to search.
· The resulting list shows brief information about the datasets. Click on the link for Regional Seas around Europe.
The next page gives you information about the data, including the publication date, and links to view and download the data.
· Under the Datasets heading, click on the link to Direct Download.
This takes you to a downloads page with a choice of formats. For these exercises we’ll use the SHP, or shapefile, option to give you experience with this common format. The information on the page shows that the download will be 160 MB.
· Click on the ellipsis (three dots…) to the right of the SHP heading and select Download.
· Wait for the file to download. It will probably be a zip file called SHP.zip. Move it to your folder for this chapter. You could also rename it as something like regional-seas-europe.zip so that you can remember what it contains later.
· Unzip the downloaded file to your CoordSystems_Q folder.
You’ll have another folder called SHP and that contains a list of files which all start Regional_seas_around_Europe_LAEA_ with some numbers, and then a variety of file extensions.
Make sure that you keep all these files together or the data won’t load into GIS.
The actual shapefile is the one with the .shp extension, but it needs the other files to be read in GIS.
[image: images/svg/info-black-24dp.png] Shapefile format
Shapefiles are a form of vector data storage. We’ll mainly use GeoPackages for data that we create, but if you download data it is often delivered in shapefile format as that will work in most GIS software.
There are limitations to the format, which is why we’re mainly using geopackages, but the main one to remember is that a single shapefile actually consists of multiple files on disk with extensions such as .shp, .dbf, .prj, .sbn etc. If you’re dealing with shapefiles make sure that you keep all those files together or you won’t be able to open the data in GIS.
SRTM data via Earth Explorer
SRTM stands for Shuttle Radar Topography Mission and is data collected from the space shuttle Endeavour. You can find out more detailed information on the USGS webpages.
If you are working in the UK then you will have more detailed height data available to you via Digimap and Open Government sources, but SRTM data is possibly the best height data easily available for many countries, e.g. Turkey. One limitation is that it is not available above 60 degrees north and below 60 degrees south - so it doesn’t cover most of the Shetland Islands to the north, for example.
Obtaining SRTM data
You could download the original data but we’ll be using the postprocessed data (this has data voids filled, and accuracy improved in some areas). This is available from the Earth Explorer website.
· Navigate to Earth Explorer.
· If this is your first visit click on Register to set a username and password. Please use your University email address to register. (IMPORTANT: don’t use your University password, but don’t forget to make a note of the username and password that you do set up! You’ll need to use them again in future.) Apologies, this is a horrible registration form, but once you’ve completed it, the data is very useful.
· If you have already registered click on Log in and enter your username and password.
· Once you have the viewer open use the map to navigate to the area that you require data for - in this case look for Skye off the north-west coast of Scotland. The image below shows the general area, but zoom in closer than this so that the island of Skye fills the whole of the map area.
[image: ../../shared/docs/images/crs/SRTMSkye_small.png]
Selecting data in Earth Explorer - the area to enter to search for data for Skye.
· On the Address / Place tab click on Use Map to select the area. You can change the area by moving the markers if necessary. The image above shows the map with Skye selected.
· Now click on the Data Sets button to move to the next tab.
· Go to Digital Elevation > SRTM - this should give you four choices. Click on the i buttons to see more information about the products. It’s worth having a look at what other data is available to you through this interface too. There is a lot there.
· For this exercise select SRTM 1 Arc-Second Global by putting a tick in the box next to it.
[image: ../../shared/docs/images/crs/SRTMDataSets_small.png]
Selecting data in Earth Explorer - Digital Elevation data choices. Select SRTM 1 Arc-Second Global - outlined in red.
· Click on the Results button - you may need to scroll down to see it.
Now Earth Explorer should give you a list of your selected data covering your chosen area, but you’ll need to explore a bit further to see exactly which tiles to download.
· The image below shows the results of a search for SRTM 3 for Skye. To see the coverage for a tile of data click on the “footprint” icon under it.
[image: ../../shared/docs/images/crs/SRTMResults_small.png]
The SRTM results screen - showing the footprint of the SRTM tile to download for the Isle of Skye.
· To download a file, click on the fifth icon next to the tile in the list (a green arrow) - it has a tool tip which says Download Options if you hover over it.
· From the choices that appear, click on the Download button next to the GeoTIFF option and then wait for the download to complete. You may need to accept/allow popups for this webpage for this to happen.
· If you want multiple tiles you’ll need to click on each one separately.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Download SRTM tile
Download one tile of SRTM data covering the western part of the Isle of Skye and save it to use in the exercises in this chapter.
If you need to do multiple searches then click on Clear Search Criteria above the map. This doesn’t always work, if it doesn’t you have to close the browser completely and start again from scratch.
Using coordinate systems: Setting up your project
For this exercise you will be using the data that you downloaded above and exploring what you need to do when your layers have different projections to each other - a situation that is very likely to happen. This exercise should show the importance of understanding coordinate systems and how they work in GIS.
· You should already have a folder called CoordSystems_Q under your gis folder from when you unzipped the Minerva download. If you haven’t, create that now and move the unzipped miniscale data to that location.
· Check that you have copied all the data for these exercises into that folder and check that it is all unzipped.
Adding layers to a blank map
We’ll start by looking at what happens if you add data to a map project without thinking about coordinate systems first. You’ll be adding these data layers in a different order to three different projects.
First time
Start by adding the layers in the following order:
· Open a blank map in QGIS and browse to your CoordSystems_Q folder in the Browser panel.
· From there find the miniscale folder and add miniscale_mono_r19.tif to the map by dragging and dropping it into the Layers panel.
· Next find the Regional Seas around Europe layer - Regional_seas_around_Europe_LAEA_20221003.shp in the browser and add that to the Layers panel. You may not see anything change on your map, don’t worry about that at this stage.
· If a Select Transformation... window opens, just click on OK for now.
· Finally find the srtm layer n57_w007_1arc_v3.tif and add that to the Layers panel. Again, you may not see any changes to your map.
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Look at the layers on your map
You should be able to see the first layer that you added but where are the other two layers? Zoom to layer on each of them in turn and see what they look like, and how they appear in relation to the other layers.
• Can you see all three layers at once?
• When you zoom to the Regional Seas layer you may see a large grey shape - zoom way out and investigate that further. What is it?
• Use the cursor to hover over the bottom left-hand corner of the miniscale layer - what coordinates show at the bottom of the map?
• Have a look at the bottom right of the map window. Use the mouse to look at the tooltips and find the button that shows the CRS. Make a note of what it says at the moment.
Second time
Let’s try adding the layers to a blank map in a different order:
· Click on the New Project button at the top left of the QGIS window, or Ctrl-N on your keyboard. If asked, Discard the current project.
· Go to the Browser panel again and this time add the Regional Seas around Europe shapefile (.shp) first.
· Next add the srtm layer n57_w007_1arc_v3.tif.
· Finally this time add the miniscale layer miniscale_mono_r19.tif.
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Look at the layers on your map
You should be able to see the first layer that you added but where are the other two layers? Zoom to layer on each of them in turn and see what they look like, and how they appear in relation to the other layers.
• Can you see all three layers at once?
• Use the cursor to hover over the bottom left-hand corner of the miniscale layer - what coordinates show at the bottom of the map?
• Have a look at the bottom right of the map window. Use the mouse to look at the tooltips and find the button that shows the CRS. Make a note of what it says at the moment.
Third time
There are three layers, so let’s try again and see what happens this time:
· Click on the New Project button at the top left of the QGIS window, or Ctrl-N on your keyboard. If asked, Discard the current project.
· Go to the Browser panel again and this time add the srtm layer n57_w007_1arc_v3.tif first.
· Next add the miniscale layer miniscale_mono_r19.tif
· Finally this time, add the Regional Seas around Europe shapefile (.shp).
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Look at the layers on your map
You should be able to see the first layer that you added but where are the other two layers? Zoom to layer on each of them in turn and see what they look like, and how they appear in relation to the other layers.
• Can you see all three layers at once?
• When you zoom to the Regional Seas layer you may see a large grey shape - zoom way out and investigate that further. What is it?
• Use the cursor to hover over the bottom left-hand corner of the miniscale layer - what coordinates show at the bottom of the map?
• Have a look at the bottom right of the map window. Use the mouse to look at the tooltips and find the button that shows the CRS. Make a note of what it says at the moment.
What have you observed?
You should see that each time the result is different. In particular the miniscale map doesn’t appear in the same geographic location as the other two maps.
You should also notice that when the European River Catchments layer is added first the CRS button at the bottom right of the window shows a different code.
· When the miniscale is added first the code will either be EPSG:4326 or No projection, depending on how the default is set on your copy of QGIS.
· When the Regional Seas around Europe layer is added first the code will be EPSG:3035.
· When the SRTM layer is added first the code will be EPSG:4326.
This is because the map is set to the coordinate system of the first layer to be added, or, if the layer does not have a coordinate system defined, to the default which is usually either EPSG:4326 or No Projection.
If you’ve noted the coordinates of the bottom right of the miniscale layer each time, you should notice that they are low numbers close to 0,0. Because the miniscale has no projection set, QGIS is placing it with the lower-left corner at 0,0 and this will vary depending on the “origin” of the current project CRS.
On-the-fly projection
The different results that you have observed are because if you have already set a project CRS either by adding a layer or through the properties, QGIS then tries to project subsequent layers “on-the-fly”. Whilst this is very useful, the result is not always successful and the layers are not all visible together or, if they are, may not line up exactly on top of each other.
Even if all the layers line up, if the coordinate systems are not all set to the same crs then you’ll have trouble editing data, measuring distance and area, or running analysis tools.
The important lessons here are:
· Make sure that you know the coordinate systems of your data
· Make sure that you know what coordinate system you want your map to appear in
· Make sure that all the coordinate systems match.
We’ll spend the rest of the time in this chapter looking at how you can do the above.
Working with coordinate systems
When setting up a new project you’ll need to start by checking and setting the coordinate reference system (CRS) for your project and for each of your layers. There are also other layer properties that you’ll need to check, for example, is your data layer raster or vector?
Deciding on the correct CRS
The first step is to think about what CRS you need to set for your project. It can depend on what area you are working in, for example if you are working in the UK then it will usually be the British National Grid, if you are in Spain then it will probably be a version of UTM. If you are creating a map of a whole continent or the World, then the use of the map will affect which CRS you choose.
In this case we’ll create a map of the Isle of Skye in the UK, so we’ll use British National Grid.
Let’s find out more about that CRS.
· Go to the epsg.io website. You can use this site to find out more about coordinate systems for different areas of the World.
· Use the search box to look for Britain.
· The first result should be OSGB 1936 / British National Grid - United Kingdom Ordnance Survey which is the most common/likely for the area you’ve searched for - click on that link
The page for this gives more information about the CRS.
· One very useful feature is the map showing the area covered by that projection. Remember from the lecture that different projections or coordinate reference systems work best for different areas and this map, showing the extent of the one you have chosen, should help.
· Make a note of the EPSG code at the top of the page - EPSG:27700. This helps when finding the correct projection in your GIS.
· Have a look at the Attributes further down the page, in particular the Unit, but also the area of use.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Looking up EPSG:4326
EPSG:4326 is a default CRS in QGIS. Click to search epsg.io again, but this time search for 4326. There only appears to be one result for this, so click on the entry in the list to go to that page and have a look at the details for that.
• What is the name of the CRS?
• What is the area covered?
• What are the units?
Setting up a new project from scratch
Now that you know the CRS you want your project to be set to, let’s go ahead and set up a new project.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Checking and setting the CRS of your project in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· If QGIS isn’t already open, open it now.
· If QGIS is already open, click on the New Project button at the top left of the QGIS window, or go to Project > New or use Ctrl-N on your keyboard. Discard the current project if there is one.
· Look at the bottom right of the QGIS window. There will probably be an EPSG code there and that will usually be EPSG:4326 by default. You’ve found out a bit more about that CRS above and should know now that it is called WGS 84 - you’ll come across this frequently.
[image: ../../shared/docs/images/crs/CrsButton2_small.png]
The current CRS button showing that the initial project CRS is set to WGS 84.
You may find that your CRS isn’t set by default, in that case the button will look as follows and say No Projection if you hover over it.
[image: ../../shared/docs/images/crs/CrsButton1_small.png]
The CRS button showing that there is no CRS set.
· Whichever version your QGIS is showing, click on the button now. This is the quickest way to get to the CRS window of the Project Properties.
· If No CRS is ticked, untick it now.
· In the Filter box type the EPSG number for the CRS you selected for this project - British National Grid - 27700. You could type British National Grid instead, but the code is often the quickest and most reliable way to find the right CRS.
· In the list that appears under Predefined Coordinate Reference Systems click on OSGB 1936 / British National Grid
Note that British National Grid is under the list of Projected Coordinate Systems. This means that it is a grid that will allow measurements in metres or similar, rather than degrees. If you want to use a map for measurements of distance or area it needs to be in a projected CRS, or projection.
[image: ../../shared/docs/images/crs/CRSProperties_small.png]
The CRS tab of the Project Properties showing the project CRS being set to British National Grid, EPSG:2700
· To set the CRS and close the properties, click on OK
· Have a look at the Current CRS button again, that should now have changed to say EPSG:27700.
[image: ../../shared/docs/images/crs/CrsButton3_small.png]
The Current CRS button now shows that the project CRS is set to British National Grid.
At this point Save your map
· Project > Save or Ctrl-S.
· Browse to the project folder and give the project file a name such as CoordSystems. QGIS will automatically give it a .qgz extension.
· Save
Once you’ve saved your file you should be able to see the Project Home folder in the Browser panel and use that to browse to your files.
If you can’t, right-click on Project Home > Set Project Home..., browse to the folder where you saved your qgz file and Select Folder.
Checking the layer properties
Now that the project CRS is set, we can start looking at the properties of the data layers.
You are going to be creating a map of an area of Britain with the spatial reference of British National Grid so need to check whether all the layers are set to that.
You will need to know whether your data is raster or vector. This is a basic classification of all the data you will be using in GIS. The basics of raster and vector formats will be covered in the lecture for this week so if you need a reminder you can look back at the presentation or recording. Below I give you some more practical tips for working out in QGIS whether your data is raster or vector.
If you are still unsure there are lots of helpful articles and videos on the web. Try the following or search for GIS raster and vector:
· Ordnance Survey Raster and vector data
· Spatial Vision Raster and vector data in GIS
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Checking the layer CRS in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips. 
To find the properties for each layer do the following then make a note of the details. If you’re not sure, just have a go. It doesn’t matter if you are wrong!
· In the Browser panel right-click on the Regional_seas_around_Europe_LAEA_20221003.shp file and select Layer properties...
· Check that you are on the Metadata tab and look for and make a note of the following details:
· Is the data raster or vector?
· In the properties panel look for the “Provider”. For a raster layer that will be gdal, for a vector layer it will be ogr.
· Look at the file extension - .shp is always vector. In this workbook, .gpkg will always be vector. (It is possible to store raster data in a geopackage, but I don’t cover it in this workbook.)
· Vector layers will also have Geometry which can be one of point, line (or linestring), polygon, multipoint, multiline or multipolygon.
· Look at the file extension - any of the following extensions are always raster - .tiff, .tif, .jpg, .asc, .png.
· For raster data, what is the data type and GDAL driver
· For vector data, what is the Storage?
· What is the CRS? Is it Geographic or Projected?
Repeat for the other two layers, the Miniscale mono and the SRTM (if you have more than one tile of SRTM data just use one of them, it doesn’t matter which). If there is no text next to CRS just write down Unknown.
Notice that you should come up with a different CRS for each layer. This is a common problem when working with spatial data from multiple sources and is an important reason why you should check your data!
Your notes should show something like the following:
	Layer
	Vector / raster
	CRS
	Projected / geographic
	Data type
	Storage or Driver

	Regional Seas around Europe
	Vector
	EPSG:3035 - ETRS89-extended / LAEA Europe
	Projected
	
	ESRI Shapefile

	Miniscale Mono
	Raster
	Unknown
	
	Byte - Eight bit unsigned integer
	GeoTIFF

	SRTM tile
	Raster
	EPSG:4326 - WGS 84
	Geographic
	Int 16 - Sixteen bit signed integer
	GeoTIFF


Now that we have this information, we can start to add our data to the project.
Setting the CRS of a layer where it is not already set
· Add the Miniscale layer to your map. This should be the first layer added to your project which already has the CRS set to epsg:27700.
When you add the miniscale layer to your map you should find that it doesn’t cause any obvious problem, but it does have a small globe with a question mark next to it in the Layers panel.
[image: ../../shared/docs/images/crs/NoProjection_small.png]
The miniscale layer in the Layers panel showing the symbol which tells you that this layer has no CRS set.
When you checked the layer properties for the miniscale layer you should have found that the CRS is not set.
At this stage you need to do some detective work to find out what the CRS for the layer should be. That usually involves looking at any documentation that came with the data, or going to the website from which you downloaded it.
In this case the miniscale layer is Ordnance Survey data downloaded from Digimap and I can tell you that it should be set to British National Grid EPSG:27700, which in this case is the same as the project.
[image: images/svg/warning-black-24dp.png] Warning
Note that you can’t just set the CRS for the miniscale layer to whatever you want at this stage, you have to set it to the original CRS or the one that should have been set. You can change the CRS later if you need to.
Temporarily assigning the existing CRS to a layer
It is possible to remove the question mark icon by temporarily assigning the correct CRS to a layer. This isn’t suitable if you are going to be using the layer for further analysis or measurement, but can help if you are only using it as a background map.
· Click on the question mark and globe icon to the right of the miniscale layer in the Layers panel. This will open the CRS window.
· At the top it should explain the the layer “appears to have no projection specification”.
· In the Filter box, type 27700, the EPSG code for British National Grid.
· From the Predefined Coording Reference Systems box select the line which says OSGB36 / British National Grid - EPSG:27700.
· Click on OK to apply the temporary fix.
You should notice that the question mark and globe icon disappears from next to the layer in the Layers panel.
[image: ../../shared/docs/images/crs/TempCRS_small.png]
Temporarily applying the CRS for the miniscale layer.
Alternatively:
· Go to the layer properties by right-clicking on the layer in the layers panel and going to Properties then to the Source tab.
· Under Assigned Coordinate Reference System you can see that it says invalid projection. To set the CRS temporarily drop this down and select the correct projection - British National Grid. You can also click on the three dots button at the end of the line and select the CRS that way.
· Click on OK to apply it temporarily.
The above looks as if it works fine, but it is only a temporary solution. If you add the miniscale to a blank map it will need to have the CRS set again, the assigned CRS isn’t part of the data.
Permanently assigning the existing CRS to a layer
To set the CRS of the raster data permanently, you need to assign the projection. It is good practice to get into the habit of using this method rather than temporarily assigning the CRS.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Assigning a projection in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To assign the CRS to the original projection do the following:
· On the menu bar click on Raster > Projections > Assign projection.
· For the Input layer select the miniscale_mono_r19 layer
· Under Desired CRS select British National Grid or click on the button at the end of the line and select it that way.
· Click on Run
· Once the tool has run click on Close and the no projection symbol should disappear from the Layers panel.
You don’t need to enter an output name because this tool assigns the CRS to the existing file.
[image: ../../shared/docs/images/crs/AssignProjection_small.png]
Filling in the form to assign a projection to a layer.
If you add the miniscale layer to a new blank map now you should find that it has kept the British National Grid CRS.
[image: images/svg/info-black-24dp.png] Sometimes an unknown CRS doesn’t matter
To confuse things slightly, sometimes it doesn’t matter if a layer doesn’t have a CRS, or if the CRS is different to that of your project.
Think of the use you’ll be making of the layer. If it is simply a background layer and is in effect a “picture” that just sits behind your other data, but which isn’t used for analysis, then you simply need to check that you’ve set the project CRS correctly and leave QGIS to use “on-the-fly” projection.
If you have added an XYZ tile layer, don’t try to change the CRS. It won’t work and can cause problems with other layers on your map. Again, these layers are there as background layers and can’t usually be used for analysis anyway.
Transformations
Let’s see what happens with a vector layer with a different projection.
· Add the Regional Seas around Europe layer to the same map.
You should find that a new window opens which looks something like the image below.
[image: ../../shared/docs/images/crs/Transformations1_small.png]
The Transformations selection window for the European River Catchments layer.
This indicates that the layer has a different CRS to the project CRS. QGIS is trying to project the layer into the project CRS on-the-fly but needs to know which mathematical method, or transformation, to use to do so, so it is asking you which transformation you prefer for your map.
It’s usually OK to select the suggested transformation.
· Click on OK now to accept the suggested transformation.
You may see a yellow band at the top of the map warning you that QGIS “Used a ballpark transform from IGNF:ETRS89LAEA to EPSG:27700”.
[image: ../../shared/docs/images/crs/BallparkWarning_small.png]
The warning about using a ballpark transform. Don’t worry about this, it’s a warning not an error!
You’ll get used to seeing these notices (with a variety of CRS mentioned). They are warnings, not errors, you are fine to ignore them! They actually mean that there should be a more accurate transformation available. Usually for your needs, the default that is used is fine.
It’s important to note that once again this “on-the-fly” transformation is only a temporary solution. This means that the map looks fine, but if you want to do any measurements or analysis you may well run into problems. We’ll look at more permanent ways to reproject and transform data in the next couple of sections.
Reprojecting a vector layer
The process of changing the CRS of a layer to a different CRS is called reprojection. Reprojection works slightly differently depending on whether a layer is vector or raster.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Reprojecting a feature class in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
We’ll start with the Regional Seas Around Europe layer, which is a vector layer.
The current CRS is EPSG:3035 - ETRS89-extended / LAEA Europe and, for the purposes of this project, we need to convert this to British National Grid permanently.
Reprojecting a layer by Exporting to a new layer
As with so many tasks in GIS there are two ways to do this. The simplest is to Export the layer to a new layer.
· Right-click on the layer in the Layers panel
· Export > Save features as...
· As this is a vector layer we’ll save it to a geopackage, so select that under Format
· Browse to the project folder to save the geopackage and give it a name, e.g. CoordSystems
· Then give the new layer a name, e.g. ERC_BNG to indicate that it is in British National Grid (note not spaces, and the only symbol allowed is an underscore).
· Next to CRS either dropdown and select the Project CRS if it is British National Grid, or click on the ellipsis (three dots) button at the end of the line to select that.
· Check that Add saved file to map is ticked
· Then click on OK
[image: ../../shared/docs/images/crs/SaveVectorLayerAs_small.png]
Changing the CRS of a vector layer by exporting to a new feature class.
You can now remove the original layer from your map to keep the map tidy.
If you add the new layer to a blank map it will still be projected to British National Grid, showing that the change is permanent.
Reproject layer tool
The alternative way of reprojecting the vector layer is as follows:
· On the menu bar go to Vector > Data Management Tools > Reproject Layer
· Fill in the Input Layer and the Target CRS and click on the three dots button next to Reprojected to save to a new file.
· Run and then Close to see the reprojected layer.
[image: ../../shared/docs/images/crs/ReprojectLayer_small.png]
Using the tool to reproject a vector layer.
You might not notice much difference in the data on the map either way, but if you look at the layer properties source tag of the new layer you should be able to see that the CRS has been changed.
If you add the new layer to a blank map it will still be projected to British National Grid, showing that the change is permanent.
However, I found that with this data, the first method (exporting) worked well, but the second gave a very strange result. This shows the benefit of having more than one option available to you!
[image: ../../shared/docs/images/crs/ProjectionProblem_small.png]
Strange end result of reprojecting vector data.
In this case, the tool has taken notice of where the edges of the target coordinate system are and has cut the data. Unfortunately, because the data is polygons, where they have been cut, QGIS is displaying them with the shortest edge. Hence, the strange lines across the middle!
If this happens, try the other method of reprojecting data by exporting. If neither methods work, you may have to investigate clipping your data to the smaller extent.
Reprojecting a raster layer
The previous section shows how to reproject vector data, now let’s reproject raster data using the SRTM data that you downloaded as an example.
Once again there are two ways to reproject a raster. It is possible to right-click on the layer in the Layers panel and Export > Save as... a new file, but usually the more reliable method for raster data is to use the Warp tool.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Reprojecting a raster layer in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Start by adding the SRTM layer to your map. Accept the transformation if you are given a choice.
· In the menu bar go to Raster > Projections > Warp (Reproject)
· The Input Layer is the SRTM layer n57_w007_1arc_v3 - you can select it in the dropdown if it is in your map, or browse for it using the three dots button at the end of the line
· The Source CRS is optional, but feel free to set it to EPSG:4326. The result tends to be more reliable if you can set this.
· The Target CRS is the CRS you are reprojecting to - if you have the CRS for your project set select Project CRS: EPSG:27700 using the dropdown, or if you need to, browse using the ellipsis (three dots) button at the end of the line.
· Go down to Reprojected and click on the three dots button at the end of the line. Choose Save to file...
· Browse to where you want to save the output file. I often create a folder called output in the project folder and use that to save all the raster files that I generate.
· Give the output file a name that reminds you what it is, e.g. SRTM_n57_w007_BNG to show what data it is, where it covers, and what the CRS is. The Save as type should be set to TIF files (*.tif)
· Save then Run the tool
[image: ../../shared/docs/images/crs/WarpReproject_small.png]
Filling in the Warp tool to reproject a raster file to British National Grid.
The new layer should be added to your map and to the Layers panel. If it isn’t, drag it there from the Browser now.
If you look at the Layer properties of the new layer now (right-click on the layer in the Layers panel and select Properties then look at the Information tab) you should see that the CRS is set to EPSG:27700 - OSGB 1936 / British National Grid - Projected.
You can now remove the original layer from your map to keep the map tidy.
Once again, if you add this layer to a blank map the CRS of the layer should already be saved as British National Grid and you shouldn’t need to set it again.
Creating a new map in British National Grid
Hopefully, if you look at the properties for each of the projected layers now they will all be in British National Grid.
Try opening a new blank map - you should be getting used to this by now! Then add all three of the newly projected layers to the map. It shouldn’t matter which order you add them.
Do all of them appear in the correct location in relation to each other? Remember that you can change the order in the Layers panel if one layer is blocking the others.
QGIS sets the project CRS to that of the layer which is added first, so has that been correctly set to EPSG:27700?
Summary of defining projections and projecting data
This summary of the main points of this section of the workbook should help you to remember what you need to do each time that you obtain a new dataset or start a new map. Read it through, and then remember where to find it so that you can refer back to it. If you don’t follow these steps then you can give yourself a major headache when trying to load data for a project.
In addition to the text summary there is a step-by-step diagram at the end of this section which you can use as a quick reference each time you have data to load into GIS.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Summary of defining projections and projecting data in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
The next chapter of this workbook gives you another exercise to practice projecting and transforming your data as this will be an important area to understand before you move onto further analysis. The chapter is optional, but if you are not completely sure about what you have just been doing it will be worth working through it.
What do you want to set as the CRS of your map?
Start by deciding what CRS to use for your map. Remember that this depends on the area you are working in and the use of your map. Go to the epsg.io website for more information on a particular CRS or to find out what CRS is best for a particular area.
Check the current CRS of your data
Once you know which CRS you want to use for your map have a look at your data.
Always start by checking the current CRS of your data. You won’t be able to do much without this information. Suggestions for finding this information include:
1. Check the file / layer properties or the metadata using the Browser
1. If that doesn’t help, e.g. if there is no CRS set, look at any documentation that came with the data (sometimes there is a text or pdf file in the folder with the data).
1. If that still doesn’t help, check with whoever or where ever you got the data from, e.g. the web page if you downloaded the data from the web.
1. If you still haven’t found the answer you may need to make an educated guess based on what you do know about the data then experiment…
Projecting your data on-the-fly
It is possible to project your data on-the-fly to the CRS of your project, but if you are using your data for further analysis you must project it to a new layer using the appropriate tools shown below.
Define the projection
If no CRS has been set you first need to set it to it’s original CRS which you should have worked out in the previous section. You cannot change the coordinate system by setting it. You need to set the correct CRS first then use the vector or raster reprojection tools if you need to change it.
Reproject the layer and transform it
If / when your data is not in the CRS that you want to use for your map then you need to Reproject the layer. Remember that you use a different tool depending on whether you are reprojecting vector data or reprojecting raster data.
If you haven’t already set the transformation for your project you may be asked to do so at this stage.
Projection all correct
If your data is projected and is in the same projection as your map then there is no problem and you can just use it as it is.
Quick reference diagram for defining projections and projecting data
This is the above information in diagram form.
[image: ../../shared/docs/images/crs/CoordinatesActionSummary.png]
Summary showing the decision process and actions necessary to prepare data for GIS.
Recommended reading: Coordinate Reference Systems
Many of the books on the reading list[footnoteRef:583] include basic information about coordinate reference systems and projections. Specific suggestions include the following: [583:  The reading list is available in Minerva and also from the University Library by searching for SOEE2650 on the reading list page.] 

For background information try the following chapter:
· Chapter 4, Georeferencing in Longley, P.A. et al. (2015), pp. 77-98 covers latitude and longitude (from p.86), projections and coordinate systems (from p.88) and gps (from p.94).
· For some general information about the how and why of coordinate systems look at I Hate Coordinate Systems!. This site gives some brief ideas for what to do if you are having problems with coordinate systems for your data.
· The QGIS User Guide includes a section on Working with Projections that should help you with QGIS in particular.
· If you want to find out more about coordinate systems and projections in general then the definitive guide is the USGS Professional Paper 1395 by John P. Snyder (1987) called Map Projections: A working manual. This is downloadable as a pdf.
· It is possible to add custom projections to QGIS and you can see how to do this on Anita Graser’s web page Beautiful Global Projections - adding custom projections to QGIS.
Coordinate systems: practice in projecting data
Last Modified: 19 Sep 21, 09:17:01
Introduction
This is an optional exercise. It is designed to give you more practice in working with coordinate systems and projections, a skill you will need for future assessments as well as the exercises in this workbook. This chapter will not be covered in the practical sessions and you do not have to do it, but if you want to work through it and need help with the exercises you can work on it in any of the classes or email me at any time. I would suggest that if you feel you are getting behind, you leave this chapter for now and come back to it later if you need to.
Often the most challenging part of a GIS project is finding the data that you need and adding it to a map so that it all fits together. In the first assessment you will need to put together several different data sets and then do further analysis. If the data sets don’t all have the correct coordinate system before you do the further analysis, then you will struggle to carry it out successfully.
What do you need to do?
This exercise is designed to give you practice in projecting data by adding the included data sets to a map.
You should aim to project / reproject all layers to British National Grid so that they all appear in the same position on the map. Once you have processed all the layers provided you should open a new map and add your layers to that. The final map should have the CRS set to British National Grid.
Refer to the instructions in the previous chapter. Remember that there is a summary and diagram at the end of the chapter.
Be aware that even if the layers appear to be on top of each other you still need to check their projection - don’t just rely on QGIS applying on-the-fly projection. That causes problems if you are carrying out further analysis on your data.
Data provided
The data for this exercise is available as ProjectionsUK.zip in Minerva. Download the zip file and unzip it to your GIS folder.
Files within each folder give more details of where the data was obtained from.
· Copernicus grassland layer for the area surrounding the Bristol Channel
· Corine land cover layer for the area surrounding the Bristol Channel
· getmapping_rgb_25cm - two tiles of aerial photography for the north of Weston-super-Mare
· OS_OpenMap_Local_Raster - two tiles of raster mapping for the north of Weston-super-Mare
· OS_OpenMap_Local_Vector - vector layers for the tidal boundary, tidal water and foreshore of the Bristol Channel
· Sentinel - real-colour data from the European Sentinel satellite
· SPOT - data from the SPOT Earth Observation Satellite
Target projection
You should end up with a map and layers ALL projected to:
EPSG:27700 British National Grid
Work through each layer in turn checking the current crs and assigning or reprojecting as necesary.
Checking the final result
Add all your British National Grid layers to a new blank map.
All the layers should now lie on top of each other. In addition check that the project CRS is set to EPSG:27700 British National Grid.
Conclusion
If you’ve worked through all the layers and everything appears to have worked, then congratulations. If you were working on a project or assessment you would be ready to move on to the analysis.
Creating data by digitising
Last Modified: 08 Jan 24, 17:18:27
The background to creating data for GIS will be covered in the lecture segment this week, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Set up storage for GIS data
· Use the tools in GIS to draw (digitise) your own data
· discuss the problems that can affect data for GIS
· suggest ways in which to minimize error and uncertainty in spatial data
Introduction
Digitising or tracing data manually in GIS involves having a background map which shows the locations that you wish to digitise, and then using the editing tools to draw vector polygons, lines and points. In this set of exercises, you will produce a map of Chancellors Court in the University showing the outlines of the buildings, the paths, and the trees. You will already have a layer from the previous chapter which contains features such as sign posts, benches and rocks.
Even if you don’t actually need to digitise a whole map it is extremely useful to know how to set up your own feature classes and how to add features by editing. Sometimes you just need to outline your study area or add a point to show where something specific is, or as input to one of the tools provided in GIS.
This is a very brief overview of the tools for digitising in QGIS as we are limited for time.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png]Vector and raster
If you feel that you are not clear about the difference between raster and vector GIS data it would be worth having a look at the video “Learn more about raster and vector map data” by the Ordnance Survey.
As you deal with more GIS data you’ll start to find it easier to spot which formats are raster and which are vector, but you need to be thinking about it already.
Obtaining the data
If you have already followed the GPS chapter and have a British National Grid version of the map of Chancellors Court then you can use that map again. This chapter will use features in the same area. You will already have downloaded CreateData.zip and unzipped that to use the data.
If you no longer have this project, or if you have not followed the GPS chapter, you can start a new project from scratch instead. You won’t have the gps points on the map when you have finished, but that doesn’t matter.
If you haven’t already downloaded CreateData.zip for the previous chapter you need to do so now.
· Download the CreateData.zip file from Minerva
· Unzip the data to a new folder within your GIS folder.
You should end up with a folder called getmapping_rgb_25cm which contains aerial imagery of the University[footnoteRef:602]. The jpg file within that folder contains the image and the other files with it, which have a similar name, contain information that will locate it correctly within GIS. [602:  This data was downloaded from Aerial Digimap.] 

You should also have a GeoPackage called StudyArea.gpkg which contains an outline for the area of Chancellors Court in the layer ChancellorsCourtBNG.
Open the map project
· Start by opening either your existing Chancellors Court map or a new blank map.
· From the files you downloaded and unzipped add se2934_rgb_250_01.jpg to your map using the Browser. (You may need to look in sub folders to find the file.) Remember if you can’t find the folder or the file that you’ve just added you can refresh the Browse panel.
· If you need help to find Chancellors Court, add the ChancellorsCourtBNG feature class from the StudyArea.gpkg GeoPackage to your map and Zoom to Layer.
· If necessary turn off the waypoints, location and any background layers so they don’t get in the way.
· Save your map. Saving your map regularly is a good habit to get into. In addition, if this is a new map, once you’ve saved your map you’ll have the Project Home heading in the browser.
You should have an aerial view of Chancellors Court on your map. You will use this as a basis to digitise the buildings, paths and trees.
[image: ../../shared/docs/images/creating_data/AerialMap_small.png]
The aerial image open in QGIS showing the area of Chancellors Court.
Setting up GeoPackage feature classes to store your data
The first thing you need to do is set up the storage for the data that you are about to create. You should already have a GeoPackage in your project, and if you do, you can use that to store this new data too.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating feature classes in a GeoPackage
This video clip can be found in the module area of Minerva or in the full list of video clips.
Creating a new GeoPackage and adding a feature class
[image: images/svg/warning-black-24dp.png] Warning
Your browser will show a heading titled GeoPackage. Don’t use that at this stage. Instead, you need to browse to the folder where you want to save your GeoPackage, and that should be the same folder as your map and data.
If you are going to use an existing GeoPackage, go straight to the next section - Adding a new feature class to an existing GeoPackage.
If you don’t already have a GeoPackage or want to create a new one:
· In the Browser, right-click on the folder in which you want to store the new GeoPackage or GeoPackage layer. It’s a good idea to use the Project Home folder if you have already saved your map but at least put it in the same folder as the rest of your project data.
· New > GeoPackage
QGIS will create a new GeoPackage called New GeoPackage.gpkg and add it to your folder.
· To rename the GeoPackage, right-click on it and go to Manage > Rename "New GeoPackage.gpkg...".
· Name your GeoPackage something that will remind you what it contains. In this case something like University.gpkg would be good, because it will be containing data about the University.
· Click OK.
[image: images/svg/warning-black-24dp.png] Warning
You may find that you get an error message at this stage, telling you QGIS can’t rename the GeoPackage. If you get that, don’t worry, just carry on with the New GeoPackage.gpkg. It’s not ideal, but still works and you could change the name later if you wanted to.
Alternatively, you can close QGIS, rename the GeoPackage in your computer file manager, then reopen QGIS.
You should now have an empty GeoPackage ready for you to fill with data.
Adding a new feature class to an existing GeoPackage
Once you have a GeoPackage, or if you already have one, you need to add feature classes, or tables, to be able to store your data.
· Right-click on your GeoPackage in the Browser panel
· Select New Table
· If you get an error message saying Cannot Create New Tables:
· click OK to get rid of it,
· then right-click on the GeoPackage again and this time select Add Connection.
· You won’t see any difference at this point, but now right-click and select New Table again.
· The New Table dialog should open.
· Give your new table a name, in this case call it Paths.
· Click on Add field and give it the name Label, Type should be Text (string) (choose from the dropdown box) and Length = 250 - that’s the maximum length of text you’ll be able to type into the table for that field.
· Set the Geometry Type to LineString. This is where you’re setting your data to be either points, lines or polygons. Note that it’s important to set this correctly as it can’t be changed later.
· Under CRS select the required coordinate system - in this case British National Grid.
· Tick to Create spatial index - this makes the storage and retrieval of your data more efficient.
· Click on OK to create the new table.
[image: ../../shared/docs/images/creating_data/NewGPKGTable_small.png]
The window to create a new table in an existing GeoPackage.
If the table isn’t added to your map automatically, drag it to the Layers panel from the Browser now.
If you can’t see the new layer in the GeoPackage you may need to select the top-level folder and then click on the Refresh button at the top of the Browser.
Setting up further feature classes
For this exercise you will need a polygon feature class, a point feature class and a line feature class.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Feature classes to create
Use the instructions above to create a total of three feature classes in the same GeoPackage. Note that the Geometry type is different each time and remember that you must set this correctly or you have to create the feature classes again.
• Create a Line feature class called Paths. If you followed the instructions in the section above, you’ll already have this feature class/table.
• Create a Polygon feature class called Buildings. This should have a new text field called Label with a length of 250.
• Create a Point feature class called Trees. Again, this doesn’t need any new fields.
Have a look at the new layers in your GeoPackage using the Browser. Note that the icons next to the layers show you what the Geometry type is.
[image: ../../shared/docs/images/creating_data/GeopackageLayers_small.png]
This is how your new GeoPackage layers should look in the browser. Note that the icons show the Geometry type of each layer. The GeoPackage example here also includes the waypoint layers from the GPS chapter don’t worry if you don’t have those.
Digitising in QGIS
You should already have an aerial view as a background for your map. For these exercises you will be digitising polygons, lines and points by tracing over features on this view.
Before starting to digitise check that you have the Digitising Toolbar open.
· View > Toolbars
· Check that there is a tick next to Digitising Toolbar
The toolbar should look something like this image at the moment. The only button available is Toggle Editing.
[image: ../../shared/docs/images/creating_data/DigitisingToolbarOff.png]
The Digitising Toolbar before you start digitising.
Digitising polygons
The Buildings feature class has a geometry type of Polygon, so this will hold closed shapes. We’ll start by digitising polygons, but lines and points are actually very similar.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Digitising in QGIS Part 1: Starting and finishing, and creating polygon features.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Start by selecting the Buildings layer in the Layers panel
· Either right-click on the layer and click on Toggle Editing or click the Toggle Editing button on the Digitising toolbar.
You should have more buttons available on the Digitising toolbar now.
[image: ../../shared/docs/images/creating_data/DigitisingToolbarOn_small.png]
The Digitising Toolbar once you have toggled editing with more buttons available.
· The button that I’ve highlighted is Add Polygon Feature. Click on this so that you are ready to start tracing.
We’ll digitise the School of Earth and Environment (SEE) building by drawing around the outline on the aerial photograph. SEE is the building to the north of Chancellors Court[footnoteRef:634]. [634:  If you’ve lost Chancellors Court in your map remember that you have the ChancellorsCourtBNG layer in your map from the downloaded data. You can Zoom to Layer on that to get back to the right area.] 

· Left-click on one corner of the SEE building, then on the next. Keep left-clicking until you have outlined the building. You can zoom in and out and pan as necessary (to pan easily hold down the mouse wheel and drag the map).
· As you progress around the shape you should see it as a transparent red with a stronger outline.
[image: ../../shared/docs/images/creating_data/DigitisingInProgress_small.png]
Starting to digitise the School of Earth and Environment. Note the transparent red area outlined in stronger red, this shows where you have already digitised.
· Each click creates a vertex or node.
· If you want to delete the previous vertex that you placed, because it’s not right, just press the Delete or Backspace keys on your keyboard.
· If you’re not happy with the whole shape clicking on Esc will get rid of it completely.
· When you have placed a vertex on each corner of the building right-click to finish editing.
Depending on the settings in your installation of QGIS you should find that a Features Attributes window opens. This gives you an opportunity to add attributes to your table.
If the window doesn’t appear you can still open the attribute table for the layer (right-click on the layer in the Layers panel) and add attributes that way.
· The buildings feature class has a Label attribute. Fill that in now with the name of the building - School of Earth and Environment.
· The fid (or Feature ID) is generated automatically so don’t touch that.
· Click OK.
· To save your new feature to the GeoPackage make sure that you click on the Save Layer Edits button on the Digitising toolbar
[image: ../../shared/docs/images/creating_data/EditingFeatureAttributes_small.png]
Adding attributes to your new feature. fid is generated automatically so don’t touch that!
Your new feature should appear as a solid colour on your map.
Continue on to digitise the buildings to the east, west and south of Chancellors Court. The map below shows the names of the buildings for you to add.
[image: ../../shared/docs/images/creating_data/BuildingNames_small.png]
Buildings around Chancellors Court and their names.
· When you have finished digitising and have saved your edits click on the Toggle Editing button again to finish.
Styling your layer
At the moment the buildings are a solid, random colour. Let’s change the colour to something that’s more usual for showing buildings on a map.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the Layer Styling panel by selecting the buildings layer then either clicking F7 on your keyboard, or clicking on the button at the top left of the Layers panel - the tool tip is “Open the Layer Styling Panel”.
· You can select a style from the Gallery that opens - one is called “Topo Building”, or click on the bar next to Color and select your own colour.
· Check Live update is ticked at the bottom of the panel so that your styles are automatically applied to your map.
· You can also click on Simple Fill at the top and experiment with the settings there.
Transparency
It can be useful to make your layers transparent. As you draw your building polygons you’ll gradually be covering up the layers underneath and it can be useful to see through the top layers.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Making vector layers transparent in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the Buildings layer in the Layers pane
· Then click on the button at top left of the Layers pane to Open the Layer Styling Panel or press F7 on your keyboard.
· The layer styling panel should open to the right of your map.
· Click on the Symbology tab in the icons on the left of the panel
· Make sure that the Fill is selected
· Use the Opacity slider to change the opacity or transparency of your layer. For example, slide it to about 70%
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
It is also possible to change the transparency by using the Opacity setting in the Layer Rendering section, but if you do that the features may not remain transparent when you export your map to pdf.
Set the opacity so that you can see through your building polgons to the aerial imagery below.
[image: ../../shared/docs/images/creating_data/SEEOpacity_small.png]
The SEE building with 70% opacity set.
Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality issues
Stop and think about the digitising you have just done. Can you think of any potential issues with the data that you have created in this way?
What scale did you digitise at? What effect will this have on the amount of detail that you included? What recommendation would you make about viewing the data on the map?
How accurate were you when you were placing the vertices on the corners of the buildings?
How clear were the edges of the building that you were digitising? What did you do when the edges were unclear, e.g. because of overlapping trees. What about shadows?
Editing features
If you want to edit a polygon, line or point to change it once you have created it you can.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Editing features in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the buildings layer and click Toggle Edit on the toolbar (if you aren’t already editing)
· Click on the Vertex tool on the digitising toolbar.
· Then right-click on the feature that you want to edit. The feature’s vertices will become visible as small red circles or squares.
· Left-click on one of the vertices and you will be able to move it around.
· When the vertex is in the position that you want it just left-click again.
· When you’ve finished editing right-click on the feature again to stop using the vertex tool. Your feature should appear as transparent red again.
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
Moving vertices by typing coordinates
Alternatively you can type coordinates into the Vertex editor to ensure that a particular vertex is in the correct location.
This is most useful if you have surveyed a feature and know exactly where the vertices should be placed.
· Click Toggle Edit on the toolbar (if you aren’t already editing)
· Click on the Vertex tool on the digitising toolbar.
· Then right-click on the feature that you want to edit. The feature’s vertices will become visible as small red circles or squares.
· The Vertex Editor should open on the left of the map window. This will show the x and y coordinates for each vertex on the selected feature.
[image: ../../shared/docs/images/creating_data/VertexEditor_small.png]
The vertex editor. It is now possible to type in new x and y coordinates for each vertex of the selected feature.
· To edit the coordinates just double-click on the coordinate that you wish to change.
· When you’ve finished editing right-click on the feature again to stop using the vertex tool.
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
Deleting features
If you want to delete a feature completely you can.
· Click Toggle Edit on the toolbar (if you aren’t already editing)
· Look for Select Features by area or single click button on the toolbars (highlighted on the image of the Attributes toolbar below)
[image: ../../shared/docs/images/creating_data/AttributesToolbar_small.png]
The Attributes toolbar with Select Features by area or single click highlighted.
· Click on the feature that you want to delete - it should become highlighted in bright yellow
· Press Delete on your keyboard
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
Labelling features
As you added features to your buildings feature class you also added the Label attribute. You can now use this to label the building features on your map.
This section shows you how to label polygon features. The same techniques apply to labelling lines and points.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Labelling features in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the Buildings layer in the Layers pane
· Then click on the button at top left of the Layers pane to Open the Layer Styling Panel or press F7 if it isn’t already open.
· The layer styling panel should open to the right of your map.
· Click on the Label tab on the left of the panel. At the moment it will just say No labels.
· Drop down where it says No labels and select Single labels
At this stage QGIS usually just labels your features with the first field in the feature class, which at the moment is fid. This isn’t very useful so the first thing you need to do is select the correct field.
· Next to Value drop down the choices and select the Label field.
Immediately the building names that you added should appear on your map on top of the correct buildings.
The default fonts, colours and placements are not always what you want. In fact, usually just accepting the defaults is not a good idea.
· Use the settings on the first of the tabs (Text) to change the font, font size and colour
[image: ../../shared/docs/images/creating_data/LayerStylingText_small.png]
The text panel of the Layer Styling panel. Change fonts properties here.
· Click on the Placement tab and select Horizontal from the Mode dropdown list. This should move your labels to within the polygon shapes as far as possible.
[image: ../../shared/docs/images/creating_data/LayerStylingPlacement_small.png]
The Placement panel of the Layer Styling panel. Change placement properties here.
Feel free to try out the properties in the other tabs too. There are lots of choices to help you make your labels clear and informative.
One useful one is on the Formatting tab where it is possible to set a maximum number of characters to wrap the labels onto multiple lines.
[image: ../../shared/docs/images/creating_data/LabelledBuildings_small.png]
The labelled buildings. Yours will look different as you will have made your own choices.
More information about labelling
Labelling is a big area and I’ve only shown you the basics here. If you want to find out more try some of the following suggestions.
The books in the Principles of Cartography section of the module reading list will all have sections on labelling, but try the following in particular.
· The QGIS User Guide includes a section on Setting a label which includes all the basic settings.
· Darkes and Spence (2017) has a section on Text on maps (pages 56-59) which includes information on type sizes and styles and text placement.
· Peterson (2021). Chapter 4 (p. 79 onwards) goes into more detail and is a readable guide.
Digitising Line features
Digitising line features is very similar to digitising polygons, except that you don’t have to finish where you started.
You should already have a Paths layer in your Layer panel. If you haven’t then drag it across from the GeoPackage.
Some of the paths on this map are curved rather than straight. The easiest way of drawing curved lines in QGIS is to click more often. On tight curves you do have to click a lot to make the line look curved. There are more advanced editing tools which would help, but this is only a quick overview so you can explore them if you want to, but this way of drawing is fine for now.
· Select the Paths layer, toggle editing and click on the Add line feature button
· Add lines for the paths across Chancellors Court. You don’t need to add any labels for this layer.
· Save your edits and toggle editing off.
· Style your paths in a similar way to how you styled the buildings - this time the gallery will have some suggested line styles and you can choose colours and line widths from the other panels.
Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality
Again, think about the problems that you encounter as you edit. Do you draw the edges of the paths, or just the centre line? How can you be sure of what happens underneath trees? How easy is it to be accurate with the drawing tools? Think about the implications for future use of the map at different scales.
Digitising Point features
Digitising point features is very similar to digitising polygons, except that you only have to click once for each point.
You should already have a Trees layer in your Layer panel. If you haven’t then drag it across from the GeoPackage.
· Select the Trees layer, toggle editing and click on the Add point feature button
· Add a point for each tree in Chancellors Court. You don’t need to add any labels for this layer.
· Save your edits and toggle editing off.
· Style your trees in a similar way to how you styled the buildings - this time the gallery will have some suggested point styles and you can choose colours and shapes from the other panels.
Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality
Again, think about the problems that you encounter as you edit. How easy is it to decide where you should add a point to represent a tree? How easy is it to be accurate with the drawing tools? Think about the implications for future use of the map at different scales.
Finally
Finish digitising the buildings around Chancellors Court, the paths across it, and the trees. Check that all the layers that you have created - the points, lines and polygons, have been symbolised appropriately and are labelled where necessary.
· Turn off the Aerial image by unticking the box next to it in the Layers panel
· If you have them, turn the symbolised waypoints layer back on
· Make sure that all the features on your digitised layers are visible in the map window.
Try creating a layout which shows your map of Chancellors Court.
In a later chapter you’ll find out how to create a full map layout with a key, scale bar, measured grid etc and print or export that properly, but for now just experiment and see what you have come up with.
When you have created a map export it to either an image or pdf and upload it to your GIS Portfolio in the Class Notebook. If you upload it within a week of the class I will provide brief feedback on your work.
[image: ../../shared/docs/images/creating_data/FinalMap_small.png]
The final map exported as an image. Yours will probably look different to this as you’ll have made your own decisions about symbols and colours, and about which features to include. You may also have included the features from GPS if you have done that exercise.
Further information and suggested reading
Many of the books in the reading list[footnoteRef:698] have a general introduction to inputting data to GIS. Suggestions include the following: [698:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 5, Data input and editing in Heywood, I., Cornelius, S. and Carver, S. (2011), pp.135-173 covers the background to a variety of ways of inputting data to GIS and discusses data quality issues.
· Chapter 8, Data Collection in Longley, P.A. et al. (2015), pp.173 onwards. Again this chapter covers the background to a variety of ways of collecting data and inputting it to GIS. Section 8.3.2 from page 183 covers Vector Data Capture, or digitising.
The QGIS Documentation has a chapter on the techniques of Editing which covers much more than we have been able to cover here.
The information about Digitising an existing layer covers the topics in this chapter, but there is plenty more there.
· Digitising an existing layer for v. 3.22 of QGIS
There are a lot of videos on YouTube which may help you. Try searching for Digitising QGIS.
Styling and labelling your data
Last Modified: 07 Nov 23, 08:23:58
The background to styling and labelling your data will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Symbolise data on a map so that it displays clearly and informatively to your audience.
· Add appropriately styled and located labels to the vector features on your map.
Introduction to styling and labelling your data
In the previous chapters you have created data and added data from other sources. Now you’ll see in more detail how to style, or symbolise, that data and label it appropriately to make a more informative map.
You have symbolised and labelled data in previous chapters, but this chapter brings those techniques together and goes through the options in more detail. It will also introduce some new techniques so that you have a wider range to choose from. You’ll also build on this to learn more about styling and labelling geological data in level 2 when you start to prepare to create a map for your dissertation.
Styling and labelling are subjective processes. Although there are general “rules”, sometimes it comes down to what do you think looks best. Some of the books on the reading list, such as Darkes and Spence (2017) and Peterson (2021), will give you more information about this.
The most important thing to remember is to look at your maps and think about your audience. What are you trying to show them and what is the clearest, most effective way of doing that?
Data to download
The project and data for this section is available for you to download from Minerva.
· Go to this week’s folder in Minerva and download StylingQMinerva.zip.
· Unzip the file to your GIS folder.
· You should have a folder called StylingQ. From that folder open Styling.qgz in QGIS.
[image: images/styles/StylesProject.png]
The initial project for this chapter. You should be able to see a map of the Otley area with a lightly coloured background and contours. The rest of the data is available for you in the project folder.
The map includes a VectorMap District Raster background map and Terrain 50 contours. Both layers were downloaded from the Digimap Ordnance Survey collection. You also have some BGS geological data and some other vector layers available to you in the project folder which you can see in the Browser panel.
· The geology is 1:50 000 BGS data downloaded from Geology Digimap.
· The other vector layers are mainly VectorMap District Vector layers from OS Digimap, but the water layers are from OpenStreetMap.
Styling your data
We’ll start by styling the vector layers to make a background map to replace the raster map, then we’ll move on to add the geology data to the map and style that with preexisting styles. Finally, we will look at how to create labels for the data to make the map more informative.
Preparing the map
Start by making the layers that you are about to symbolise visible and turning off the other layers so that you can see what you are doing more clearly
· The vector layers are all in a group in the Layers panel which is called Vector data. Click the little box next to that subheading to make all the layers visible.
· Untick the little box next to ContoursT50 and vmd-raster_4113816.tif to make them invisible - this makes it easier to see what you are doing with the other layers.
Your map should look more like the picture below now - though possibly with different colours.
[image: images/styles/InitialProjectView_small.png]
The initial view of the ‘Styling’ project when you have made the vector layers visible and turned off the contour and raster layers. Note that all the data is symbolised in random colours, and only one colour per feature class.
When you first add a vector feature class to a map, QGIS symbolises it with a single, random colour and doesn’t add any automatic information about what the features show. You need to apply styles to your data to make the features look different.
In this section we’ll symbolise the data that you’ve downloaded so that it becomes an informative, but basic, map.
The sections below show the general techniques to change colours, line styles, point symbols etc, but you have to decide for yourself how best to style your data so that your audience can interpret and understand your map. The references in the recommended reading at the end of this chapter will give you more idea about this and are well worth following up as this is too large a subject to cover fully here.
If you add a key to your map (you’ll be shown how to do this in the Layout chapter), it will show the colours and styles that you have set in this section.
Styling polygon features
We’ll start with polygon features as they are often the simplest to style, then we’ll move on to lines and points.
· In the Layers panel select that layer that you want to style, in this case we’ll start with the WaterArea layer. You can also turn off the other individual vector layers so that you can see what you are doing.
· To open the Layer Styling Panel either use the F7 key on your keyboard, or the Open the Layer Styling Panel button at the top of the Layers panel.
[image: images/styles/OpenLayerStylingPanel_small.png]
The button to open the Layer Styling Panel.
The Layer Styling Panel should open to the right of your map. Check that the layer is set to WaterArea in the box at the top. If it isn’t you can dropdown the box and choose the correct layer from your map.
[image: images/styles/LayerStylingPanelPoly_small.png]
The Layer Styling Panel - this should open to the right of your map. Check that WaterArea is selected at the top.
Setting a single symbol for a layer
The simplest style is a single symbol for every feature in your layer and this is the style that QGIS applies by default when you add a vector layer to your map.
If you have a layer which contains a single type of feature, then you can keep this type and just need to set it to your choice of colour or symbol for outline and fill.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· The style type should already be set to Single Symbol near the top of the panel.
· The simplest way to select a new style is to click on a patch in the gallery. Scroll down the gallery and have a look at the choices. If you don’t have many check that the dropdown box directly above the gallery is set to All Symbols. It’s often set to Favorites by default.
· Find topo water in the gallery - it should be a blue square with a darker blue outline and is probably near the bottom of the list. Click on the symbol. Your WaterArea layer should immediately change. If it doesn’t, check that Live Update is ticked at the bottom of the panel or click on Apply.
[image: images/styles/StylesGallery_small.png]
Selecting topo water from the gallery. Note that Live Update is ticked so that the style will immediately be applied to your layer.
This is really simple if the style that you need is available, but what if you wanted a different fill, e.g. a paler blue? The choices above the gallery make it possible to have more control over your styles.
· In the box at the top click on Simple Fill instead of Fill. This gives you more choices.
· Click on the colour patch next to Fill color. You now have a selection of “color swatches” and some sliders underneath.
· As the fill is already set to blue we’ll use the sliders to change the colour. Try moving the slider next to S to the left, or use the box on the right to change the value to 15% and the value under V to 95% [footnoteRef:724]. [724:  HSV and RGB refer to different colour models and the abbreviations stand for Hue, Saturation and Value and Red, Green, Blue. More information on the HSV colour model and more information on the RGB colour model.] 

· If you look at the bottom of the panel you should be able to see the difference between the old colour and the current colour. The colour should be automatically applied to your map layer.
· When you are happy with the colour go back to the top of the panel and click on the back arrow to return to the original panel.
[image: images/styles/StylesFillColour_small.png]
Selecting a custom colour.
You can also click on the colour patch next to Stroke color to change the colour of the outline. Try that now and change the stroke to a darker shade of blue.
Changing style and width
Other options in the Layer Styling panel for Simple Fill allow you to change the style of the fill and stroke, and the width of the stroke.
· Have a look at the settings and try changing them to see what difference they make.
· You can turn off the outline by selecting No Pen under Stroke style
· If you don’t want a fill for your polygons you can turn that off by selecting No Brush under Fill style.
· If you don’t like what you end up with you can click on “Fill” again and apply the topo water style from the gallery once more.
[image: images/svg/create-black-24dp.png] Styling the buildings
The SE_Building layer also needs to be styled as a single colour. Turn the layer back on and try that for yourself. Buildings are usually coloured brown or grey on maps and often don’t have outlines.
There is a topo building style in the gallery, but it is rather dark. Apply that, then change the fill colour to something lighter and try setting the stroke style to No Pen.
Once you’ve styled your water areas and buildings your map should look something like the image below.
[image: images/styles/WaterAndBuildings_small.png]
The styled water areas and buildings. It is fine if your colours and styles are different to mine.
[image: images/svg/warning-black-24dp.png] Save your map
Don’t forget to save your map at regular intervals. QGIS can crash and you don’t want to lose the work you’ve already done.
Setting categorized symbols for a layer
Setting categories for a layer allows you to show different feature types within that layer. For example, if you have a single layer for natural features and within that you have multiple types of feature, such as ‘water’, ‘heath’, ‘wood’, you can set each type as a category and then style each with a different colour.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as categories in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make the NaturalFeatures layer visible on your map.
If you haven’t already checked the attribute table of your layer to find out what information it contains then it’s a good idea to do that now so that you know which field you need to use to set the categories.
· Go to the attribute table of the NaturalFeatures layer (right-click on it in the Layers panel and go to Open Attribute table).
[image: images/svg/help_outline-black-24dp.png] Which field will you set for the categories?
Have a look at the columns in the attribute table and the data that they contain. One of the fields (columns) will contain data about the type of natural feature, which field is that?
Make a note of the column heading then close the attribute table.
· If the Layer styling panel isn’t already open, open it now, then check that the correct layer (NaturalFeatures) is selected at the top.
· To change the type of styling, drop down the box that initially says Single Symbol and select Categorized instead.
· The next thing you need to do is choose the Value field. That will be the name of the field that you chose above. Drop down the Value box and select that now. Hopefully you spotted that it is the natural field that you need.
· Now go to the bottom of the panel and click on Classify.
QGIS should automatically set a colour scheme and give a colour to each separate type of natural feature in the feature class. If you have Live update ticked the layer should be changed to match on your map.
[image: images/styles/LayerStylingCategories_small.png]
The NaturalFeatures layer styled as categories with random colours.
Now that you have a random colour ramp set, you can go through the categories and change them so that they are more appropriate for the data.
· Go down the list of values and double-click on the colour patch next to the one which says wood
· This panel should look familiar, it’s the same as the one you used to style the WaterArea and buildings layers. Use the options to change the woodland to a dark green fill with no stroke.
· As usual use the back arrow at the top to get back to the full list of categories.
[image: images/styles/Woodland_small.png]
The map with woods styled as dark green. The other natural features haven’t been styled yet.
Note that I’ve chosen green for the woods because in general that’s the colour your audience would expect them to be.
Now continue and style any of the other categories in a suitable way, e.g. grassland in pale green, heath in purple.
[image: images/svg/info-black-24dp.png] Choosing colours for map features
There is a lot of advice in the books on the reading list about choosing colours for maps. 
In addition, try the Color Brewer web site - it lets you play with colour combinations and is specifically aimed at people making maps.
Note that if you are going to be making a layer transparent (see below) then you will probably find that it is best to choose strong colours for your polygons. They will fade when you apply transparency.
Removing feature categories that are not required
Sometimes you want to remove particular categories from the legend, in this case that isn’t a problem apart from the All other values entry. When you want to create a key for your data, this will appear. Given that it doesn’t give your audience any useful information it will be a good idea to remove it.
To remove a category:
· With the NaturalFeatures layer selected in the Layer Styling panel select all other values in the list of values.
· Click on the red minus button at the bottom of the list to remove the entry.
Changing the name of items in the legend
If you look at the list of categories in the Layer styling panel, at the moment they are completely lower case and instead of spaces have underscores. This has been taken straight from the category names.
It’s good practice to change these so that when you create legends or keys for your maps they read as normal language.
· In the list of categories double-click on bare_rock in the Legend column. This is the second column. You don’t want to change the text in the first column (Value) or your features will disappear from the map because the values will no longer match.
· Instead of bare_rock type Bare rock and press Enter.
You should see that the text also updates in the Layers panel.
Continue to edit each of the legend headings so that they all start with an uppercase letter and have spaces rather than underscores. You can also use this method if you need to add a bit more description to a legend item.
[image: images/styles/LegendUpdated_small.png]
The categories list in the Layer styling panel showing the updated legend entries with uppercase first letters and spaces instead of underscores.
Setting transparency
It can be useful to make your layers transparent. Layers higher up in the layers panel will hide the layers underneath and it can be useful to see through the top layers.
[image: images/svg/videocam-black-24dp.png] Making vector layers transparent in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the SE_Building layer in the Layers pane.
· If the Layer styling panel isn’t already open, click on the button at top left of the Layers pane to Open the Layer Styling Panel or use F7 on your keyboard.
· Make sure that the Fill is selected.
· Use the Opacity slider to change the opacity or transparency of your layer. For example, slide it to about 70%.
[image: images/svg/warning-black-24dp.png] Warning
It is also possible to change the transparency by using the Opacity setting in the Layer Rendering section, but if you do that the features may not remain transparent when you export your map to pdf. This is something you have to experiment with!
Styling line features
Styling line features is basically the same as styling polygon features so refer back to the instructions for those too, but there are some extra things to think about in addition to choosing colours for fill and stroke.
Styling lines as single styles
· Start by styling the Waterway layer as a single style - use a blue stroke, similar to the fill colour of the water areas, and set the Stroke width to 0.36 mm. You’ll see that you now click on Simple Line rather than Simple Fill. You can select a line from the gallery and then make changes to the style, if you wish.
[image: images/styles/InterimMap02_small.png]
The map showing all the layers that you’ve styled so far, including the waterways.
[image: images/svg/create-black-24dp.png] Styling railways
You also have a layer called SE_RailwayTrack. Make that visible and use the gallery to choose a suitable style for the feature class.
Note that the railways on this map are to the west of Otley so you may have to pan in that direction to find any.
There is a style called topo railway. Try applying that then have a look at the elements that make up that line to see how it has been constructed.
Styling lines as categories
Lines can also be styled as categories in the same way as polygons.
· Select the SE_Road layer, make it visible on the map and go to the Layer Styling Panel
· Change Single symbol to Categorized and set the Value to CLASSIFICA.
· Click on Classify and have a look at the values that are being used to classify your data.
As with polygons, you can now style each category of feature differently.
· Double-click on the symbol next to A Road. Now have a look at the values in the gallery. You should be able to find one called topo main road.
· Once you have that selected you can change the Width to something thinner, e.g. 1.06 mm
· Staying on Line, change the Color to red.
Notice that the apparently single line of the topo main road is actually made up of two lines, the lower being thicker than the upper so that it looks as if it is the outline.
· To get rid of the black lines across the roads click on the black Simple Line - next to Cap style select Flat.
[image: images/svg/create-black-24dp.png] Styling roads
Use the instructions above to also style the following categories, each time starting with the topo main road symbol and altering the colour and width.
• Primary road - Make this red again, but make the line a bit wider than the A road style.
• B road - these are usually a pale orange and thinner than the A roads.
• Minor road - try yellow for these.
• Local street - make these grey outlines around white roads - so you’ll need to change the colour of each component line separately. Local streets will be the thinnest roads on your map.
[image: images/styles/StyledRoads_small.png]
The styled roads with the other layers that you’ve already styled too.
You don’t need the rest of the types of road lines so just untick those, or click on them in the Layer Styling panel and remove them from the classified list.
Once you’ve finished styling the road lines turn the other layers that you’ve already styled back on and save your project.
Styling point features
Again, basic point styling is very similar to styling lines and polygons.
Styling point features as a single symbol
In the project you downloaded look in the Layers Panel under the Vector data group. You should be able to find a layer called Tourism.
· If the Tourism layer isn’t already visible, tick in the box next to it so that it appears on your map.
· Open the Layer styling panel if it isn’t already open, and try out some of the point symbols in the gallery. If the box at the top of the gallery doesn’t say All Symbols drop it down and choose that now.
· When you’ve chosen a symbol you may need to make changes to the size and colour so that they appear clearly on your map.
Styling points with categories
If you look in the attribute table for the Tourism layer you’ll see that the column named tourism includes information about the type of attraction. You could use this to style the points so that this layer is more informative.
· Still in the Layer styling panel with the Tourism layer selected, change Single Symbol to Categorized.
· Set the Value to the tourism field
· Click on Classify to create the categories.
[image: images/styles/TourismRandom_small.png]
The Tourism layer styled as the initial randomly coloured categories.
· Tidy up the categories by removing all other values and renaming the legend items so that they start with a capital letter and have spaces rather than underscores.
[image: images/styles/TourismTidied_small.png]
The categorised tourism layer with the legend entries tidied up.
Styling points with svg markers
You can change the symbols by double-clicking on each symbol in turn and selecting different ones from the Gallery.
At the moment all your symbols are Simple markers. It is easy to change them to SVG markers and have a wider range of symbols to choose from.
[image: images/svg/videocam-black-24dp.png] Styling points with svg markers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Double click on the first symbol in your list in the Layer Styling panel (in my example it is artwork)
· In the box at the top click where it says Simple marker
· Below that change the Symbol layer type to SVG marker
SVG stands for Scaleable Vector Graphics and is basically what it says. In the context of QGIS it gives you a much greater range of pictorial symbols with which to style your map.
· Have a look at the SVG Image gallery at the bottom of the panel and select an appropriate symbol. I couldn’t find an obvious one for artwork, so chose the image of a book!
· You can use the settings above the change the size, colour, rotation etc.
· Sometimes the symbol on your map becomes clearer if you change the Stroke width to 0.1 - try that, you can go back to No stroke if it doesn’t work.
· The symbols should appear on your map automatically, but if they don’t click on Apply
· When you’ve finished click on the back arrow at the top of the panel to get back to the list.
[image: images/styles/SvgMarkers_small.png]
Choosing an SVG marker for the Artwork points from the Tourism layer.
[image: images/svg/create-black-24dp.png] Choose symbols for the points in the tourism layer
Continue in the same way to select appropriate svg symbols for the rest of the categories in the Tourism layer.
It is possible to create your own svg symbols and use those on your maps. You’ll be learning to create svg drawings later in this module. In level 2 I’ll show you how to use custom symbols for geological maps.
· To complete the map, turn the contours back on. You don’t need the vmd-raster layer as that information is now provided by the vector layers.
[image: images/styles/InterimMap03_small.png]
The map with the vector layers styled and contours turned back on.
Using style files in QGIS
So far, we’ve been styling layers from scratch using the settings in the Layer Styling panel. Sometimes data will have style information with it when you download it.
You’ll find out more about saving and sharing your own styles in level 2 GIS classes.
Styling the geology with lyr files
Adding the geological data to your map
If you look in the bgs-50k folder in the data you downloaded from Minerva, you will see that you have been provided with the shapefiles for British Geological Survey 1:50 000 sheet 69, Bradford in the folder ew069.
· Drag and drop the ew069_bradford_bedrock.shp layer into your map.
You should have a layer which contains a large number of polygons all styled in a single colour.
· Have a look at the attribute table of this layer.
You should be able to see that styling this layer appropriately yourself would be difficult. Which field would you use? How many different classes are there? But don’t worry, you have been provided with the style files to make the data look like a proper geological map using BGS styles (i.e. the correct BGS colours). If you download BGS data from Digimap, the style files are included in the download.
At this stage you can’t see the style files in QGIS because you need to start by installing a plugin.
Installing the SLYR (Community Edition) plugin
You need to start by installing the SLYR (Community Edition) plugin to be able to add the styles to your map.
[image: images/svg/videocam-black-24dp.png] Installing plugins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu go to Plugins > Manage and Install Plugins...
· When it opens, click on the Not installed heading on the left.
· Type SLYR into the search box at the top.
· From the list that appears click on SLYR (Community Edition) and have a look at the description.
· Finally, to install the plugin click on Install Plugin.
[image: ../../shared/docs/images/bgs_data/InstallingSLYRplugin_small.png]
Finding and installing the SLYR Community Edition plugin in the Plugin Manager.
Once it has been installed you should get a message at the top telling you it has been successful, and SLYR (Community Edition) should now be in the list of Installed Plugins.
· You can Close the plugin manager now.
Applying the lyr styles
[image: images/svg/videocam-black-24dp.png] Applying styles to a layer with a .lyr file in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Now you have the plugin, you can style the geology layers on your map.
· Return to the browser panel in QGIS. Select Project Home and click on the Refresh button at the top of the Browser.
Your ew135 folder should now look like the figure below. It should show .lyr files to match the .shp files.
[image: ../../shared/docs/images/bgs_data/BrowserSLYR_small.png]
The .lyr files should now be visible in the same folder as the shape files.
· Remove any geology layers you’ve already added to your Layers panel. These will just get in the way when you add the .lyr files.
· Now drag and drop the ew069_bradford_bedrock.lyr file from the Browser panel to your map. Make sure you pick the .lyr, not the .shp file this time.
The bedrock geology should appear on your map. You may need to move it upwards in the Layers panel to be able to see it.
The layer should appear correctly styled as in the image below.
[image: images/svg/warning-black-24dp.png] Warning
If the layer doesn’t appear on your map and has a warning triangle next to it in the Layers panel, click on the warning triangle and navigate to the .shp layer.
A .lyr file contains the style information, but only links to the data, which is in the .shp file. If the link is broken, as it sometimes is when you download data (though no fault of yours), you need to repair the link.
[image: images/styles/BedrockGeology_small.png]
The styled bedrock geology layer.
[image: images/svg/create-black-24dp.png] Add linear geology to your map
Repeat the drag and drop with the linear .lyr files to add the linear features to your map.
Move the layers in the Layers panel so that they are in a single group called Geology and show in the order below:
· Linear
· Bedrock.
[image: images/styles/GeologyMap_small.png]
The symbolised geological map showing the bedrock and linear geology.
Using blending modes to show all layers
Finish by making the geological layers transparent so that you can see the basemap underneath them. You’ve used transparency to do this before, but here I’ll show you another way which is often more effective and that is to use blending modes.
· Select the bedrock geology layer in your Layers panel.
· Open the Layer Styling panel, if it isn’t already open.
· Go down the the bottom of the panel and click on the little arrow next to Layer Rendering to see the options.
· Drop down the list under Layer next to Blending mode.
· There are lots of options here, and you are welcome to try them out, but the most useful in this case is Multiply, so select that for now.
[image: images/styles/BlendModeMultiply_small.png]
Setting the Layer blending mode to Multiply in the Layer Rendering options.
You’re aiming for a result where the bedrock layer is still clear and easy to see, but it is also possible to see roads, rivers etc through it. You may feel it would be useful to apply some transparency to the layer as well as the blend mode.
[image: images/styles/BlendModeMultiplyResult_small.png]
The map with a multiply blend mode applied to the geological layers so that the background map shows through.
[image: images/svg/info-black-24dp.png] Setting up a background map for geological data
In this example I’ve given you the instructions to create a multicoloured background map. If you look at the British Geological Survey geological maps you’ll notice that they style the background map entirely as greyscale. This is clearer as the background is still visible, but the colours don’t “interfere” with the geological colours.
The styling works in exactly the same way but instead of choosing colours, choose shades of grey.
Save this map - you’ll be using it again in the next section which is on labelling your data.
Labelling your data
If you look at any map, you’ll be able to see that attributes from the attribute table have been used to add labels. Labels on your data are essential to the understanding of the map.
When you have information in your attribute tables it is really easy to add labels to your features on the map. You may not need to add them to all layers, but they can really help interpretation. For example, if you look at British Geological Survey published maps they add symbols or letters to each rock polygon. These labels are then included in the key and make it easier to spot which symbol applies to which type of rock. Points can be labelled to show location names or dip angle, and names can be added to lines, such as “Moine Thrust” on the appropriate thrust fault.
Adding simple labels
We’ll add simple labels to the bedrock geology layer to add a code to each rock formation.
[image: images/svg/videocam-black-24dp.png] Labelling features in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the ew069_bradford_bedrock layer in the Layers panel.
· Start by looking at the attribute table. You need a short abbreviation with which to label each bedrock polygon on your map. Which attribute contains a short abbreviation for the rock formation name? You could choose to use either LEX or LEX_RCS. I’ll use LEX as it is shorter.
· Open the Layer Styling panel and click on the Labels tab on the left-hand side.
· This layer is currently set to No Labels. Drop the box down and select Single Labels.
· QGIS starts by guessing which field to use - this will probably be wrong! Next to Value select the field you decided to use above.
[image: images/svg/warning-black-24dp.png] Warning
Check you are changing the Value field on the Labelling tab of the Layer styling panel, not the Symbology tab. If you change from LEX_RCS to LEX for the styles, your bedrock layer will probably disappear.
If you do that by mistake, just change the Value back to LEX_RCS and your bedrock should reappear.
The labels will automatically appear on your map. At this stage they are using default settings and probably won’t look very good. A general rule for dealing with both styles and labels is “don’t settle for the defaults”. Not unless you’ve thought about them, anyway!
The settings for the labels are controlled by the series of tabs underneath the Value field. To start with check that the left-hand tab is selected - this has a tooltip which says Text.
· With the Text tab selected choose a font for your labels. Select a clear font - remember your audience!
· Size depends on the scale at which you will be printing or exporting your map. We’ve used 1:50 000 scale geological data, so set the scale of your map to 1:50 000.
· Now set the Size of your font so that most of your labels fit within the bedrock polygons, for example, I set mine to 7 Points.
· Black is a rather strong colour on most maps - try changing the colour to a dark grey, for example, in the colour chooser find the box for HTML notation and type in #5b5b5b.
[image: images/styles/LabelText_small.png]
The Text settings for labelling the bedrock geology polygons.
Placing labels for a polygon layer
· Now go to the Placement tab at the top of the panel - you may need to use the arrows to move along the row of tabs.
This tab controls how the labels relate to the area of the features to which they apply.
· Drop down the Mode box and have a look at the effect of the different choices on the labels on your map. Choose for yourself which one you prefer.
· Also have a look at the effect of ticking and unticking Allow placing labels outside of polygons.
[image: images/styles/LabelPlacement_small.png]
The Placement settings for labelling the bedrock geology polygons.
There are plenty of other settings on the other tabs, feel free to have a go with those and see what they do. We’ll have a look at techniques such as Callouts and manually moving labels in your level two GIS classes.
[image: images/svg/library_books_black_24dp.png] Recommended reading
Use the book by Graser and Peterson (2018) from the reading list to experiment with different ideas. Part 2 of the book is about labelling. Browse through the pictures and pick something you like the look of to try or use the index to find specific technqiues.
[image: images/styles/InterimMap07_small.png]
Labels from the LEX field on the bedrock polygons on the map.
Placing labels for a point layer
The placement of labels for polygons can be relatively straightforward, though it’s a good idea to experiment, but placing labels on points can be more complex, depending on how the point is being used.
· Make sure that the SE_NamedPlace layer is visible on your map, and all the other layers are made invisible.
· In the Layer styling panel turn on Single Labels for the Named Places layer.
· Check that the Value is set to DISTNAME.
[image: images/styles/DefaultLabelsPlaces_small.png]
The default styling and locations for the names from the named places layer.
· Set the font and size as you wish
· Then go to the Placement tab of the Label options.
· By default the Mode will be set to Around Point. Try changing it to Cartographic and see what difference it makes to your map. The text in italics underneath the box gives you a bit of an idea of what that mode aims to do.
· You’ll also see that you can choose Distance - this is the distance of the text from your point. At the moment the text is probably overlapping the point, try increasing the distance and see what difference it makes.
· You can also choose the Distance offset from - try changing that to From Symbol Bounds.
· Now change the Mode to Offset from Point - this time your labels will be placed on top of the point to which they refer. You can change this by clicking on different locations next to Quadrant. Experiment if you wish, then leave it set to the centre.
It’s difficult to make any definite recommendations about settings as it depends on your map and the density of the text. The aim is to space the labels out so that they can all be read, but also so that it is clear to which feature the label applies.
[image: images/styles/LabelsOverSymbol_small.png]
Labels positioned with the Offset from Point mode, set to appear on top of the symbols.
One more setting which may help is being able to wrap the label onto more than one line.
· Go to the Formatting tab at the top of the Labels panel.
· Go down to Multiple lines and have a look at the Wrap lines to box.
· At the moment the box should be set to No automatic wrapping. Change that so it reads 10 characters by using the up arrow at the right-hand side.
· You can also change the settings for Line height and alignment. Try changing Line height to 0.70 and Alignment to Center.
Experiment with these settings until you are happy with your labels. Remember that you can also change the size and style of your font.
· For these place name labels finish by going into the Symbology tab of the Layer Styling panel and setting the symbols to No Symbols at the top of the panel.
· Also feel free to try out any of the settings on the other Label tabs, for example, setting a Buffer around the text can be very useful in some situations.
[image: images/styles/LabelsPlaced_small.png]
The named places labels positioned and wrapped, with the symbols turned off.
Finish this section by turning on the rest of the layers that you’ve already styled and having a look at your map. You can go back in and change the label settings if you aren’t happy with it.
[image: images/styles/InterimMap08_small.png]
The map with all the layers that have been styled so far and the named places labels.
Placing labels for a line layer
Labelling lines creates another set of challenges. Do you need your labels above the line, or on top of it? Does it need to follow the line exactly or can it be straight?
· Make all the layers on your map invisible apart from the Waterway layer.
· If you have a look at the attribute table for the data the name field contains the names of the waterways.
The usual way of labelling water courses is to give them a label the same colour as the line, and above or to the left of the line, following the curves.
· Set the Labels properties in the Layer Styling panel to Single Labels with the name field as the Value.
· Set the font and font size to something you think looks right, then change the Style to Italic - this is fairly commonly used for water labels.
· Click on the Color, then on the Color Picker tab at the top of the panel. Click on the button that says Sample color to get a color dropper tool.
· Now hover over one of the water courses on your map and when the colour panel on the right picks up the blue, click your mouse. This can be a bit fiddly, so try again if you miss.
[image: images/styles/ColourPicker_small.png]
Selecting the correct shade of blue from the water courses with the color picker tool.
Your labels should change to the correct shade of blue to match the water courses.
· Once you’ve chosen the correct colour use the back arrow to go back to the Labelling panel.
· Now go to the Placement tab.
· Under the General Settings set Mode to Curved and make sure that Above line is ticked.
Your labels should now appear curved to something close to the shape of your lines.
[image: images/styles/PositioningLabelsOnRivers_small.png]
The Mode for the labels is Curved, so the labels follow the shapes of the rivers.
[image: images/svg/library_books_black_24dp.png] Recommended reading
Refer to Darkes p.58-59 or Peterson p. 93-101 for more information on label placement.
Setting symbol or label size at a particular scale
This is an optional section. You may find it useful to know how to control the sizes of your labels or symbols, but otherwise just be aware that it is possible and come back to this section if you need it. Otherwise continue to Using Rule-based labelling.
So far all the sizes that you have set for symbols are millimetres, and for labels are points. These are sizes that refer to either the size on screen, or to the paper size when you print or export your map.
Sometimes it is useful to be able to set the symbol and label sizes so that they appear relative to the scale rather than the paper or screen size.
To see what this means try the following:
· With the Waterway layer visible and the rest of the layers invisible, zoom out to about 1:100 000 and back in to about 1:10 000. Have a look at the thickness of the lines and the size of the text.
· Now open the Layer Styling Panel for the Waterway layer.
· Under the Symbology set the Unit to Map Units and the Width to 20.
· Under Labels set the Size to 70 and the box underneath to Map Units instead of Points.
· Again zoom out to about 1:100 000 and back in to about 1:10 000. Have a look at the thickness of the lines and the size of the text.
[image: images/svg/help_outline-black-24dp.png] What difference do you notice?
What difference does it make to the lines and labels on your map when you change the units of measurement?
Map units refer to the units for distance measurement which are set for your project, usually by the coordinate reference system that you have set. In this case the map uses British National Grid.
You can find the map units by going to
· Project > Properties... > General in the menu bar
· Then looking next to Units for distance measurement under Measurements.
[image: images/svg/help_outline-black-24dp.png] What are the Map Units set to for this project?
You should find that the map units are metres.
This means that the width of the lines and the size of the font for the waterway layer is now being applied as the size “on the ground”, e.g. we set the width of the lines to 20, so each line is effectively taking up 20 metres on the ground. As you zoom in and out the width of the line then appears to change, but is actually remaining the same relative to the real world.
This can be useful if you know what scale you will be printing or exporting your map. Set your map to that scale, then set units to map units, and you can control how your map appears at that scale.
It can also be useful to set this so that if you zoom out a long way you don’t find your symbols covering an enormous area, they just shrink and become less obvious.
This is one of those things where it’s up to you which method you use, depending on what you are trying to do with your maps.
[image: images/styles/InterimMap09_small.png]
The map with the vector layers styled and labelled.
Using Rule-based labelling
It is possible to use multiple styles of label for features within a single feature class. We’ll use the SE_NamedPlace layer to investigate how to set this up using rule-based labelling.
· If you have a look at the attribute table of the SE_NamedPlace layer you’ll see that there is a field called CLASSIFICA which contains information about the type of place.
We’ll set up the labelling so that different classes of feature have different labels.
[image: images/svg/videocam-black-24dp.png] Rule-based labelling in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the Labels tab of the Layer Styling Panel and check that the SE_NamedPlace feature class is selected.
· Change the dropdown at the top from Single Labels to Rule-based Labeling.
You’ll get a panel containing a single label class or rule and the labels on your map should look the same as they did before.
· Untick the existing rule so that your labels disappear.
· Click on the green plus button at the bottom of the panel to get the panel to Edit Rule
· For Description enter Populated place then click on the E button to the right of the Filter line.
· This will open the Expression String Builder which consists of three panels. You’ll build the expression on the left using the tools in the other two panels.
· In the centre panel drop down Fields and Values and double-click on CLASSIFICA
· Next click on the = button on the left to add the equals character to your expression.
· Then click the All Unique button on the right. This gives you a list of the available classes.
· Double-click on Populated Place
Your expression should now read:
"CLASSIFICA" = 'Populated Place'
· Now click on OK to return to the Edit Rule panel.
[image: images/styles/LabelRules_small.png]
Creating the rule for your labels.
· The rest of the form should look familiar. Under Value select DISTNAME and now you can choose your settings as usual for your labels.
· When you’ve finished use the back button at the top to return to the list of rules.
[image: images/svg/create-black-24dp.png] Set a label rule for landforms
Now that you have labelled populated places try the same actions to set up a label rule to label landforms. There aren’t as many of these labels, but try making them a bit larger.
Final touches to the labels
Now we’ll finish building up the 1:50 000 geological map.
· Turn all the layers back on, including the geological layers, but not including the vmd-raster layer.
The first thing you may notice is that the place and waterway labels “float above” the bedrock geology polygons. Particularly with halos set around the text this looks a bit odd, and in this case the labels only need to be in the background.
[image: images/styles/LabelsFloating_small.png]
Labels floating above the bedrock geology - it’s particularly clear with the halos.
The only way I’ve found to deal with this in QGIS is to go back to your labels and edit the styles.
· Either avoid the use of buffers or use them extremely carefully
· Apply Opacity to your labels using the Opacity slider on the Text tab so that the labels fade into the background a bit.
Suggested final map
Once you’ve finished your map
· Set the scale to 1:50 000
· Set the background map as the Vector data group and turn off the vmd-raster_4113816 layer - I want to be able to give feedback on your work, not the work of the Ordnance Survey!
· Check that all the vector background data is lower in the Layers panel than the bedrock geology. Remember that layers appear on the map in the same order as in the Layers panel.
· The Natural Features layer has rather obvious polygons which can interfere with the geology bedrock. You could try making the Natural Features 50&percent; opaque, or remove them completely.
· Set up a simple layout containing your map, a title and any other elements that you think should be present. Check that the scale is still 1:50 000.
· When you are happy with your map go to Layout > Export to Image...
· Click on Save and choose where to save your file and what to call it.
Now upload the map to your individual area of the Class Notebook as a record of what you have done.
If you upload your map during the week after the class, I will give you brief feedback on what you have done.
Your map could look something like the map below - hopefully even better! We won’t worry about setting up a full layout at the moment as that is covered in a later chapter, but if you’d like to have a go you can upload the output from that instead.
[image: images/styles/FinalMap_small.png]
Possible final map of the geology of the Otley area. Yours will probably look different to this one as we will all make our own choices for colours and styles.
Recommended reading: Styling and labelling your maps
The University of Delft has an open course about Creating data visualisations with graphs, maps and animations. The emphasis is on communicating your data to an audience. Sections of particular interest are:
· Visualize Data in Maps
· Cartography for Map Figures in Academic Journals and Books
The books in the Principles of Cartography section of the reading list[footnoteRef:901] cover good practice for styling and labelling your maps. Suggestions include the following: [901:  The reading list is available in Minerva and from the library (search for the number of this module).] 

For a quick guide go for Darkes and Spence (2017). The section on “Symbolisation” on pages 17-18 and “Text on maps” on pages 23-25 are particularly relevant.
Peterson (2021) is a very readable book about map design. Chapter 4 covers fonts and chapter 6 covers features. These chapters are both relevant to styling and labelling.
If you want specific techniques for QGIS then Graser and Peterson (2018) have lots of ideas. Browse through the book and look at the pictures to find something you fancy trying and just have a go. If you are looking for a particular technique, make use of the index.
Using GIS for analysis
Last Modified: 07 Sep 23, 14:51:12
The background to using GIS for analysis will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate how to select and display point sampled spatial data
· demonstrate the use of symbology to analyse and display data on a map
· select appropriate tools to carry out geoprocessing tasks in QGIS in order to answer specific questions.
Introduction to using GIS for analysis
The glen of the River Cononish near Tyndrum in Scotland has historically been a lead mining area. In 2012, after further exploration, planning permission was granted for Scotgold Resources to mine gold in Cononish mine.
[image: images/analysis/Cononish_small.jpg]
River Cononish. Ben Lui dominates the view ahead.
Using data from stream and soil samples we will look at ways of processing and displaying point sampled data in GIS to investigate possible lead contamination from the historic mines.
The techniques in this chapter will give you an introduction to carrying out analysis in GIS and can be used for a wide variety of data, not just the geochemical data that we use here.
Have a look at some more examples on the GIS for Science website or in the ESRI GIS Showcase. These may give you some inspiration for your own maps and data.
Data to download for analysis
Follow the instructions below to download the data that you will need for these exercises.
· Create a new folder called Cononish in your GIS folder and put all of your unzipped data in there when you download it.
Geochemical data
You will create the map yourself, but the data, which consists of a spreadsheet and a shapefile which outlines the study area, should be downloaded from Minerva.
· Download CononishQMinerva.zip from the Minerva folder for this week.
The data was collected as part of a student project in 2009 and is presented as an Excel spreadsheet which gives you details of the locations of the stream and soil samples in British National Grid references and the lead concentration (in parts per million - ppm) in each sample.
The zip file also contains a shapefile outlining the study area.
Map data from Digimap
Using Digimap OS Download download the following data:
· OS 1:25 000 Raster for at least the area shown in the image below. You should search for Tyndrum as Cononish doesn’t seem to be in the gazetteer. Tyndrum is the village to the north-east of Glen Cononish.
[image: images/analysis/ConProfileArea1_tr.png]
The minimum area for which to download data from Digimap OS Download.
Setting up your map
You will set up this map from scratch. If you can’t remember how to do this refer back to the section on Starting a new project in QGIS.
· Open QGIS and save a new map project to your Cononish folder as Cononish.qgz.
· Add the 1:25 000 raster tile(s) from Digimap to your map. These should be a .tif format file.
· It’s a good idea at this stage to check the coordinate system of your map has been set to British National Grid
· It probably won’t have been set as the 1:25 000 raster data doesn’t have the coordinate system assigned, so adding this layer to the map first doesn’t change the map coordinate system to British National Grid. In this case it doesn’t matter that the 1:25 000 raster layer doesn’t have a CRS as it is just a background layer, but you do need to make sure that the map has the right CRS.
· So set the coordinate system of the map to British National Grid now.
· If you want to check that your map is in the correct location add a tile map and check that features such as the roads line up. It’s probably safest to remove this tile map once you’ve checked, so that it doesn’t slow down the drawing of the rest of your map later.
[image: images/analysis/InterimMap01_small.png]
The map with the 1:25 000 background layer. Note that the CRS is set to EPSG:27700, which is British National Grid.
Importing xy data
The next thing we will do is to add the data from the Excel file to QGIS. This data is a form of what can be called xy data because the file contains the x and y coordinates for locations as well as other data.
If you haven’t already, download the CononishData.zip file from Minerva and unzip it into the project folder.
Preparing the spreadsheet
· Open the Excel spreadsheet, XYZ_Pb.xlsx in any spreadsheet program to have a look at the data.
You should have a file which includes grid references for the British National Grid (these are the columns headed Gridref, eastings and northings) and lead concentrations from soil and stream samples in parts per million (ppm) (the column headed concentration).
[image: images/analysis/Spreadsheet_small.png]
The first few rows of the spreadsheet showing the location and concentration of the samples. This is how it looks in Excel.
[image: images/svg/warning-black-24dp.png] Warning
Note that when you are preparing a spreadsheet to import into GIS, the column headings must be short and contain no spaces or non-standard characters. So use text, numbers and underscore characters only. Always look at your tables and edit them if necessary before importing in GIS.
Notice the eastings and northings columns which show the grid reference. These are in British National Grid 1 m coordinates.
We need to do some work to make these coordinates suitable for importing into QGIS. If you import the spreadsheet as it is, these coordinates will leave your data somewhere in the sea south-west of Cornwall.
Note the column titled Gridref - that tells you which 100 km grid square the references are in, NN in this case. Unfortunately GIS programs won’t read these so you need to convert the references into numeric equivalents.
British National Grid 100 km squares
British National Grid references are most commonly given in the form NN6005,2674, with grid letters at the start to give the 100 km grid square. These letters need to be replaced by numbers if the grid references are to be read by QGIS (or indeed virtually any other app or program).
If you are given a reference that does not include the grid letters but consists entirely of numbers, it is worth checking whether the grid numbers make sense as they are - that is, that they apply to the location you are expecting. Of course, it may just mean that the person who created the references forgot about the letters, in that case the reference could refer to any of the 100 km squares covering the UK - not helpful!
Replacing 100 km grid letters with numbers
[image: images/svg/videocam-black-24dp.png] Replacing British National Grid 100 km grid letters with numbers
This video clip can be found in the module area of Minerva or in the full list of video clips.
Follow the example below, then have a go for yourself with the examples provided.
[image: images/analysis/BNG_small.png]
British National Grid 100 km grid squares.
Using the example SK 6005 2674 (note that this is not Cononish)
· find the number of the line to the left of the grid square in the image above (i.e. one of the numbers from the line at the bottom of the map) - for SK this is “400” - so write it down as 4.
· This number will apply to all of the references in the eastings column of the spreadsheet
· then find the number of the line below the grid square (i.e. one of the numbers to the left of the map) - in this case “300” - so write it down as 3
· This number will apply to all of the references in the northings column of the spreadsheet
So in this example grid reference SK 6005 2674 will become 46005 32674.
· In addition, x and y numbers all need to be six figures to appear in the correct location on a map in QGIS, so if, as in the example, there are fewer digits then we have to add zeros to the end of each to make it up to six figures.
Finally the grid reference above will become 460050 326740 and at this stage will be ready to enter into QGIS.
[image: images/svg/create-black-24dp.png] Practice converting grid letters to numbers
Using the instructions above convert the following grid references to British National Grid numbers with 6 figures for each half (12 in total) so that QGIS will be able to read them. Answers are in the footnotes[footnoteRef:934]. [934:  The QGIS-readable grid references are as follows:
1 - NH 3395 3196 = 233950 831960
2 - SP 727 499 = 472700 249900
3 - TM 2753 3952 = 627530 239520] 

1 - NH 3395 3196 =
2 - SP 727 499 =
3 - TM 2753 3952 =
If you look at the corners of a published hardcopy Ordnance Survey map such as the Landranger (Pink covers) or Explorer (Orange covers) series you’ll be able to see these numbers as small figures on the labels of the grid lines - only at the corners, though, not right around the edges. The grid letters will appear in the corner of the published maps too.
Replacing the numbers in your spreadsheet
If you don’t have many locations that you need to change then you can edit each one manually, but if you have many sample points this rapidly becomes a big job. Try using the power of the spreadsheet to do this more efficiently.
Start by working out what numbers you need to replace the grid letters using the instructions above.
· Open your spreadsheet in Excel or similar
· Before you go any further, Save the spreadsheet with a new name, for example XYZ_Pb_ed.xlsx to indicate it has been edited.
[image: images/svg/info-black-24dp.png] Saving a copy of the original data
It is good practice to avoid making changes to the original data as far as possible so by doing this, you will be making your changes to a copy and can go back to the original if there is a problem.
· Give headings to two more columns to the right of the rest of the data - call them x and y
· Click in the first cell in the x column then go up to the Formula Bar at the top
· Type =( in the Formula Bar then click on the first cell in the easting column, the reference of that cell should appear, e.g. C2
· Now type in the formula bar - *10)+200000 (that’s 5 zeros after the 2). The first number before the 5 zeros (2 for the grid square containing Cononish) should be the one that you found when converting the grid letters. We are multiplying by 10 to add a zero to the end of the original number so that once we’ve added 200000 we have a six-figure number. You won’t always need to do this, it depends how many grid numbers you’ve been given, but for QGIS alway aim for six figures for each part of the final grid coordinates.
The statement should read:
=(C2*10)+200000
· Press Return to apply the statement to the cell.
[image: images/analysis/ExcelFunctionBar_small.png]
Typing the function in the first cell.
The six-figure reference for the x coordinate should appear in the cell.
· Repeat the above for the first cell in the y column using the northing column and the second number that you found.
· Now select both of the cells that you’ve just edited
· Note the tiny square at the bottom right of the selection, click and hold on it and use the mouse cursor to pull it down the other cells in those columns.
The rest of the cells should autofill with the correct grid references.
[image: images/analysis/XYZpbSpreadsheet_small.png]
The first few rows of the spreadsheet containing the location and concentration of the samples.
Check the results look correct. All numbers in the x column should begin with 2 and in the y column should begin with 7. All numbers in both columns should be six figures.
Save your spreadsheet then close it and make sure that your Cononish map is open in QGIS.
Converting .xls or .csv to a feature class
It is possible to convert a spreadsheet to a csv (comma-separated value) format to import it into QGIS. Alternatively, we can install a plugin which allows us to import the spreadsheet without converting it to csv first. The plugin will also allow you to import csv data.
Installing a QGIS plugin
One of the strengths of QGIS is that it has a wide variety of plugins that you can install to carry out extra tasks. It’s worth having a look at the list of plugins available to you in the plugin manager.
[image: images/svg/videocam-black-24dp.png] Installing plugins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu bar go to Plugins > Manage And Install Plugins...
· When it opens click on the Installed heading on the left to see the plugins that are already installed.
· If you click on a plugin you’ll be able to see a bit about it in the panel on the right.
[image: images/analysis/PluginsInstalled_small.png]
The plugin manager showing the core plugins that are installed when you install QGIS. Your list will probably be different to mine.
To install a new plugin:
· Click on Not installed on the left
· Type Spreadsheet into the search box at the top
· From the list that appears click on Spreadsheet Layers and have a look at the description
· This plugin will do what you want it to do so click on Install Plugin
[image: images/analysis/PluginsSpreadsheetLayers_small.png]
Installing the Spreadsheet Layers plugin.
Once it has installed you should get a message at the top telling you it has been successful, and Spreadsheet Layers should now be in the list of Installed plugins.
· You can Close the plugin manager now.
· If you can’t see the Manage Layers toolbar (see image below) make it visible by going to View > Toolbars and putting a tick in the box next to Manage Layers toolbar. It will probably open vertically to the left of your Layers and Browser panels.
· You should gain a new button in the Manage Layers toolbar - hover over it to see the tooltip which should say “Add spreadsheet layer”.
[image: images/analysis/ManageLayersToolbarSpreadsheet_small.png]
The Manage Layers toolbar showing the new button for Add spreadsheet layer.
Converting the spreadsheet
[image: images/svg/videocam-black-24dp.png] Importing points from csv or spreadsheet to QGIS with the Spreadsheet Layers plugin
This video clip can be found in the module area of Minerva or in the full list of video clips.
To convert the spreadsheet so that you can use it in QGIS:
· Click on the Add spreadsheet layer button to open the dialog. Start filling it in by browsing for your spreadsheet file using the button to the right of File Name.
· Make sure that there is a tick in the box next to Geometry and select the x and y fields as appropriate.
· Set the Reference system to the correct CRS. This time it will be the same as the current project - EPSG:27700 - OSGB36 / British National Grid.
· Check the data types in the preview pane. The important one here is under the concentration column and that should be set to Real, which means a decimal number.
· Check that the table previewed below looks correct.
· Then click OK.
[image: images/analysis/CreateLayerFromSpreadsheet_small.png]
Creating a layer from a spreadsheet. Check that the concentration column is set to Real.
The data points from the spreadsheet should appear on top of the 1:25 000 base map. Use Zoom to Layer if you need to. If they don’t appear over the background map, check that you entered the x and y columns in the add spreadsheet tool correctly and the coordinate system too.
If you have a look in your folder in the Browser you’ll see that the new layer has been created with an extension of .vrt. This means that it is a virtual GIS format which references the original file. For our purposes it is a good idea to convert this to a geopackage feature class, i.e. a more permanent file format. This is so that we can use it in analysis.
· Right-click on the layer in the Layers panel and go to Export > Save features as...
· Save the layer to a new geopackage called Cononish.gpkg in your project folder and call the layer something like XYZ_Pb so that it’s clear what data it contains.
· Check that the CRS is correct.
· Once the geopackage layer is added to your map remove the .vrt layer.
[image: images/analysis/PbData_small.png]
The lead concentration data on the 1:25 000 background map.
Reviewing the data
As usual it is important to look at the data to see what it contains and to check your attribute table against the spreadsheet.
· Zoom in on the new layer with Zoom to layer and look at the area it covers. Each point is the location of a sample reading. Do they look as you’d expect from the image above?
· Zoom in further and have a look at the 1:25 000 map that you added first, particularly noting the locations of any mines you can see on the map.
· Open the attribute table and have a look at it. How does it compare to the original Excel spreadsheet?
[image: images/svg/create-black-24dp.png] What are the highest and lowest values?
In the attribute table sort the concentration column by left-clicking on it so a small black arrow appears. After the first click it will be sorted ascending, click again to sort in descending order.
Make a note of the highest and lowest values in the concentration column - this information will be useful later.
Although this chapter is headed Analysis, getting your data in GIS and checking it is always a big part of any project. Make sure you leave plenty of time to do these steps whenever you are setting up a project. It’s frustrating and time-consuming if you have problems with the analysis because there’s something wrong with your data.
Styling the points as graduated symbols
Now that you have the points from the spreadsheet imported into QGIS, you can start styling them to visualise the data in a more user-friendly fashion. This doesn’t use a tool from the toolbox but is an essential part of analysing your data.
We’ll use graduated point symbols for this. You’ll also see this way of displaying points described as “bubble maps”.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as graduated points in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the lead concentration layer in the Layers panel then go to the Layer Styling panel.
· Click on the dropdown box which currently says “Single Symbol” and change that to Graduated.
· Next to Value select the concentration column from your attribute table.
· Now go to the bottom of the panel and click on Classify.
By default, QGIS uses the Color method of showing the range of values. If you have a look in the Classes section, you should be able to see how the values have been divided up.
We’ll change the Method to show graduated size instead of colour:
· Use the dropdown next to Method to select Size.
The symbols should change straight away, if not click on Classify again, and on Apply at the bottom of the panel.
It’s a good idea to set transparency at this stage so you can see more of what is happening on your map when the symbols are overlapping.
· Click on the button next to Symbol and use the Opacity slider to change the opacity to something like 60%.
· You can also try using the Layer Rendering settings at the bottom of the Layer styling panel. Try setting the Layer Blending Mode to Multiply.
· You can also try setting the Feature Blending Mode to Multiply and see what difference that makes.
· Try changing the Size from settings, for example, change the upper figure to 12.
[image: images/analysis/GraduatedSymbolSettings_small.png]
Layer styling settings for graduated point symbols.
[image: images/analysis/GraduatedPointsSize_small.png]
The graduated points on the map. Don’t worry if yours look different - you should make your own decisions based on your scientific experience.
There are a lot of settings that you can change to display your data in a way that will be most informative to your audience.
· For example, try changing the Mode to Equal interval or Natural breaks, or indeed any of the other options.
· You can also change the number of Classes, though it’s not a good idea to set too many. The usual recommended maximum is six, unless you have a good reason to use more. Higher than six it can become difficult to see the categories on the map.
· You can also try alternative colours to see what effect you get. Click on the button next to Symbol to select a new colour.
· If you have your point styling set to graduated colour, you’ll be able to select a new colour ramp by clicking on the little arrow to the right of Color ramp.
There are principles for styling these maps that you can find on the cartography texts on the reading lists, but in the end, it comes down to experience, both as a map-maker and as a scientist. Experiment and see what works best for your data or for the story you are trying to tell with it.
This should also show you how important it is to look carefully at other peoples maps. Why have they decided to style their data in a particular way?
Viewing a histogram
The Layer Styling panel also allows you to view a histogram of your data. That is a graphical view of your data showing how it is distributed.
· On the Layer styling panel look just above the list of classes. You should see that you currently have the Classes tab selected, now click on the Histogram tab.
· Click on the button to Load Values.
The histogram showing your data should appear. The graph is showing the distribution of your data within the classes across the bottom and where the size boundaries are for the symbols on your map.
You may need to increase the width of your Layer Styling panel to see the histogram more clearly. Do that by clicking on the border between it and your map and dragging it across.
[image: images/analysis/Histogram_small.png]
The histogram for my lead concentrations layer, showing the distribution of data in the classes.
In my example (Classes are set to Natural Breaks (Jenks)) it becomes possible to see that most of the classes have a relatively low concentration of lead, but that there are a few classes with higher concentrations.
I can now go back to the Classes tab and change the Mode, e.g. to Equal Interval, then check the histogram again to see which setting makes my data the clearest.
It is also possible to manually adjust the classes using the histogram.
· Use your mouse to “grab” one of the lines denoting the class boundaries in the histogram and drag it to left or right.
· Try manually adding another class by clicking on the histogram where there isn’t already a vertical line. It only appears to be possible to remove one by going back to the class tab and resetting the number of classes.
[image: images/svg/help_outline-black-24dp.png] Correlations
Have a quick look at your map. Do these ways of styling your data show any correlation between lead concentrations and mine locations?
Tools and analysis
You will have shown useful information about your data by styling it in a certain way. Now you can run some processing tools to generate alternative methods of looking at your data and produce some new layers and data.
Restricting the processing area
If you are working with a large dataset it can be essential to keep processing power, time and storage under control by limiting the area of data that you process. Some tools allow you to restrict extent, so we’ll add a polygon layer to our map which outlines the extent that we’ll use for processing.
· The CononishData.zip file should have included a folder called CononishArea which contains the multiple files which make up a shapefile.
· Find the CononishArea.shp shapefile in the Browser panel and add it to your map.
· Style the polygon so that the outline (stroke) is visible, but the polygon has no fill.
[image: images/analysis/StudyArea_small.png]
The styled outline of the study area.
Creating a raster surface
The feature class you’ve been working with shows the lead concentration at each sample point. What do you do if you want to know the potential concentration at any other point between these points, or over an area?
QGIS gives you tools to interpolate point data and calculate z values, or totals, for the spaces between the points.
Inevitably the accuracy of the generated surface will increase if you have more data points in a particular area, but it can still work if your points are widely spaced.
[image: images/svg/warning-black-24dp.png] Warning
Note that you may not get a good result if your points are all in a line. If you have a dataset, think about whether it makes sense to process it in this way. Will the output really show what you want it to show or do you need more or different data?
There are different methods of interpolation in QGIS. The instructions below use Inverse Distance Weighted (IDW) as that works well for this geochemical data, but try searching for interpolation in the processing toolbox and try some of the other tools that come up too.
With IDW the interpolation is weighted so that closer to the points the values have a higher weighting from the point value.
See ArcUser for a useful article on Interpolating surfaces in ArcGIS Spatial Analyst (link to pdf). Although we are using QGIS rather than ArcGIS the article still includes useful information about different types of interpolation and when to use them.
Running a geoprocessing tool
As so often in GIS there is more than one way to carry out a particular task. In the following instructions I’ll show you how to use two different tools to carry out interpolation. You may find that one doesn’t work in your installation of QGIS. If this is the case, try the other one instead.
Using the GRASS toolbox IDW tool
[image: images/svg/videocam-black-24dp.png] Interpolating surfaces from point data
This video clip can be found in the module area of Minerva or in the full list of video clips.
The analysis tools in QGIS can all be accessed from the Processing Toolbox.
· Open the toolbox by going to Processing > Toolbox in the menu bar, or use Ctrl-Alt-T on your keyboard.
The Processing toolbox should open to the right of your map.
[image: images/analysis/ProcessingToolbox_small.png]
The Processing Toolbox when you first open it, showing the main toolboxes and tool providers.
There is a choice of tool providers in the toolbox. The series of toolboxes with the QGIS logo are the most likely to work in any installation of QGIS, but if you can use the GDAL and GRASS tools as well, that gives you much more choice. You won’t need to use the SAGA tools in this course.
To use the toolbox to carry out interpolation:
· Start by searching for interpolation in the box at the top of the toolbox.
· Look down the list and double-click to open v.surf.idw from the GRASS Vector toolbox.
[image: images/analysis/ToolboxInterpolation_small.png]
Selecting v.surf.idw from the GRASS vector toolbox.
Fill in the form as follows:
· The Input vector layer is XYZ_Pb or your lead concentration point sample layer.
· Set Attribute table column with values to interpolate to the concentration field.
· Under Advanced Parameters (you may need to click on a little arrow to drop this down) go to GRASS GIS 7 region extent and click on the three dots button at the end of the line. Click on Calculate from layer and select the CononishArea layer to restrict the processing extent.
· Set GRASS GIS 7 region cellsize to 5. This refers to map units, so the cellsize, or resolution, of the output raster layer will be 5 metres. If you have a powerful computer you can set this lower, e.g. to 1, but the tool will take a lot longer to run and the output file will be much larger.
· Under Interpolated IDW at the bottom of the form, click on the three dots button and go to Save to file... to select where to save the output and give the output a name. In this case, you’re creating a layer for lead concentrations using IDW interpolation, so something like Pb_IDW could remind you what the output file contains.
· Now click to Run the tool and if it finishes successfully click on Close.
[image: images/analysis/GrassIDWtool_small.png]
Filling in the form to run the IDW interpolation tool.
If the tool doesn’t finish successfully go back to the Parameters tab and check that you filled everything in correctly. If it fails when you run it again try the tool in the next section instead.
You will probably get a couple of warnings in red while the tool is running. For example:
· WARNING: Concurrent mapset locking is not supported on Windows.
· ERROR 6: […] SetColorTable() only supported for Byte or UInt16 bands in TIFF format.
If the output looks good you don’t need to worry about those this time.
You should have a greyscale layer on your map. You will see how to style this informatively further down, but for now go onto the next section and try the alternative tool.
[image: images/analysis/grass_idw_layer_small.png]
The GRASS IDW layer when it is first added to your map. Yours may look slightly different to mine - that isn’t a problem.
Using the QGIS native tool
There is an alternative tool for running IDW interpolation which you can use if the GRASS tool above doesn’t produce output for any reason. Even if the tool above does work, it’s worth trying this one too and comparing the results.
· In the menu bar click on Processing > Toolbox to open the toolbox, or use Ctrl-Alt-T on your keyboard. You’ll get a list of the tools available to you.
· In the search box at the top search for IDW. This should give you a few options.
· Look for the Interpolation subheading, and find the tool called IDW interpolation and double-click on it to open the dialog.
[image: images/analysis/IDW_search_small.png]
Selecting the IDW interpolation tool from the QGIS toolbox.
Fill in the form for the tool:
· The input Vector layer will be the lead concentration point layer - in my case it is called XYZ_Pb.
· Select concentration as the Interpolation attribute.
· Underneath that box click on the green plus button on the right to add the vector layer and attribute to the box - check that both are correct and Type is set to Points.
· Next to Extent click on the three dots button (ellipsis) and select Calculate from Layer > CononishArea to set the extent of processing.
· Under Output raster size change Pixel size X to 5. The other three boxes should update automatically. If you leave this on 0.01 it will take absolutely ages to run, and may well crash your computer.
· Under Interpolated click on the three dots button (ellipsis) to navigate to where you want to save the output, and give the output a name, e.g. idw.tif. The name should be something that will make sense to you if you come back to this project later.
· Check that Open output file after running algorithm is ticked.
· Then click Run.
[image: images/analysis/IDW_tool_small.png]
Filling in the dialog for the IDW interpolation tool.
The output from the above settings will have a horizontal resolution of 5 metres. If your computer is powerful enough, try changing the Pixel size X to 1 instead of 5. You’ll get a more detailed result, but it’s not worth it if it loads very slowly or even crashes your computer.
[image: images/analysis/idw_layer_small.png]
The IDW layer when it is first added to your map. Yours may look slightly different to mine - that isn’t a problem.
At this stage the output will be a greyscale layer that covers the other layers on your map. We’ll look at how to make it more informative in the next section.
Styling the raster layer
If you were able to run the GRASS IDW tool then use the output from that to carry out the rest of the exercises. Remove the other layer from your map to prevent confusion. If you were only able to run the QGIS native IDW tool then you are fine to continue with that output.
The default styling for the new raster surface is greyscale. Try using the Identify tool to see what the values are at a range of locations across the layer.
You should be able to see that surface has decimal values that change continuously. This is a continuous surface.
To style the layer:
[image: images/svg/videocam-black-24dp.png] Styling a continuous raster in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· With your IDW layer selected in the Layers panel go to the Layer Styling panel.
· Dropdown the box that currently says Singleband grey and select Singleband pseudocolor.
· Values should automatically be styled, usually in a white to red color ramp. If your layer disappears, it means there isn’t a colour ramp set, so click on the little down arrow at the end of the Color ramp box and select one of the colour ramps from there. It doesn’t matter which at the moment but if you want your map to look like my screenshots, select Reds for now.
· As usual, don’t assume that the defaults are correct. Drop down the Min/Max Value Settings section of the Layer Styling panel and check that it is set to Min/Max. It’s also worth setting Accuracy to Actual (slower).
[image: images/svg/help_outline-black-24dp.png] How do the min/max values compare with the values that you noted down for the points layer earlier?
Do the minimum and maximum values of the raster surface match the minimum and maximum values of the original points layer?
If not, why do you think this might be based on the article about Interpolating surfaces in ArcGIS Spatial Analyst (link to pdf) that I referred you to earlier?
Let’s have a look at some more ways of presenting your interpolated surface.
· As this is a continuous surface the Interpolation setting should be set to Linear. Try setting it to Discrete and see what the difference is. This works better when your data is in classes. The other option is Exact - I don’t recommend trying this as it styles each individual value, and you will have a lot!
· Feel free to experiment with the Color ramp setting, but bear in mind how your audience will interpret your data based on colour. We’ll look at this in more detail in the session on styles and labelling.
· The Label unit suffix allows you to add the units to your key for the data. Make use of this, it’s an essential part of interpreting your data and will be essential for anyone you share your map with. Type parts per million (ppm) into the box - note there is a space at the beginning of that so it isn’t too close to the number.
· Label precision controls how many numbers you will show on the legend after the decimal point. You don’t usually need many, though that does depend on your data. In this case, set that to 0 and click Apply at the bottom of the panel.
· Under Mode you have a choice of settings. It’s currently set to Continuous which is fine for this data, but try out the other settings to see what difference they make.
· Finally it’s a good idea to make the basemap visible through the raster surface layer - use the Layer Rendering settings to set Blending mode to Multiply.
[image: images/analysis/IDWLayerStyling_small.png]
The layer styling panel for the IDW raster surface.
It should now be possible to look at your map and see which areas have higher levels of lead contamination, and which lower.
[image: images/analysis/IDWstyled_small.png]
The styled IDW raster surface layer.
[image: images/svg/create-black-24dp.png] Try a different form of interpolation
If you were able to run the GRASS toolbox IDW tool, try another form of interpolation too.
Open the processing toolbox and look for the v.surf.rst tool. This use the spline method of interpolation. Fill in the tool and run it then style the output.
Compare the output of the IDW and rst methods of interpolation.
Which method of interpolation do you think is best for this data and why?
Deriving contours from a surface
Once you have created a raster surface you can use another tool in QGIS to derive vector contours. This can be another useful way of displaying some forms of data on a 2D map, again, it’s up to you whether it makes sense to display your data in this way.
[image: images/svg/videocam-black-24dp.png] Creating contours from a raster surface in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Contours, or isolines, are lines that join points of equal value on your map.
· Go back to the Processing toolbox and this time search for contour
· Look for the GDAL subheading and double-click on the tool called Contour.
· Check that the Input layer is your IDW raster surface layer.
· The most appropriate Interval between contour lines varies depending on the data, in this case try setting it to 50 initially. It’s easy to run the tool again and try other values later.
· The Attribute name should be a field name which tells you what data it contains. The default is ELEV for elevation, but in this case the values will be lead concentrations in ppm, so I’ve called mine ppm.
· The other values can be left as default, but you should enter a location and name for the output - next to Contours click on the three dots button and go to Save as file, navigate to where you want to save the output and give it a name to save it as a geopackage. I usually try to include the interval of the contours in the name, so I’d use something like Contours50ppm.gpkg in this case.
· Click on Save then Run.
[image: images/analysis/Contours_small.png]
Settings to create contours based on the IDW raster surface.
The contours should be generated and automatically added to your map.
Style the contours as a thin black line and give them labels which use the new field - in my case, the field I set above called ppm.
Do make sure that your lead concentration contours are styled in a different style or colour to the topographic contours!
[image: images/analysis/ContoursStyled_small.png]
Contours generated from the IDW surface at 50 unit intervals. The units in this case are parts per million (ppm).
Make the contours and IDW layers invisible while you work through the next few exercises. They’ll just get in the way otherwise.
Buffering to display distance from mines
One frequent use of GIS analysis is to show proximity - that is how close one geographic feature is to another. Longley (2015), p.34 (Details are on the module reading list) quotes Tobler’s First Law of Geography:
Everything is related to everything else, but near things are more related than distant things.
Being able to measure and display the relative proximity of different datasets is a powerful tool.
It is possible to see some of the sites of former mines on the topographic base map. We’ll set up a feature class and digitise points for these mines, then it will be possible to create buffers around the points which show distances from the main mining activity. Once you’ve done this it should be possible to look at your map and see whether there is a potential link between mines and lead contamination.
If you need to remind yourself how to create a feature class and create features within it, refer back to the chapter on creating data.
· Create a new point feature class in the project database and call it Mines.
· Add the feature class to your map and edit it to add points at the locations of any mines or related sites that you can find within the outlined area on the map [footnoteRef:1045]. There are only a few. Note that the buildings at Cononish itself are also mine-related so mark those too. [1045:  If you’re wondering what the “Old Shielings” are that appear on the map, they were summer grazings for cattle in the Scottish Highlands. Now you can often find ruined stone structures in remote locations which are all that is left of them.] 

· Remember to Save your edits.
· Clear any selections so that they don’t affect the output from the buffer tool.
There is a Multi-ring buffer tool in the processing toolbox, but this doesn’t quite do what we need it to do, though you can search for it and try it out if you wish to.
Instead we’ll install a plugin and use that instead.
· Go to Plugins > Manage and install plugins from the menu bar.
· Search Not installed for Multi Ring Buffer. The information should look something like the image below:
[image: images/analysis/MultiRingBufferPlugin_small.png]
The Multi Ring Buffer plugin in the Plugin manager.
· Click to Install Plugin then Close the Plugin manager.
You should have a new icon on a toolbar at the top of your map. Click on this to open the tool.
[image: images/analysis/MultiRingBufferTool_small.png]
The button to click on to open the Multi Ring Buffer tool.
[image: images/svg/videocam-black-24dp.png] Using the Multi Ring Buffer plugin in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Fill in the dialog as follows:
· The Layer to be buffered is your new Mines point layer.
· Tick to Dissolve feature before buffering - this is the bit missing from the ring buffer tool in the toolbox.
· Set Rings buffer distance to 200. This is in map units, which in this case are metres.
· Set Number of rings to 10.
· In the Advanced section check that both Central and Donut Ring Buffers are ticked.
· Click OK to generate the buffers.
[image: images/analysis/MultiRingBuffers_small.png]
Filling in the Multi Ring Buffer tool.
You should end up with a new layer in the Layers panel and concentric shapes covering your map.
· At the moment this is a temporary layer (note the sort of “square spider” icon next to it in the Layers panel), so make sure that you right-click on it in the Layers panel and Export it to a geopackage layer with a name such as Buffers200 so you know what they are, and the distance setting you used.
· Remove the temporary layer from your Layers panel so that it doesn’t confuse you later.
· Change the style of the buffer layer so that each distance buffer is a different colour (Categorized with the Value set to mrb_dist should do the job). Set the Layer rendering to Multiply so that the map underneath can still be seen.
[image: images/analysis/MultipleRingBuffersMap_small.png]
The multiple ring buffers on your map overlain by the styled lead concentrations point layer. Choose your own colours and styles to display the data as clearly as you can.
You’ll probably find that the Values aren’t styled in the order you’d expect so that the colour gradient doesn’t start from the middle and work out to the edge in order. This is because the mrb_dist field is being treated as text rather than numbers. If you wish, you can correct this as follows:
· Open the Processing toolbox and search for Refactor.
· Open the Refactor fields tool.
· Check the Input layer is your multi ring buffer layer.
You’ll see a list of the fields in the layer under Fields mapping, and that confirms that mrb_dist is set as a text field.
· Click on the dropdown box under Type next to the mrb_dist field and change the type to Integer (64 bit).
· At the bottom of the form, click on the three dots button at the end of the line under Refactored and select where you want to save your output, and what you want to call it. You can save it to the same GeoPackage, maybe with the same layer name, but this time add _ref for refactored at the end.
· Then click Run.
Once the new layer has been added to your map, try applying the Categorized style again. Hopefully this time the classes will be in a better order.
[image: images/svg/create-black-24dp.png] Experiment with multiple ring buffers
Feel free to run the tool again and change the distance and number of rings to settings that you think might be more useful. Experiment! You should interpret your data and display it as you feel is best using your expertise as a scientist.

[image: images/svg/create-black-24dp.png] Look at your map
Make sure that you styled point layer for lead concentrations is visible and have a look at how the concentrations compare to the distance from the mines.
How far have the high levels of lead travelled?
Remember that if you used the distances that I suggested, each ring is 200 m further from the mines than the previous one. You can run the Multiple ring buffers tool again with a different distance if you think that will be more useful.
The final map
You have used the original data to generate a lot of different layers. You can’t just make all of them visible and expect your audience to be able to interpret your map - some of the data probably wouldn’t even be visible. You need to select the layers which help to answer your original question and display them on multiple map views.
The examples below show possible layouts. Your layout should look different. You will have made your own decisions about styles for layers, and elements to include in the layout. You’ll learn more about layouts in the next chapter and will get a chance to apply those techniques to this map.
· Create a layout containing two maps, one showing the lead sample points styled as graduated size (a bubble map) and the other showing the interpolated lead concentration surface. You can do this by setting up one map with the layers you want, clicking on Lock layers in the Item properties. Copy and paste the map frame, then untick Lock layers and set the map up with the layers you want for the second map. You’ll get more information about this in the layout chapter later, so don’t worry too much if you can’t see how to do it.
· Also include a scale bar, copyright acknowledgements, a title and any other elements you think your layout should have.
· If you wish, have a go at adding a key, but don’t worry too much - you’ll work through the instructions for how to do this in the next chapter.
· Export this map as an image or a pdf and upload it to your GIS Portfolio.
[image: images/analysis/FinalMap3_small.png]
Example layout for the Cononish geochemistry map.
You have other layers which can be usefully displayed on a map as well. Experiment to see whether you can display the locations of the mines or the buffers on your map as well as the lead concentrations.
· Return to your layout, select the map and click on the refresh button at the top of the item properties. The layers should update.
· Make any changes to the layout that you want to make, then export this map as an image or pdf and again, upload it to your GIS Portfolio.
If you upload your exported maps to your GIS Portfolio, I will provide brief feedback on your work.
[image: images/svg/create-black-24dp.png] Save your map for next week.
Keep this map project so that you can try out the more advanced layout and presentation techniques on it in the next chapter.
More information: Analysis in GIS
There is more about data analysis in GIS in the module reading list[footnoteRef:1073]. In particular have a look at the following: [1073:  Reading list available from Minerva and from the module catalogue.] 

Heywood, Cornelius and Carver (2011) chapter 6 on page 174 and following.
Longley et al. (2015) Part III is all about analysis, but in particular have a look at chapter 13 on page 290 and following.
For QGIS-specific techniques try the following reference from the reading list:
Menke (2019) Exercise 3 (p. 123-137) includes many of the techniques covered in this chapter, particularly from task 5 (p. 131) onwards.
As usual, if you want more information about a particular process try searching online, and particularly on YouTube. For example:
Hans van der Kwast, Spatial interpolation in QGIS - video covering interpolation.
Layout and presentation
Last Modified: 08 Jan 24, 17:13:47
The background to layout and presentation will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Layout your maps in such a way that they effectively communicate the content and purpose of your work to a user
· Select relevant map elements to include in a layout and set their properties to match the requirements of your map
· print or export your map layout to show your work to it’s best advantage
Introduction to layout and presentation
Once you’ve put in all the hard work to produce a map of your field area or project, it is worth making the extra effort to ensure that you lay it out clearly and print or export it in a professional fashion. Make sure that you allow the time to do this. Care and patience can make the difference between a scruffy, unimpressive map that loses you marks, and a clear, professional map that gives a good first impression and causes your audience to take your work seriously.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Don’t underestimate the time that the final details can take and don’t leave this part of the preparation until the last hour before a deadline!
You won’t need to use all the elements and features outlined here for every map. Equally this is not an exhaustive list of possible elements. You should already have some idea of what elements are useful, and should be able to make a decision for each case based on your existing knowledge of maps. If you think that you need to add something that is not listed here, e.g. a report based on a table, then use the extra information available at the end of the chapter and search on-line to find out how to add it.
This chapter isn’t necessarily for working through in order. Make sure that you are aware of the contents and of what QGIS is able to do, and then make your own decisions about what you need to include based on the principles that will be covered in class.
Note that the examples in the images use a general map which isn’t the same as the one you will be working on. The techniques and the buttons in QGIS are still the same, though.
The data for this chapter
You should use a map that you have been creating in previous chapters as instructed below [footnoteRef:1084]. Try out all the techniques listed below and then decide which you need to include on this layout before you export it. [1084:  If you no longer have a copy of the map that you have been instructed to use it doesn’t really matter. Either use a different map that you have created, or download the map from the week 1 class and use that instead. It isn’t the map itself that is important for these exercises, but having a layout with data on it so that you can try things out.] 

· Level 1 geologists use the Cononish map from the previous chapter.
· Level 2 and above geologists. You should be working on your own maps.
· Level 2 environment students use the Lake District map.
· Level 1 geophysicists continue working with the Llanbedr map.
Creating and saving layouts
In QGIS a print layout allows you to control the format and scale at which you print and export your map, and to lay out additional elements to complete the final product.
Creating a print layout
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating a print layout in QGIS and adding a map view.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To create a new print layout
· Open your map project in QGIS if it isn’t already open
· Add a print layout by going to Project > New Print Layout...
· You’ll be asked to Enter a unique print layout title - call it something that will tell you what this layout is intended for. For example, enter A3 for printing. You can leave this blank if you wish.
· Click OK
QGIS will open your new blank layout in a new window. It should look something like the image below - though your toolbars may be in different places.
[image: ../../shared/docs/images/layout/NewPrintLayout_anno.png]
Your new print layout showing a blank page.
In this view you will see your map laid out as it will be when it is finally printed or exported. You’ll see the page outlined on screen and, once you have started adding elements you will see the content as it will look on the page.
Opening existing print layouts
Once you have created a print layout you can close it and open it again without losing it.
· Close the window containing the print layout (Layout > Close)
· To reopen it go to Project > Layouts and select your layout from the list - there is only one there at the moment so click on that.
Saving layouts
A layout is saved as part of the project so whenever you click on Save in your project it will save the layout too.
For now:
· Click on the Save button in the layout window.
· Or Layout > Save Project
Adding a map to a layout
At the moment all you have is a blank page. To add a map to a layout:
· Click on the Add Map button on the Toolbox
· Or Add Item > Add Map
· Then use the mouse cursor to drag a box across the page. It doesn’t matter about the size at the moment you can change it later.
You should now be able to see a section of the map from your main project window. The Item Properties on the right will now give options for the map. You’ll explore these in more detail later.
Size and scale of pages and maps
The size of the page and of the map “window” will affect the scale and extent of the map. These are all linked so if you change one remember to check that your map is either still at the correct scale, or still covers the correct area.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Setting the size and scale of a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Page size and orientation
The page that you see in the layout window shows how the page will look when you export or print your map. Remember to check the paper size and set it correctly before you spend time arranging your layout.
To change the paper size and orientation:
· Right-click somewhere on the “page” and go to Page Properties
The page properties should open in the Item Properties on the right.
· The Size setting allows you to choose from a wide range of standard sizes, e.g. A4, A3 etc.
· The Orientation setting allows you to choose between portrait and landscape orientation.
· You can also set the page measurements manually by changing the Width and Height in the boxes below.
· The page in the main view should change automatically when you change a setting.
[image: ../../shared/docs/images/layout/PaperProperties_small.png]
The page properties set to an A3 Portrait page.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Changing paper size and orientation
Change your page size and orientation to A3 Landscape. This will give you more space to experiment with adding other elements to your page.
Once you have changed the paper size you may find that you can no longer see the whole page in the layout view. To zoom in or out use the buttons on the toolbar at the top. In particular use the Zoom full button.
Setting up a multi-page layout
It is possible to create layouts with multiple pages in QGIS.
· On the menu bar go to Layout > Add pages...
· In the box which opens select the number of pages to create and whereabouts you want them to be added.
· Set the size and orientation of your new page(s)
· Then click on OK to add them to your layout.
[image: ../../shared/docs/images/layout/InsertPages_small.png]
Inserting two new pages at the end of the layout.
If you decide you don’t need any of the pages you can delete them:
· Right-click on the page you wish to delete and select Remove page.
Resizing the map in a layout
When you first set up a layout the size of the map may not be the size that you want it to be eventually. Changing the size of the frame is easy, but can take a little experimentation. You will also need to look at this in conjunction with the instructions on changing paper size in the previous section.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Resizing the map frame in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure that the map frame is selected in the layout by clicking on it.
· When the map frame is selected you should be able to see that there are small boxes at the corners and on each side.
[image: ../../shared/docs/images/layout/ResizeMapFrame_small.png]
Using the handles on each corner and side of a map to resize a map frame in a layout.
· Use the boxes as “handles” to resize the map frame by dragging them
· Keep an eye on the scale in the map Item Properties. If you need to make a map at a particular scale you may need to keep putting this back to the correct scale each time you resize the map.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
This process can take patience to get the map frame the correct size for the scale and area. There don’t appear to be any short cuts so just stick with it and keep repeating the process!
Moving the map within a map frame
If you need to move the map itself within the frame, e.g. so that you see a different part of it:
· Click on the Move Item Content button on the Toolbox
· You’ll be able to use the mouse cursor to move the map around within the frame.
· You’ll also be able to zoom in and out on the map.
· Remember to click back onto the Select/Move Item button to be able to select items again. It’s frustrating when you forget and find that you can’t move any elements around!
Controlling the map with the Item Properties
If the map is selected on the layout you will see its properties in the Item Properties panel on the right. You can use these to control various settings for the map. The ones you need to know now are:
· The most obvious is Scale. Use this box to type the scale that you want your map to print at.
· Extents is useful if you don’t need to worry about the scale but do need to show a map covering a particular area. You can type the east, south, west and north coordinates and the map frame will change accordingly.
· The Frame setting allows you to put an outline around the outside of your map. This can make the map look more professional.
Adding items to a layout
The information below includes details on adding many different items to a layout. Not all these will be appropriate to every layout, but it is up to you to decide which items to use depending on the purpose and audience of your map and any guidelines specified for assessments or reports. Some of the references on the reading list, particularly Darkes and Spence (2017), should help you with this.
Remember that the QGIS Documentation will provide you with plenty of extra information on how to add items to a layout.
Most items are added to a layout in a similar way to each other using the buttons on the Toolbox. In most cases you’ll then be able to use the Item Properties to make changes to the item.
Selecting items on a layout
There are a couple of ways of selecting items on a layout.
· Click the Select/Move Item button on the Toolbox then click on the item you wish to select
· Alternatively, use the Items panel. As you add more items to your map they will be added to this panel. All you need to do then is click on them in this list to select them on the map.
You can also use the items panel to lock items in place and make them invisible.
[image: ../../shared/docs/images/layout/ItemsPanel_small.png]
The Items panel showing that Map 1 is select and locked, while the attribute table frame is invisible.
Once an item is selected it will have the little “handles” visible for resizing.
A legend or key
You will have added various data to your map, and it is necessary for you to explain to anyone looking at your map what those layers and symbols show. To do this you’ll need to add a legend or key. Note that this can be a relatively complex procedure and there are a lot of instructions in this section. It’s worth having a quick look at the whole section to get an overview before you start trying to add a legend.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a key or legend to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Start by using the default options to create a legend. Once you have the basic legend it is possible to make alterations later.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Save your map and take a backup copy of your project folder before you start doing this.
While it is usually fine, if you have a lot of big layers on your map QGIS can crash when you first add a key and you don’t want to lose the work you’ve already done.
There are ways to get around this problem with the legend crashing QGIS.
To add a legend / key:
· Click on the Add Legend button on the Toolbox
· Click on your layout in roughly the location that you want your legend to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a legend which includes all the items from all the layers on your map. This is likely to be rather a lot! The first thing to do is to remove any that you don’t need.
As usual, while the legend is selected, the Item Properties will show the specific properties for this element.
· In the Item Properties start by checking that the legend is referring to the correct map on your layout - use the dropdown box next to Map to select the correct one if you have more than one.
· You can give your legend / key a title if you wish, but note that this isn’t always necessary.
· Then move down to the Legend Items heading
· If you don’t want all your layers to appear then untick Auto update - you can always click on the Update All button later if you change symbols etc on your map.
· Now you can select layers and then click on the red minus button under the list to remove them.
· To only show elements which appear on your map tick next to Only show items inside linked map - this can be a great help to remove surplus symbols.
[image: ../../shared/docs/images/layout/LegendPropertiesLayers_small.png]
Setting the legend properties to control the layers and symbols on the key.
Once you have just the layers that you want on your key you can then use the rest of the properties to set fonts, backgrounds etc.
· It is possible to drag and drop the layers in the Items list and rearrange them.
· The Columns section allows you to split your legend into two or more columns.
· The Symbol section will let you change the size of symbol, or patch, on the legend - sometimes it is useful to be able to enlarge the “patch”.
· To change layer names in the legend without changing them on your map you can select the item in the list and click on the pencil icon below.
· Alternatively, you can change the names in the Layers panel in map view then click on the Refresh button in layout view to refresh the map and all associated items.
Changing the order of items within a categorized layer
If you have a layer styled by categories, the initial legend entries will usually be in alphabetical order starting from the top.
If you are creating a legend for a layer for which the order is important, for example, a geology bedrock layer where the younger rocks should be at the top and the older at the bottom, you will probably need to rearrange the legend entries.
There are two ways of doing this.
In the Layer Styling panel:
· Open the Layer styling panel and check the correct layer is selected.
· In the categories list drag and drop each entry to change the order.
This also changes the order in which categories are drawn on the map, so you may also need to check that your map still appears correct.
In the Layout legend options
· Select the legend and untick Auto update under Legend Items, if it isn’t already unticked.
· Select one of the categories you want to move and use the blue up and down arrows below the list to move it up or down.
This method only changes the order in the legend and doesn’t affect the order in which your categories are drawn on the map.
Changing the size of the legend patch
Sometimes the patches are too small to see clearly. This can be a particular problem for continuous colour ramps, but vector patches can be resized the same way.
To change the size of a legend patch:
· With Auto-update off…
· In the legend properties double-click on the layer to change or click on Edit selected item properties below the list of items.
· In this dialog you can also change the text next to the legend item.
· Use the Width and Height settings to make the patch larger - it should update automatically as you type numbers.
[image: ../../shared/docs/images/layout/LegendPatchSize_small.png]
Changing the size of a legend patch in the item properties.
Creating a legend for a continuous raster
Version 3.20 and above of QGIS will automatically create a continuous patch. So if you are using version 3.20 or above you don’t need to worry about the rest of this section.
[image: ../../shared/docs/images/layout/ContinuousAuto_small.png]
A legend for a continuous raster which was produced automatically by version 3.20 of QGIS.
Unfortunately, the tools in version 3.16 and below of QGIS don’t make it easy to create a patch for a continuous raster. The quantities will appear as separate boxes. There are ways around this.
[image: ../../shared/docs/images/layout/ContinuousNo_small.png]
A legend for a continuous raster which isn’t showing a continuous scale.
If you look at the article by EcoDiv entitled Legend for continuous raster in QGIS composer you’ll find a way to generate a continuous legend patch [footnoteRef:1145]. [1145:  Page last visited: 30th March 2022.] 

[image: ../../shared/docs/images/layout/ContinuousYes_small.png]
A continuous legend scale produced using the method at the web page above.
Manually editing the legend
There is a limit to what you can do with the automatic functions and properties but do as much as you can as that will save some time. It’s particularly important to play around with the spacing settings as there isn’t a way to change that manually.
Once you have finalised as much as possible on your legend using the item properties, the instructions below show how to manually add and edit elements manually.
Alternatively, it is possible to export the map as pdf or svg format then edit the legend in a vector graphics editing program such as Inkscape, CorelDraw or Adobe Illustrator.
[image: images/svg/videocam-black-24dp.png] Manually editing a legend in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Adding or editing items not created automatically
As an example, this could be a way to add a patch for a combined colour on the layout which isn’t actually part of a layer so doesn’t appear in the legend.
To do this, you add the shape you want using the menu items listed below, “draw” it on the layout, then style it using the item properties.
· To add a rectangle or circle go to Add Item > Add shape > Add Rectangle or Add Ellipse.
· To add a marker symbol, e.g. for a point, go to Add Item > Add marker, then choose a marker from the properties as you would for marker symbols in Layer styling.
· To add a line go to Add Item > Add Note Item > Add polyline. Click each node to draw the line, then left-click to finish.
Matching a colour on the map using the color picker
Legend items need to accurately reflect the colour of the equivalent feature on the map, so it’s important to be able to set this. QGIS provides a colour picker feature which is ideal.
· Make sure that the item you want to colour is selected on the layout.
· In Item properties click on the button next to Style. The Symbol Settings dialog should appear. This works in the same way as the Symbol Settings when you’re styling map features.
· click on the colour you need to change.
· Choose the Color picker tab (as usual, hover over the buttons to see the tips).
[image: ../../shared/docs/images/layout/ColorPickerTab_small.png]
The color picker tab.
· Click on the Sample color button to get the color picker cursor, then hover the cursor over the correct colour on the map.
· To select the colour, press the spacebar on your keyboard.
The colour should be applied automatically to your element.
Covering unwanted text or elements
This is an example of lateral thinking, but the easiest way to get rid of unwanted text or elements that can’t be removed using the legend properties, is the following:
· Go to Add Item > Add Shape > Add Rectangle and draw a rectangle over the text or elements you want to remove.
· Set the fill of the rectangle to the same colour as the background (using the color picker as above if necessary).
· Set the stroke style to No pen.
You can then add any new elements on top of the “invisible” rectangle.
Adding new or extra text
Adding new or extra text is really just a case of adding a label in the usual way.
· Add Item > Add Label
· Change the font, font size, colour, etc, to match any other text on the legend.
Preventing the legend from crashing QGIS
If you have a problem with QGIS crashing when you add a legend, try the following. It is probably crashing because you have a lot of layers on your map and, because Auto update is selected, it is struggling to add all the details.
· Open a new, empty project in QGIS
· Create a new blank layout as you did above.
· Add a legend to the layout. It won’t have any content, but that’s fine.
· Untick the box in the legend properties that says auto-update
· It’s a good idea to add a title and a frame to the legend so that you can find it again!
· Save the layout as a template (Save as template button on the toolbar)
· Close the blank project and reopen your real project
· Create a new layout use the template that you saved by doing the following:
· Project > Layout Manager
· Under New from Template select Specific from the dropdown
· then click on the three dots button next to the blank field
· Select the template that you just created and Open
· Click on the Create... button and you’ll be asked for a name for your layout
Once you have the layout open add a map frame. You’ll then need to associate the map frame with the legend by selecting the legend and setting the Map to the correct map.
Now use the + (plus) button below the Legend Items to add the layers that you do want to be included. Ticking Only show items inside linked map will also help.
This is a fiddle and not ideal, but if it stops your QGIS project from crashing hopefully it is worth it!
Scale bar and scale text
Some indication of scale should always be added to both printed and screen maps. A scale bar is a useful convention for both. Scale text (e.g. 1:50,000 or 1 cm = 1 km) is only relevant for printed maps, not for maps on screen where someone can zoom to any scale. If you add scale text you must also ensure that you print or export the map at the correct scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a scale bar and scale text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add a scale bar
· Double-check first that you have the correct map selected on your layout. Particularly important if you are including multiple maps at different scales.
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale bar (you can always move it later)
· Select OK on the New Item Properties box that pops up
The scale bar should appear on your layout. You can now go to the Item Properties to change various parameters.
· The Map dropdown is where you check that the scale bar is set for the correct map
· Use the Style dropdown to select how you want the scale bar to appear - try a few of these and see what effect they have
· The Scalebar units should be set to something appropriate for your map
· You can use the settings under Segments to change the length and intervals of your scale bar. Try these out and see what happens.
[image: ../../shared/docs/images/layout/ScaleBarProperties_small.png]
The most important settings for the scale bar.
There are a lot more settings so just explore these and see what they do. In particular you may want to change the Font under the Display settings. You can always remove the scale bar and start again!
To add scale text
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale text (you can always move it later)
· Select OK on the New Item Properties box that pops up
A scale bar should appear on your layout. You can now go to the Item Properties to change this to numbers.
· The Map dropdown is where you check that the scale text is set for the correct map
· Use the Style dropdown to select Numeric
The text should appear and automatically match the scale of your map. There are far fewer options for this - mainly just the Font settings.
Text or labels
Text is an essential part of any map layout. Maps need an informative title to show the audience what the map is about. You should include your name (or for an assessment your student ID) as creator of the map. Copyright statements are essential if you have used data from other sources and you may also want to include acknowledgements and further explanations of your maps and data.
There are two main ways to add text, static text and dynamic text. The instructions for static text are shown below. Dynamic is more complex and won’t be covered here. If you are interested in using it you can look at the tutorial on Creating a Dynamic Print Layout in the QGIS Training Manual.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Static text
Static text is text that you type into the box on the Item Properties. This stays the same once you have added it. Most of the text that you add to your layout will be of this type. For example, a title or subtitles to individual maps, your name or ID as the creator of the map, copyright text etc.
To add static text:
· Click on the Add Label button on the Toolbox
· Click on your layout in roughly the location that you want your text to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
· A new label item should appear on your layout. By default the text will be “Lorem Ipsum” (placeholder text).
· Type your text in the box on the Item Properties panel
· The options on the panel will also allow you to change the font, font size and colour, the alignment, and add a frame.
[image: ../../shared/docs/images/layout/TextProperties_small.png]
Item Properties for text. Note the large box to type your text and the options in the Appearance section below.
Copyright acknowledgements
Copyright is important. Remember that most data providers ask you to sign up to conditions that include an obligation to add a copyright acknowledgement to your map. Check what that copyright statement is and make sure that you add it.
For example, when you signed up to use the Digimap collections you agreed to add copyright acknowledgements whenever you created a map with the data. These acknowledgements do change from time to time so it’s worth knowing how to check what they are for yourself.
· To find the Digimap copyright acknowledgements go to the Digimap Help (Help at the top of the main Digimap page)
· Look for a link to Copyright and Licensing and click on it.
· Individual licences are in a list on the left, click on the one for the data you are using. There is more general information in the main body of the page.
· Then look for the information under In return, you must: - that gives you the acknowledgement text.
For example, from April 2019, when you use Ordnance Survey data obtained from Digimap you are expected to add the following text to your map.
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
Remember that you do have to acknowledge each different dataset that you use and will have signed up to that when your registered.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Adding the copyright symbol to your text
• To add the © symbol (on Windows), you can copy the symbol from this document and paste it into the box in the text properties panel.
• Alternatively, put the number lock on the keypad, hold down the Alt key, type 0 1 6 9 then let go of the Alt key.
• If you are on a Windows laptop and don’t have a number pad, put the text [%char(169)%] in the text box.
• If you are on Mac, either copy and paste, or use the shortcut Option + G.
If you are not using U.K. Ordnance Survey data this is not the correct copyright acknowledgement to use. For example, if you are using data for Spain or the United States, or indeed UK data that you haven’t downloaded from Digimap. You’ll need to find the correct copyright acknowledgement for yourself. You can often find this sort of information on files that come with the data or on the webpage you downloaded it from.
Digimap also give advice on citing Digimap data as opposed to the copyright acknowledgement.
GIS Lounge have an article about How to Cite GIS Materials which includes the software as well as the data and the maps.
A measured grid
Measured grids add labelled grid lines to a map. If you are using Ordnance Survey or other UK data projected in British National Grid then you can easily add National Grid lines and numbers to your map. The O.S. Raster tiff files already have grid lines marked, but adding a measured grid allows you to include coordinates around the edge of your map - making it possible to read grid references.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a measured grid to a map in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the map to which you want to add grid lines.
· In the Item Properties scroll down until you reach the Grids heading and click on the little arrow next to it.
· Click on the + (plus) button below the Grids heading to add a Grid to the list below.
· Select the Grid in the list and click on Modify Grid...
The Item Properties will change to show the properties for the grid.
· Under Interval set the X and Y boxes to the interval that you want between the lines. This depends on the scale of your map and you can experiment to see what looks best and would be most useful. For now try 1000 - this is in map units which for British National Grid will be metres.
· The lines are often too bold, so click on the Line style dropdown and select a paler shade of grey. You could also make the lines thinner.
[image: ../../shared/docs/images/layout/MapGridProperties1_small.png]
The top of the Map Grid Properties showing the interval and the paler line style.
· Scroll down and tick next to Draw Coordinates - this adds the numbers.
· I usually change the Left and Right coordinates from Horizontal to Vertical so that they follow the edge of the frame.
· Alter the Font as you wish - don’t make the coordinates large. They need to be visible, but not intrusive.
· Change the Coordinate precision to 0
[image: ../../shared/docs/images/layout/MapGridProperties2_small.png]
The Draw Coordinates part of the Map Grid properties showing the Vertical setting for Left and Right and Coordinate Precision set to 0.
Note that the grid that QGIS adds is fully numeric, you may be more used to seeing grid letters for 100 km grid squares, e.g. the University grid reference is similar to SE 2934 3444, the University grid coordinates are similar to 42934 43444. It is the latter that will appear on a measured grid generated by QGIS.
[image: ../../shared/docs/images/layout/MapGrid_small.png]
A map with a measured grid that shows British National Grid coordinates on a 1000 m grid.
North arrows
Before adding a north arrow to your layout stop and think about how you need to indicate north on your map. If you look at the technical information on an Ordnance Survey Landranger (1:50 000) map you’ll see a diagram showing Grid north, True north and Magnetic North. The information given there shows how to plot the difference of magnetic north from grid north. Adding this to your own maps can be useful, particularly if you, or anyone else, are going to be using the map in the field.
If you are taking strike and dip measurements in the field you should have corrected your compass-clino for declination (the horizontal angular difference between true north and magnetic north) anyway. When you plot the measurements on your map it isn’t worth worrying too much about whether you are plotting against grid or true north as the difference on any grid, not just the British National Grid, is unlikely to be that big. See the image below for the different types of north and the declination.
[image: ../../shared/docs/images/layout/LONorthVersions.png]
The different types of North that you will find on a map set to a projected coordinate system, such as British National Grid.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Labelling north arrows
If you add any north arrows to your layout do remember to label them in some way which shows which version of north each one is showing.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding north arrows to a layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
North arrow: Grid north / Map north
If a map is in a projected coordinate system QGIS will automatically lay it out aligned with the grid. So for example, any map set to British National Grid will be aligned to grid north.
In this case it isn’t strictly necessary to add a north arrow to show grid north if you also include a measured grid on your map, but it doesn’t hurt.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation the North alignment should be set to Grid North by default - if it isn’t set that now.
[image: ../../shared/docs/images/layout/NorthArrowGrid_small.png]
The Item Properties for a north arrow showing Grid North.
If you check this against your measured grid lines you should find that it matches exactly.
North arrow: True north
True north is the direction from the area of your map to the North Pole. In the east/west centre of a grid, such as that set for the British National Grid, it may well be the same as grid north, e.g. in Leeds the difference is extremely slight. As you go further east or west towards the edges of an area covered by a grid the difference becomes more noticeable, e.g. at Lands End in Cornwall, or in Norfolk.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north
You should see the rotation in the box above change to a slightly different number.
If you check this north arrow against your measured grid lines you may well find that the north arrow is slightly tilted.
North arrow: Magnetic north calculated by declination
Magnetic north is the direction from the area of your map to the magnetic north pole. This is the number that is given on the corner of Ordnance Survey maps and the one geologists need for setting their compass-clinos in the field, so it is worth making a note of this on your map too.
Finding the magnetic declination
First you need to find the magnetic declination.
· Go to the World Magnetic Model 2020 Calculator on the BGS Geomagnetism Group web pages
· Use the map to navigate to your location and click to drop a point.
· A small results box will appear. The number you want is the Magnetic declination, which is in in the D column and MF row. There is a key to the results below the map and you are looking for degrees east.
· Make a note of the declination, including any minus sign.
To set magnetic north on a layout
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north as declination is the angle from True north to Magnetic north.
· In the Offset field enter the angle that you obtained from the BGS website.
[image: ../../shared/docs/images/layout/MagNorthImageRotation_small.png]
Setting the image rotation for a magnetic north arrow. The declination from the website is -0.35 degrees.
Don’t forget to add text to your map showing the date of the reading. It changes with time.
For more about how the magnetic north pole is moving see the BGS blog.
Multiple maps on one page
It can be very useful to be able to place more than one map or map view on a single page, either so that you can show a different area, or a different zoom level for the same area. You can also use this to set up an automatic extent indicator which marks your study area on a map of a country.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding multiple maps to one layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Different areas of the same map
You can add multiple maps to your layout using the Add Map command in the same way you added a single map earlier.
If you add them directly both maps will show the same data and styling. You can then change the scale and extent on each one individually using the Item Properties and the Move Item Content button.
Maps showing different content
If you want to add further maps to your layout but have them showing different content you can do that too.
· Select the initial map frame on the layout
· Make sure that it shows the content that you want it to show and it is all styled correctly
· In the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
Now go back in to the map view and set up the map and layers so that they are as you want them for the second map.
· Back in layout view add a new map frame as before. This should reflect the map that you have open in the map view now.
· Once you are happy with this view in the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
As both of your maps are locked you will have to remember to unlock them if you need to make any changes to the styles or combinations of layers.
[image: ../../shared/docs/images/layout/MultipleMaps_small.png]
Two views from the same map with layers locked.
Extent indicator or locator map
For some maps, particularly large scale (detailed) maps of very small areas, it is useful to show a small scale map of the general area with the area of the main map marked, as in the figure below.
[image: ../../shared/docs/images/layout/ExtentIndicator_small.png]
A map of a small area with an extent indicator or locator map to give context.
To do this you need to obtain small scale data and add it to your map. You really only need a general map, even just an outline of a whole country.
Natural Earth data
It is possible to do this using data from Natural Earth. Download the Countries data from Medium scale data, 1:50m > Cultural > Admin 0 - Countries - click on the Download countries button to download a zip file containing a shapefile.
Quick World map
There is also a little trick hidden in QGIS which makes adding a World map with country outlines really easy.
· In your QGIS project click in the Coordinate box at the bottom of your map then delete the existing contents.
· Type world (all lower-case) and press enter.
A map of the world with country outlines should appear on your map and in your Layers panel. When you zoom to layer the result might be a bit odd if you have a projection such as British National Grid set for your map, but try it out and see whether the area you need looks right.
You can style the map as usual, e.g. if you just want outlines.
[image: images/svg/warning-black-24dp.png] Warning
Using a screenshot from Google Earth or Google Maps (or similar) with a marker on it doesn’t look professional and should be avoided. Not least it is surprisingly easy to end up with the marker in the wrong place.
Adding the extent indicator to your layout
Note that the extent indicator does not need to be large, but should be a small map which doesn’t take up too much space on the layout.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding an extent indicator to a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your main map and lock the layers on the layout.
· Add the Countries outline to your map and turn off the other layers
· Symbolise the countries as a thin black outline and zoom in to the country containing your study area
· Add a new map to your layout and resize it as appropriate so that it shows the country as a small map.
· Make sure that the small map is selected then go to the Item Properties panel
· Scroll down to the Overviews section and click on the little arrow next to it to open it out
· Click on the + (plus) button then select the new Overview title that appears
· Check that Draw "Overview 1" overview (or whatever your new Overview is called) is ticked.
The properties to change how the overview looks are below.
· Under Map frame select your main map - the one of the smaller area.
[image: ../../shared/docs/images/layout/OverviewsProperties_small.png]
The Overview properties in the Item Properties for the small map.
· Set the Frame style as you wish. If you can’t see the frame on the indicator map because it is too small
· I found that setting the Simple fill Stroke style to Solid Line in the Symbol Settings
· then giving it a thicker Stroke width and setting the Join style to Round gave the effect of a dot on the map.
[image: ../../shared/docs/images/layout/OverviewDot_small.png]
Using the Symbol Settings to make the overview frame look like a dot.
You should now have a map with a marker showing the location covered by your main map. If you move the main map the “frame” on the smaller map will automatically update to reflect the new location.
Inserting photographs and images
You may want to include photographs and diagrams on your map layouts. Geological cross-sections will come under this category too.
[image: images/svg/videocam-black-24dp.png] Inserting photographs and images in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add a raster image
This includes photographs or any image in a format such as jpg, png, tiff, gif.
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a Raster Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
To add an SVG image
SVG stands for Scaleable Vector Graphics. It is the native editing format for the vector graphics program Inkscape. If you have used Inkscape to draw your diagrams you can import them as follows:
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a SVG Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Unfortunately, svg images with gradient fills don’t seem to work well in QGIS. In many cases it will be better to export your diagram from Inkscape as a png file then import that to QGIS as a raster image.
Alternatively, you can export the layout from QGIS when you have finished adding all the map elements and then open it in Inkscape and add your diagrams there. This is usually a better option and instructions will be given for exporting from QGIS later in this chapter.
Checking your map
Checking your map is a very important stage but one that can easily be forgotten if you are in a hurry.
In addition to the points below have a look at Darkes (2017) which gives a lot of quick tips on map layout and presentation. On pages 92 and 93 Darkes includes a section with quick wins for improving your map before publication if you have 5, 15 or 50 minutes.
Suggestions for things to check
· Check that you have included everything you need to include. If this is an assignment reread the instructions and check that you haven’t forgotten to do anything.
· Check that you have left space for margins on the page. This is particularly important if you are printing your map - you don’t want to lose any of the content - but leaving some white space around the outside of your layout looks better even if you’re not printing.
· Check spelling. It’s easy to miss something obvious so if possible, print your map out, or put it on screen and stand back a bit then have a look at it. In particular check geological and geographical names and any technical terms.
· Check that your map doesn’t include anything that you don’t want to include! Did you add some experimental polygons when you were editing, then forgot to delete them? Have you added text boxes and then not removed any that you don’t need?
· Look at the article on Using a mapmaking checklist for map design on the ESRI blog. Read about what makes a map great, then click on the link to the checklist and use the questions there to evaluate your own map. Have you included everything you need to include, or do you have a good reason if something is not on your map? Have you taken care with your presentation?
Checking the colours of your map and layout
In the lectures on styles and labelling, and on presentation, we will have discussed the use of colour on maps. It’s a good idea to check your colours before exporting or printing your map, though you should have been thinking about them as you created and laid out the map too.
In Layout view there is a setting which allows you to simulate different forms of colour blindness.
The idea is to check that all the information on your map is accessible to all your potential audience.
[image: ../../shared/docs/images/layout/PreviewNormal_small.png]
The original, normal view of the map - no preview applied.
· In Layout view go to View > Preview then choose one of the forms of colour deficiency.
The whole layout should change to give you a preview.
[image: ../../shared/docs/images/layout/PreviewProtanopia_small.png]
A preview of the same map as it could be seen by someone with protanopia - no red.
· Check all the colours on your map are distinct. Do any look too similar? Have a look at the key as well to check the colours.
· Do all the layout elements show up clearly? If you’ve put anything on a background, is it still easy to see?
· Try different settings and check the colours carefully for each one.
· Looking at a layout in the greyscale preview setting can give you a good idea of the amount of contrast you have between your colours.
[image: ../../shared/docs/images/layout/PreviewGreyscale_small.png]
A greyscale preview of your map. Note how you can see the amount of contrast between your colours. Try to aim for good contrast to make your map clear to all your audience.
Printing a copy to pdf to check
Almost inevitably you’ll notice something not quite right with your map after you have printed it. To minimize the chances of this happening if you are printing an expensive A0 copy it is a good idea to print your map at A3 and have a close look at it. This isn’t such an issue if your map is only A3 or A4 when full size.
If you don’t have access to a printer then you’ll need to export as pdf and then zoom in and out on your screen.
· Export your layout as a pdf file following the instructions below.
· Open your pdf map file in your usual pdf reader (instructions below are for Adobe Acrobat but you should be able to find similar commands in other programs)
· File > Print
· Choose your printer and use the printer properties to set the paper size to A3 then choose to print in colour.
· In the Page Handling section set Page Scaling to Fit to Printable Area. In Acrobat this should show you a small preview of how your file will print.
· When you are happy with the settings send your file to the printer.
Printing and exporting map layouts
When you have finished creating your map layout in QGIS, you will often need to export it to pdf for printing. The following instructions should help to ensure that your map is the correct size and scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Printing a map layout from QGIS
The best quality output is probably obtained by printing directly from QGIS, though this isn’t always possible. If it is, print as follows:
· Start by checking that the page size and the map scale are correct.
· Go to Layout > Page Setup and check that the paper size matches the size you set in the layout properties.
· Then Layout > Print to actually print your map.
You’ll need to set up the printer as you usually would. This is system and printer specific so I can’t include fuller instructions here.
Exporting a map layout from QGIS
Exporting to pdf
These instructions show you how to export the map to pdf - the format that is usually required if you are having the map professionally printed.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as PDF... or click the button on the toolbar.
· Select where you want to save your output and give it a name
· Then click on Save
· The PDF Export Options should open. The defaults are fine, so stick with those
· Click Save to export the pdf.
You should get a message saying that your layout was successfully exported.
At this stage open the pdf and make sure it looks as you expect it to.
Important note on printing a map layout from pdf
If you are printing your final copy from pdf double-check in the pdf reader you use that the Page Scaling or Zoom is set to Actual size... or None. The actual terminology depends on which pdf application you are using.
This is important to ensure that your map is printed at the scale at which you intend it to be printed. This is particularly important if you are printing maps to be used as field slips. Major problems with measurements can be caused if your map is reduced by even a tiny amount.
Importing a pdf map layout in to Inkscape
[image: ../../shared/docs/images/svg/info-black-24dp.png] Export pdf and import to Inkscape
It is possible to export a map layout to svg which would work in Inkscape, but at the moment the export is rather unreliable. If you want to open your map layout in Inkscape to finish it off it is better to export pdf and import that to Inkscape.
I have experimented a bit with using the output from QGIS in Inkscape for a large map, and have found that, unless you are going to actually want to edit some aspects of the actual map, Inkscape is more stable if you import the map as an image, e.g. png format, and then add other elements around it. The next section below shows how to export your map as a png image.
If you need to make changes to a single element of your map, e.g. the legend, try creating the legend on a separate, smaller layout, export that as pdf and then add that to the main layout in Inkscape.
If you are importing the pdf in to Inkscape and if your map is going to be part of a bigger presentation where scale is important, such as the Geology degree final dissertation map, be very careful to import it without changing scale, size or proportions. The Interactive Inkscape exercises[footnoteRef:1272] have a section on how to import a map layout. [1272:  If you are not a Geology student but would like to learn how to use Inkscape for drawing and for finishing maps please contact Clare Gordon or go to Clare’s downloads to obtain a copy of the exercises as interactive worksheets.] 

Exporting a map to import to Word and PowerPoint
You can also export the layout to include in programs such as Word or PowerPoint if you are intending it to accompany a report.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as image or click the button on the toolbar.
· The Image Export Options will open. This gives you another chance to check the resolution.
· It’s usually worth ticking Enable antialiasing - but if your map looks very blurred it will be worth trying again with this unticked.
· If you are likely to want to open your output in GIS again click to Generate world file
· Click Save and wait for your file to be exported. You’ll get a message when it finishes.
Be aware that it is a good idea to create your layout at the correct size in QGIS before you export it. You can resize jpg or png files in Word and PowerPoint but you’ll lose some of the quality.
Setting up to print multiple map pages
Sometimes, once you have a map set up, you need to print it across multiple pages. The most likely example of this is for Geology students, where you set up your field slip ready for mapping, but it will need more than one page to print it at 1:10,000. Other students probably won’t need to do this, but the instructions are here anyway.
[image: images/svg/warning-black-24dp.png] Warning
Unless you need to set up a map as a series of field slips, or atlas pages, don’t follow these instructions now. It will be better to spend your time on other aspects of your map.
There are a couple of different ways you can do this and instructions are below.
· For all the options, start by setting up a layout with a map frame and any other elements you need to include, e.g. a scale bar, copyright text, date etc.
· It can be useful to have an outline of your area of interest so you can keep track of the area you need. If you don’t already have one in your map, create it as a polygon and roughly digitise the outline of your area.
Moving the map around within the layout
This method is probably the simplest, but it can be easy to miss bits, and if you do, it isn’t always easy to repeat the process.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages by moving the map around in the layout
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your map layout, then move the map so you are looking at the north-west corner of your area of interest.
· Check the scale is correct.
· Print or export your map. If you export, you’ll be able to print further copies if you need them.
· Now carefully, using the Move item content tool, click and hold on the north-east corner of your map, and drag the map content across so that the bit you are dragging from is in the north-west corner of the layout. It’s usually a good idea to have an overlap.
· Once again, print or export your map.
· Continue doing this, dragging the map upwards from one of the southerly corners when necessary, so you have complete coverage of your study area.
Using the QGIS atlas function
This seems more complex, but if you make the effort, it is more reliable and if you need to generate maps for the same area again, it will be much simpler to do so than with the method above.
Once you have set up an atlas, QGIS will automatically export the pages based on your settings.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages with the QGIS atlas tool
This video clip can be found in the module area of Minerva or in the full list of video clips.
Creating a grid to control your atlas
You need to start by creating a coverage layout to control the area of each page of your atlas and the most reliable way to do this for field slips is to set up a vector grid to cover your area of interest.
To generate your vector grid:
· Search for Create Grid in the Processing toolbox and open the tool from under Vector Creation.
· Set Grid type to Rectangle (Polygon).
· If you have a layer covering the whole of your area of interest on your map, click on the three dots button at the end of the Grid Extent line and select Calculate from Layer, then select your area of interest layer.
· If you don’t have a layer covering the whole of your area of interest, select either Use map canvas extent or Draw on Canvas. If you select the latter, you’ll have a chance to draw your area on the map.
· Use the table below to select your Horizontal spacing and Vertical spacing based on the scale of your maps, and the size of your paper.
· Set the Grid CRS to the correct CRS for your map.
· Either create a temporary layer, or choose where to save your vector grid.
· Run the tool.
Note that the values in the table allow for a bit of an overlap. For landscape orientation instead of portrait, swap horizontal and vertical spacings.
This is a process which is likely to involve a bit of experimentation and changes in spacing to get the coverage you want.
	Paper size and orientation
	Scale of map
	Horizontal spacing (metres)
	Vertical spacing (metres)

	A4 landscape
	1:2,500
	600
	400

	A4 landscape
	1:5,000
	1250
	850

	A4 landscape
	1:10,000
	2700
	1800

	A4 landscape
	1:25,000
	6500
	4400

	A4 landscape
	1:50,000
	12000
	9000


[image: ../../shared/docs/images/layout/CreateGrid_small.png]
Creating a grid on which to base an atlas.
The result should be a regular grid, shown as the blue, dashed lines in the image below. (The thin, solid blue line is my area of interest.) The grid starts from the top left, so you may find you have too much space on the right and bottom of the grid. The main way to deal with this is to change the grid spacing, or use a slightly different area. If any of your grid rectangles have very little or none of your area of interest in them, as in the right-hand rectangles in the example below, you can delete them.
[image: ../../shared/docs/images/layout/VectorGrid_small.png]
The resulting vector grid shown as a blue, dashed line. The rectangles on the right contain very little of the area of interest, and I will delete them.
Setting up the atlas
Once you are happy with your coverage layer, you can start setting up the atlas.
· Enter Layout view and check your layout is set up correctly, e.g. with titles, scale bar, copyright, etc as required.
· Go to Atlas > Atlas Settings - the settings should open to the right of your layout.
· Tick the box labelled Generate an atlas.
· Set the Coverage layer to your vector grid layer.
· For now leave the Hidden coverage layer box unticked - being able to see the coverage layer while you are setting up, helps to get the correct areas on each page.
· For now you can leave the other settings as they are. You can come back to the settings and change those later if you need to.
[image: ../../shared/docs/images/layout/AtlasSettings_small.png]
The basic settings for an Atlas. Note that there has to be a Coverage layer, which in this case is my vector grid layer.
The next options are in the map properties:
· Click on the map frame that will control your atlas.
· Click on the Item Properties tab on the right.
· Scroll down and tick the box next to Controlled by Atlas.
If you are setting up a field slip you will need your maps to be at a fixed scale, usually 1:10,000. To set that fixed scale:
· Check next to Fixed scale.
· At the top of the Map Properties, check the Scale is set correctly - in my case to 10000.000 for 1:10,000.
[image: ../../shared/docs/images/layout/ControlledByAtlas_small.png]
Controlling the Atlas as a Fixed Scale in the Map frame properties.
· Now go up to the Atlas toolbar - if it isn’t visible go to View > Toolbars > Atlas toolbar.
[image: ../../shared/docs/images/layout/AtlasToolbar_small.png]
The Atlas toolbar with the Preview Atlas button clicked.
· Click the button on the left of the toolbar - the tooltip should say Preview Atlas.
Your map frame should jump to the first atlas page for your map. As you’ve left the coverage layer visible, you should be able to check whether you have the coverage you need.
· To preview your atlas, use the arrows on the toolbar. The numbers show which page you are on.
[image: images/svg/create-black-24dp.png] Changing the coverage
If you need to change the coverage, you’ll need to regenerate the vector grid, add it to your map, and change the coverage in the Atlas settings.
Preview your atlas again, and check whether it looks right.
Printing or exporting an atlas
Once you are happy with the coverage of your atlas pages:
· If you want to, make the coverage layer invisible by going to the Atlas settings and putting a tick next to Hidden coverage layer.
· Also in Atlas settings, you can choose whether to export multiple files, or tick next to Single file export when possible to generate a single file with multiple pages. This will work for pdf, but not most image formats.
· Double-check the scale is still correct.
· Go back to the Atlas toolbar and either click on the button to print your atlas, or choose one of the export buttons.
· If you are printing later, then choose pdf. This will also work best if you are going to make changes to your maps in Inkscape.
· If exporting, choose the folder you want to save your output(s) into, then click Select Folder.
· The defaults are usually fine, so stick with those for now, and press Save.
Depending on the number of pages you may have to wait for a bit, but once QGIS tells you it has finished, your file(s) should be available in the folder you selected.
Check the output, and make any changes to your coverage or layout as necessary.
There are other settings you can try, including using Expressions to add a page number or a different title for each page. The sources of help suggested below include more on this.
If you have a vector grid, it is also possible to create a final, less detailed map, which shows the coverage of each individual page - a map index.
[image: ../../shared/docs/images/layout/MapIndex_small.png]
A map index created from the coverage layer with the grid rectangles labelled with the map number.
Other sources of help for creating an atlas
There is a lot online about creating atlases in QGIS. Try any of the following:
· Training manual lesson on using the Atlas Tool - this uses a vector grid to control the pages of the atlas and this is what you are most likely to need for field slips.
· QGIS manual page for Generating an Atlas
· Klas Karlsson YouTube video on creating an atlas
Recommended reading: layout and presentation
The following references from the reading list[footnoteRef:1316] will give you information on the principles behind producing a professional layout. [1316:  Available in Minerva and via the University Library reading list page - just search for the module number.] 

· Darkes and Spence (2017) - large parts of this book are particularly relevant but it is formatted as a quick reference guide so it’s easy to get quick information about what ever you are looking for. Unfortunately, this book isn’t available online, but is worth buying if you want to buy one book for this module.
Particularly useful in the Darkes and Spence book are the pages at the end titled “Better mapping in 5, 15 and 50 minutes”.
· The article by Frye (2001) gives you quick information about communicating with maps.
Technical information
· The QGIS User Guide includes a chapter on Laying out the maps which covers a lot of the techniques from this chapter plus a few other things such as generating an atlas.
· QGIS Tutorials has a tutorial on Making a map in QGIS 3.
Further information and inspiration
· University of Delft publishes GIS OpenCourseware. Their tutorial on Cartography for map figures in academic journals and books is a clear look at how to include maps in other publications. This is well worth going through.
· For examples and ideas look at the ESRI Map Book Gallery.
· The British Geological Survey printed maps are available online via the BGS Maps Portal and it’s worth having a look at the layout of some of the more modern sheets, such as the Glossop sheet or the Bath sheet.
Completing a map layout in Inkscape
Last Modified: 28 Nov 23, 11:36:04
This chapter gives you ideas on how you can put together your own map layout in Inkscape. I’ll show you some ways you can do that, but feel free to experiment. You will probably need to use quite a few of these techniques for your dissertation map, but this time have a look at the information below and see how you can use it to improve layouts exported from QGIS. Use the Interactive Inkscape worksheets in conjunction with this chapter to finish laying out your map. In level two you’ll be learning how to produce a fair copy geological map in QGIS, and these techniques will be essential for the final layout then.
Why finish off your map in Inkscape?
The instructions in the GIS workbook, and particularly in the layout chapter, will enable you to create your whole map layout in QGIS, but adding images, diagrams and text to the final layout can be a bit hit and miss. Instead, once you have added measured grids, north arrows, a key, an extent indicator, and any other elements which are linked directly to the map, you can export the layout and then add more images, diagrams and text in Inkscape.
If you are working on a map exported from QGIS as pdf format, you can also ungroup content, and make minor changes (very carefully!). This is particularly useful if you need to move elements around on the legend or key, or remove some text.
In Inkscape you can use guides and grids to align your content, as well as the Align and Distribute dialogue. Make use of layers and groups to keep your content organised and “lock” anything you don’t want to edit by accident. You can import content from a range of sources, or create it directly within Inkscape.
[image: images/svg/warning-black-24dp.png] Warning
The instructions below don’t step you through setting up a layout. They are a series of things to try out and use if they are helpful for the layout you are working on at the time.
If you are in the level 1 class, try these all out and see how they work. In future you’ll have an idea of what is possible and what will be useful.
Deciding which format to export from QGIS
It is possible to export your map from QGIS and import it into Inkscape in a few different formats. Each has their advantages and disadvantages, but the amount of memory and power that your computer has might be the deciding factor.
SVG is the “native” format for Inkscape. This allows you to edit elements within the exported map, e.g. if you want to change the legend or some text. Unfortunately, at the moment support for exporting svg from QGIS is unreliable and I don’t recommend trying this.
PDF is another vector format and this can also be opened in Inkscape. Once you open a pdf in Inkscape you can save it as an svg file and edit the vector components in the usual way. This is the way I recommend you try first. If your map covers a large area in detail, note that Inkscape can struggle with large maps, but it could be worth a try to see how it gets on with your map.
QGIS will also export your map as png image format. This is the best option if Inkscape is running too slowly, or crashing when you open the pdf (or svg). It does mean that you can’t edit elements of the map itself any further in Inkscape. You’ll only be able to add new elements. It is, though, possible to export just a legend, for example, from QGIS and add that separately if that helps.
Below I’ve given separate instructions for using pdf and image formats in Inkscape.
[image: images/svg/create-black-24dp.png] Level 1 class: What should you do?
In the level 1 class, try out both of the sections below.
I have provided both pdf and png exports of the same map (Ashes Hollow) from QGIS so you don’t need to do the export from QGIS yourself.
• In the InteractiveInkscape.zip download from last week, you should be able to find the files AshesHollowLayout.pdf and AshesHollowLayout.png. Use these to work through this worksheet. (If you no longer have the data from last week, then download it now.)
Start by following the instructions to open the pdf version. You can also import the png version to the same document to see how it works but use the pdf version for the rest of the exercises.
Exporting your map from QGIS as pdf and opening it in Inkscape
If you have exported your map as png rather than pdf, go down to the next section for instructions.
Exporting a layout from QGIS as pdf format
[image: images/svg/create-black-24dp.png] Level 1 geology
If you are using these instructions as part of the level one geology module the pdf has already been exported for you. Go straight to the section on Opening a pdf file in Inkscape.

[image: images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS.
You can find this video clip in the module area of Minerva or in the full list of video clips.
Open your completed map layout in QGIS and start by checking that the scale of your map is correct in your layout - usually 1:10 000.
· Click on the button to export your map as pdf.
· Choose where to save your file and give it a name you’ll remember, then click Save.
You can experiment with the settings, but I find it works best if you don’t export as vectors or create a geospatial pdf.
[image: images/svg/info-black-24dp.png] Exporting text as paths
The recommended setting for Text export is Always Export Text as Paths. This exports text as a series of lines, rather than as text. It does mean you can’t edit your text, but it is possible to delete it if you need to and add corrected text in the resulting space.
The alternative - Always Export Text as Text Objects - keeps the text as text, but tends to mess up the spacing of the letters. It also becomes very difficult to change text, despite what you might think!
[image: ../../shared/docs/images/layout_inkscape/PDFExportOptions_small.png]
QGIS PDF export options.
· Close QGIS.
Opening a pdf file in Inkscape
As pdf is a vector format, you can open it in Inkscape in exactly the same way as you would open a .svg document.
Opening the map directly is the best way to preserve the scale of your map between the two programs. If you open a new document and add your map, it is very easy to change the scale without meaning to, though it is possible. Do not be tempted to resize your map! You should already have set it carefully to the correct scale in QGIS.
· Open Inkscape
· If you get the full splash screen, then click Time to Draw and select Browse for other files..., click on Open, then navigate to your exported pdf. How this splash screen looks will vary depending on your version of Inkscape.
· If you don’t get the splash screen, open the pdf map document with File > Open.
The PDF Import Settings window should open, showing a preview of the document you are opening. (The screenshot below shows Inkscape version 1.3. If you are using Inkscape 1.2 your import screen will be different, but you should still be able to leave everything as the defaults.)
[image: ../../shared/docs/images/layout_inkscape/PDFImportSettings_small.png]
Inkscape PDF import options.
It is best to leave all settings as the defaults, though if you have a multi-page pdf you can select just the page(s) you need. Usually, if you’ve exported from QGIS, you will only have one page.
· Click OK.
Inkscape should open your map layout, setting the page size to the same as the original pdf.
Saving the pdf as svg
At this point it is a very good idea to save the imported pdf as an svg document.
· File > Save as...
· Check the Save as type: is set to Inkscape SVG (*.svg).
· Give your new file a name you’ll remember and choose where to save it. (If you’re using the Ashes Hollow map, feel free to keep the name as AshesHollowLayout.svg.)
Exporting your map from QGIS as an image and opening it in Inkscape
If you have exported your map as pdf rather than png image format, go back to the previous section for instructions.
Exporting your map from QGIS as an image
[image: images/svg/create-black-24dp.png] Level 1 geology
If you are using these instructions as part of the level one geology module the pdf has already been exported for you. Go straight to the section on Importing a map as an image into Inkscape.
· Follow the instructions in the QGIS workbook section on Exporting a map layout from QGIS to export a png (image) format map from your layout.
[image: images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS.
You can find this video clip in the module area of Minerva or in the full list of video clips.
Open your completed map layout in QGIS and start by checking that the scale of your map is correct in your layout - usually 1:10 000.
Then click on the button to export an image.
· Set Export resolution to 300 DPI to start with.
· Check that Crop to Content isn’t ticked.
· Choose where to save your file and give it a name you’ll remember, then click on Export.
[image: ../../shared/docs/images/layout_inkscape/ImageExportOptions_small.png]
QGIS image export options.
[image: images/svg/info-black-24dp.png] Resolution and image quality
Image quality depends on the resolution in DPI (dots per inch). If this is set too low the quality will be bad, if it set too high your computer will struggle to handle the image. 300 dpi is usually a good compromise between quality and speed, but you can experiment, e.g. by putting dpi up to 600, or down to 150.
· Check the map image by opening it in your computer’s default graphics app.
At this stage you can change any settings, such as the dpi, and export the image again if you need to.
· Once you’re happy with the map image, close QGIS.
Importing a map from an image into Inkscape
· Open Inkscape if it isn’t already open.
You can either import the image to a new document or to an existing one.
· If you get the splash screen, click on New document at the bottom right of the Time to Draw tab to get a blank Inkscape document.
· Click on File > Import... or the keyboard shortcut <ctrl + I>.
· Select your exported png image and click Open.
· In the dialog which appears, select to Link the image, not to Embed. This means that you will need to keep the Inkscape document and the image together, but that the Inkscape document won’t become too large and will be less likely to crash.
[image: ../../shared/docs/images/layout_inkscape/ImageImportOptions_small.png]
QGIS image import options.
· Click on OK to import the map.
Don’t be tempted to resize the imported map image once it has been imported or the scale will become incorrect.
Setting page size for your map
If you opened a pdf, Inkscape will have set the page size to the same as the pdf. If you imported an image, then the page size in Inkscape is probably still the default A4 size.
If necessary, set the page size to the maximum size you are likely to need. For the level 1 map I’ve provided and for the assessment for your level 2 module this will be A3 so you have room to add sections etc. For a mapping dissertation it will probably be A0. Make sure you read the instructions you’re given!
· File > Document Properties > Display
· Select the correct page size, and whether you want it to be Portrait or Landscape orientation. It is also a good idea to tick the box next to Border on top of drawing.
Saving your document and setting autosave options
· Save your document - either File > Save or <ctrl + s>. Do this regularly - you are likely to be dealing with large documents and Inkscape may crash.
Additionally it is possible to set Inkscape to autosave your documents at regular intervals.
· Go to Edit > Preferences > Input/Output > Autosave and tick Enable Autosave.
You then need to restart Inkscape for this to work. The default interval is every 10 minutes, and it would be worth making a note of where Inkscape saves the autosave files.
Keeping track of elements with the Object browser
Don’t forget you can use the object browser to keep your layout elements organised. See Interactive Inkscape 10 for a reminder of how to use this. You can end up with a very complex document, so being organised can save you time in the long term.
I’d suggest starting by locking the layer you have imported the original map onto so you don’t move or make other changes by mistake. If you then need to move or change anything on the pdf map, don’t forget to unlock it to make the changes but then lock it again.
I’d also suggest renaming your layers so you know what they contain. For example, my imported pdf map is on a layer called 1. I’m going to rename that as Original map so I know what the layer contains.
When adding other elements, create a new layer and add the new elements to that.
For example, before importing a cross-section, create a new layer called Cross-section 1, make sure that it is selected, then import the svg for the cross-section.
Then you’ll be able to select that element using the object browser, make it invisible if you need to, or lock it so you can’t select it by mistake.
In the image below you can see that I’ve added separate layers for each element I think I’m going to be adding - Text, Title, Logo, Abstract, Cross-section 1.
[image: ../../shared/docs/images/layout_inkscape/ISObjectBrowser_small.png]
An example of layer organisation. The layer at the bottom called Original map is the renamed layer for the original map. The padlock on the right indicates the layer is locked and can’t be edited. I’ve added layers for a cross-section, title, etc.
Moving elements from the original pdf
Making changes to the elements on the original pdf in Inkscape is something to be done with care, though if you make mistakes you can always reimport from the pdf again. The best advice is to position elements carefully in QGIS first so you don’t have to move anything later!
Sometimes you need to move parts of the layout around to make space on the new page. For example, moving the legend or a section of text.
[image: images/svg/create-black-24dp.png] Level 1: Moving an element
If you’re using this document in the level one module, try moving the north arrow and associated text so it is in a different position on the layout.
· Make sure the layer containing the original layer is unlocked.
· Use the Selector Tool (s) to draw a rectangle around the element you want to move and let go. You may need to lock (or delete!) a background element if it moves when you try to select.
· At this stage you can group the element if it consists of multiple items - Ctrl + G.
· Now use the Selector tool again to move the element to where you want it.
Adding cross-sections and diagrams to your layout
[image: images/svg/videocam-black-24dp.png] Importing elements to an Inkscape document
You can find this video clip in the module area of Minerva or in the full list of video clips.
Create any cross-sections, stratigraphic columns and diagrams as separate svg documents. Don’t worry too much about matching colours with your map at this stage - you can do that later. It is then simple to import them to your main layout.
[image: images/svg/create-black-24dp.png] Level one: Cross-section to add to layout
For the level one module, either use the cross-section from Ashes Hollow that you digitised in Interactive Inkscape worksheet 11, or use the example cross-section for the same area that I digitised.
· File > Import... and select your svg file then Open.
The SVG Input dialog should open.
· Set the SVG Image Import Type to Include SVG image as editable object(s) in the current file - this enables you to make changes later if you need to, such as matching the colours to the map.
· Leave the DPI for rendered SVG as 96.00. If you’re not happy with the result, you can try again with this set to 300, or even 600.
· Image Rendering Mode should be set to Smooth (OptimizeQuality) as you’re trying to create a good quality presentation.
· Click OK once you are ready.
[image: ../../shared/docs/images/layout_inkscape/SVGImport_small.png]
The SVG Input dialog. Choose to Include SVG images as editable objects within the current file.
Once the content is imported, you can move it around, resize if necessary (be careful with scale for your cross-sections though), and edit it too if you need to. It will come in as a group, so you may need to Ungroup it - Shift - Ctrl - G.
Checking scale in Inkscape
Document 7 of Interactive Inkscape - Transformations - will have shown you how to create an accurate scalebar within Inkscape. You can also check within Inkscape that the scale of your map and section is correct.
You’ll usually need to create a map at 1:10 000, and your section should be to the same scale, with no vertical exaggeration.
[image: images/svg/info-black-24dp.png] Checking scale at 1:10,000
At a scale of 1:10,000, 10 cm will be 1 km.
To check the scale of your map:
· Use the Pen tool (b or Shift-F6) to draw a horizontal or vertical line (remember to hold down the control key to constrain the line to certain angles). Don’t worry about the length while you are drawing it.
· Use the select tool (s) to select the line, then use the context toolbar to change the units to cm, then set the width or height as appropriate to 10 cm. I find it useful to make the line a bright colour so that I can see it above the rest of the items on the page.
· Now move the line so that it is over your map, and line it up with the grid squares. Remember the space between 1 km grid squares should be 10 cm.
· You should know the length your section is supposed to be, so use a similar technique to check that.
Don’t forget to remove any lines when you’ve finished! You don’t want to include them on your final map.
Matching colours between diagrams and your map
[image: images/svg/videocam-black-24dp.png] Editing imported elements in Inkscape and using the colour dropper to match colours
You can find this video clip in the module area of Minerva or in the full list of video clips.
Once your svg sections, strat columns or diagrams etc. are on the main layout you can match the fill colours using the dropper tool.
[image: images/svg/create-black-24dp.png] Level 1: Matching the colours
If you are using the level 1 Ashes Hollow map and my section, notice that the colours for the section are stronger than the colours on the map. If you are using your own digitised section, the colours may well be different.
Use the instructions below to make the colours on the section match the colours on the map.
You’ll need to select the area for which you want to change the colour, and to do this you may need to ungroup your diagram.
· Right-click on the diagram and Ungroup. Click elsewhere to unselect then try clicking on the object you want to select again. You may need to ungroup multiple times. Alternatively you can choose to Enter Group...
· Select the object for which you want to change the colour. Open the Fill and Stroke dialog and go to the Fill panel.
· At the lower left is an eye dropper symbol, click on that, then click on the area of your map that matches the same colour, e.g. the same type of rock. The fill for the object you have selected should update to match.
Try not to click on a contour, or somewhere with a part of the background map - you need the “pure” colour. If you have a key for your map which was produced by QGIS, the colour patches for the key are probably the easiest way to find the correct colour.
[image: ../../shared/docs/images/layout_inkscape/ISFillPanel_small.png]
The Fill panel in Inkscape with the eye dropper tool marked.
Adding images to your layout
Images can be jpg, png, tif formats, and probably others too. Use this to import logos, photos etc.
[image: images/svg/create-black-24dp.png] Level 1: Adding the University Logo
I’ve provided the University of Leeds logo in the Interactive Inkscape folder - uol-logo.png. Use the instructions below to add this to your layout.
Note that the University has strict requirements for use of the logo. Keep it small, don’t change the colour, and if you use it, place it at the top right of your documents.
Adding images is fairly simple, but do try to make sure they are good quality to start with, and it’s best if you don’t need to resize them too much once they have been imported.
· File > Import navigate to the image and select it, then Open.
· To include it in your document choose to Embed. If you choose to Link you’ll need to keep the image and svg file together in your folders, but the size of the svg file will be smaller.
· Choose Image Rendering Mode as Smooth (optimizeQuality). Then click OK.
You can then move the image to wherever you want it, and resize etc as necessary.
Adding text to your layout and editing existing text
More detailed instructions for adding text are covered in the Interactive Inkscape worksheet number 9.
Adding new text
To add a title, or your name, student ID and the module code just use the text tool (t) and format the text as required.
[image: images/svg/create-black-24dp.png] Level 1: Text to add to Ashes Hollow Layout
I’ve exported the Ashes Hollow layout from QGIS with very little text. Try adding the following:
• A title: “The geology of Ashes Hollow, Shropshire”
• Your name or id, the module number, and the date.
• Label the cross-section as “Cross-section following the line on the map”.
• The data acknowledgements shown below:

Background map: © Crown Copyright and database rights 2023. Ordnance Survey (AC0000851941)
Geological map based on: Wilson, D. (2000) Ashes Hollow - Devil’s Mouth In Precambrian Rocks of England and Wales, Geological Conservation Review Series No. 20, Joint Nature Conservation Committee, Peterborough, pp. 98-103.

Adding formatted text directly in Inkscape
It is possible, though fiddly, to add formatted text directly in Inkscape.
To create paragraphs of formatted text directly in Inkscape use the Text tool (t) to drag a box to fill the space where you want your text. Type your text, then select a couple of words. To format that text, bring up the Text and Font dialog (Shift + Ctrl + T) and choose a different font, or select bold then click Apply. You can also use keyboard shortcuts such as Ctrl - B to make the selected text bold.
This isn’t ideal, but then Inkscape is a graphics program, not a word processor.
Adding formatted text from Word or similar apps
To add formatted text, e.g. an abstract, you may find it easier to import it from a Word document or any other similar word processed document that can be saved as pdf. Try that now by creating a Word document with a title and some bold, italic and coloured text. It doesn’t matter what it says! (Keep it polite…) Set the page size to a size that will just fill the space on your page, e.g. A5 or a custom size in centimetres. You can also set the margins to Wide so there is space around your text once it is imported.
Try not to use any fancy fonts - these probably won’t import and your text will be imported as a generic font.
Save the document as a pdf file, and import it into Inkscape in the usual way -
File > Import... Select the document, then Open.
If Inkscape imports the text as a separate page, you may need to copy and paste it from there, or select and drag it onto your layout.
You can then delete the extra page as follows:
· Click on the last button on the toolbar on the left (usually… It’s the one with all the tools such as the select tool). The tooltip should say Pages Tool.
· Use the tool to click on the new page, the one you want to delete.
· Right-click and Delete page.
· Make sure you go back to a different tool, such as pressing s for the Selector Tool, so you don’t delete the page you’re working on by mistake!
Editing text from the original pdf
If you exported text as paths from QGIS (as recommended) and imported the pdf, you won’t be able to edit the text as text. Instead, try hiding or deleting the bits you don’t need or need to change, and use the Inkscape text tools (Interactive Inkscape worksheet 9) to fill in the changed text.
· Unlock the layer your original map is on.
· Use the Selector Tool (S) to select the text you want to change. The selection should be highlighted in the Layers and Objects panel. Use that to hide the selection by clicking on the eye symbol next to it.
· At this stage it’s a good idea to create a new layer and add your additions on that - it makes it easier to find them later if you need to!
· Now go to the Text tool (t) and use it to add the new text. It can be a little tricky to match the size and font of the text, but it’s worth making the effort.
Replacing text on an imported image
Note that if you imported the image file for your map rather than the pdf, you won’t be able to select existing text or delete it.
One way around this is to cover the text you don’t want with a rectangle or other shape which is the same colour as your background. You can then add new text on top of that.
Additional techniques
Adding outlines or boxes
If you want to outline elements, just add rectangles or squares using the appropriate tool (r or F4) and set the fill and stroke appropriately. Using the Layers and Objects panel, move the shape downwards so it doesn’t cover other elements.
A well placed outline can lift the presentation of a map or poster - but don’t go overboard!
Aligning elements
Don’t forget to use Align and Distribute (Shift+Ctrl+A) to line up elements.
Try using Guides in combination with Snapping to make it easier to line up the elements in your map or poster, or turn on the Page Grid.
Remember to refer back to the Interactive Inkscape worksheets if you need reminders of how to do things.
Printing or exporting your map
Refer back to Interactive Inkscape worksheet 12 which covers printing and exporting.
Creating posters in Inkscape
The techniques shown here for creating a map layout in Inkscape will also work for creating posters.
You may have used Powerpoint in the past, but some people find Inkscape much more flexible and easier for producing a professional-looking poster. It’s up to you!
Remember that your dissertation map is not a poster. One big difference is that a poster will be put on a wall and needs to be read from a distance. This map is intended to be looked at more closely, probably whilst being held in the hand.
So for a map to be held in the hand, you shouldn’t make text and elements too large. Have a look at published geological maps, e.g. by the British Geological Survey (copies available from Clare) and see how small some of their text is.
For a poster, you will need to use larger headings and clearer symbols on diagrams so that they can be read at a distance - have a look at the scientific posters on the walls around the School of Earth and Environment for plenty of examples.
Viewing your data in 3D
Last Modified: 08 Dec 23, 10:00:00
The background to viewing data in 3D will be covered in the lecture and the presentation and any other supporting materials will be available in Minerva. The lecture should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[image: images/svg/info-black-24dp.png] Optional chapter
Note that this chapter is optional. It adds to your knowledge and experience of GIS and is an engaging way to display and analyse data, but it is not essential.
If you are enjoying the GIS and have time in the final practical, then try working through this or the chapter on dynamic / time data to explore some fun techniques and different data.
If you don’t have the time, then don’t feel you have to do this chapter now. If you’re aware these techniques are possible, you can come back to this chapter in the future.
Learning outcomes
When you have completed this section of the workbook you should be able to
· Display data in 3D with GIS tools.
· Explore data in 3D.
· Save a 3D view and add it to a map layout or export for use in other applications.
Introduction to viewing data in 3D
On 18th May 1980 the long dormant volcano, Mount St Helens in the north west United States of America, erupted. Over the course of several weeks lateral blasts from the eruption destroyed the forested slopes and the volcano covered a large area in lava and ash.
[image: images/three_d/HEruption_small.jpg]
The eruption of Mount St. Helens in May 1980 showing the ash cloud.
The USGS has a downloadable file with more information about the eruption.
The Cascades Volcano Observatory has a lot more information and images of Mount St. Helens, including sections on hazards, monitoring, geology and history.
In this exercise we’ll use tools in QGIS to investigate the changes in the shape of the mountain caused by the eruption. We’ll use USGS (United States Geological Survey) height data measured before and after the eruption.
Obtaining the data for this exercise
Download the MtStHelensQ.zip file from Minerva. Save it to your gis folder and unzip it.
The data for this exercise has been obtained from SERC Carlton teaching resources and converted for use in QGIS.
The exercises are based on worksheets from the above URL and from ESRI Canada.
Setting up the map project
· Open a new blank map in QGIS.
· The data folder should include two files, hafter.tif and hbefore.tif. Add these both to the blank map by dragging and dropping from the Browser panel.
· Adding these layers should set the CRS of the project to EPSG:26910 - NAD83 / UTM zone 10N [footnoteRef:1422]. If you have a look at the Project properties CRS subheading you should be able to check the area that this covers. [1422:  NAD = North American Datum and UTM = Universal Transverse Mercator. The World is divided into UTM zones which are also marked as north or south. For example, Portugal is covered by UTM zone 29N.] 

· Save your project into the MtStHelensQ folder.
[image: images/svg/create-black-24dp.png] Look at your data
Have a look at the two layers that you have added to your map. They should cover the same area but look slightly different.
Check their details in the Layers panel - are the maximum and minimum values the same?
Have a look at the layer properties and make a note of the following information:
Data type
Unit
Pixel size
The hbefore layer is height data from before the May 1980 eruption, hafter is height data from after the eruption.
These are raster layers where each pixel contains the elevation of the land at that point. If you’ve checked the layer properties, you’ll know that each pixel covers an area of 30 x 30 metres.
[image: images/three_d/HGridFiles_small.png]
The original layers as you should see them at the moment. Left is hbefore, right is hafter. Note that you will see them one at a time as they should be in the same location.
Styling the raster layers
At the moment the height layers, the rasters that you have just added to your map, will be coloured the default shades of grey. We can style the layers so that the elevation is clearer. This is similar to the way we previously styled a continuous raster but this time we’ll select a colour ramp which is suitable for elevation data.
[image: images/svg/videocam-black-24dp.png] Styling a continuous raster in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make the hafter layer invisible in the Layers panel.
· Select the hbefore layer in the Layers panel and go to the Layer styling panel.
· Set the style type to Singleband pseudocolor and check that the Min / Max Value Settings > Accuracy is set to Actual (slower).
· Drop down the box next to Color ramp and go to Create new color ramp...
· Set the color ramp type to Catalog: cpt-city then click OK.
· Use the selector to go to Topography and click on the color ramp called sd-a
[image: images/three_d/ColorRamp_small.png]
Selecting the sd-a color ramp from the Topography section.
· Click on OK to return to the Layer Styling panel and see the color ramp applied to your data. It’s a good idea to click on the Classify button underneath the list of classes to ensure that it has been updated correctly.
[image: images/three_d/HbeforeStyled_small.png]
The hbefore layer styled with the sd-a color ramp.
Now that you have the style set for one raster you can easily apply it to the other.
· Make the hafter layer visible again.
· Right-click on hbefore and go to Styles > Copy style.
· Then right-click on hafter and go to Styles > Paste style.
Both layers should now be set to the same maximum and minimum values. This is good because it makes it possible to visually compare the two on the same scale.
Creating hillshading
It is possible to see from the height files that you have already styled some differences in the before and after topography, but they do not give a very clear view. Hillshade layers can accentuate the topography of an area (and incidentally can give a better idea of the quality of your height data).
[image: images/svg/videocam-black-24dp.png] Hillshade, slope and aspect in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Go to Raster > Analysis > Hillshade... in the menu bar.
· The Input layer is the hbefore layer.
· You can leave the rest of the settings as the default, but go to Hillshade at the bottom and click on the three dots button to choose where to save the output and give it a name.
· Click on Run, then Close when the tool has finished running.
[image: images/three_d/Hillshade_small.png]
Filling in the form to generate a hillshade layer from the hbefore layer.
You should find that you have a new grey layer which gives an impression of the shape of the land shown in the hbefore layer.
[image: images/three_d/HbeforeHillshade_small.png]
The hillshade layer generated from the hbefore elevation layer.
[image: images/svg/create-black-24dp.png] Create a hillshade for hafter
Repeat the instructions above to create a hillshade layer for the hafter elevation layer.
Check that the Layers panel is arranged so that the hbefore hillshade layer is just above the hbefore layer and the hafter hillshade is just above the hafter layer and make the hafter layers invisible. You can group the pairs of layers to keep the layers panel tidy.
[image: images/three_d/OrderOfLayers_small.png]
The order of the elevation and hillshade layers in the Layers panel.
Using the hillshading to style the elevation
At the moment only the hillshade layer is visible, and it doesn’t look very informative.
· Select the hbefore hillshade layer in the Layers panel and open the Layer styling panel.
· Go to the Layer Rendering section and set Blending mode to Multiply.
· You can also change the Opacity slider in the Transparency tab if the hillshading still looks too strong.
Now you should be able to see the styled elevation layer through the hillshade, but the hillshade is just accentuating the shape of the land. Try unticking and ticking the box next to the hillshade a few times to see the difference it makes.
[image: images/three_d/HbeforeHillshadeMultiply_small.png]
The hbefore elevation layer with the blended hillshade layer on top.
[image: images/svg/create-black-24dp.png] Repeat the process with the hafter layers
Use the instructions above to repeat the process, using the hafter hillshade on top of the hafter elevation layer.
Have a look at both combined layers. The difference in the shape of Mount St Helens before the eruption and after should be becoming clearer.
The lines across the hillshades are due to the way the data will have been collected and processed. In this case there isn’t much we can do about that.
[image: images/svg/info-black-24dp.png] Hillshade light source
Incidentally, notice that the light source on the hillshade layer comes from the top-left of the image - which is usually the north-west, a direction from which the sun very rarely shines in reality.
This direction gives the best effect of 3D for a 2D image. If you try turning a hillshaded map upside down so that the sun comes from the south-east, very often valleys will look like hills and hills will look like valleys.
Area and volume calculations
It’s good to be able to look at the differences on a map, but what about actually doing some measurements and getting some figures out of the data? The Processing toolbox gives us a tool which will calculate the volume of our elevation rasters before and after the eruption.
· Open the processing toolbox if you don’t already have it open.
· Search for surface volume in the toolbox and double-click to open the Raster surface volume tool from the Raster analysis toolbox.
· Fill in the form as follows:
· Set the Input layer to the hbefore layer. Make sure you use the elevation layer not the hillshade.
· Set the Base level to 669. This is 669 metres above sea-level and is the lowest height from the two height raster layers. You need to set this to an appropriate height for the particular analysis that you are doing.
· Set the Method to Count Only Above Base Level - the help for this tool gives a bit more information about the options.
· Don’t worry about saving the output this time - you’ll make a note of the results from the Log or the results window.
· Click on Run but don’t close the window yet.
[image: images/three_d/RasterSurfaceVolume_small.png]
The form for the Raster surface volume tool, also showing the help information. If you can’t see this there should be a small black arrow to click on at the top right of the form.
· If the tool runs successfully the results will appear in the Log - you should be able to see the AREA, PIXEL_COUNT and VOLUME.
· Don’t worry if you have already closed the tool. QGIS should also have opened the Results viewer. You’ll see there a link to an html file - click on that and the results should open in your web browser.
[image: images/three_d/RasterSurfaceVolumeResults_small.png]
The results for the raster surface volume shown in the Log. Take a note of the VOLUME result.
It is the volume that we are particularly interested in. This takes height into consideration so should give a greater number than simply measuring the area in 2D on the map.
· Make a note of the VOLUME so that you can compare it with the volume of the hafter layer later.
hbefore volume =
· The units are set by the map units, which in the case of this map are metres. You can check this in the Map Properties if you need to. So the volume is measured as metres cubed (m^3).
[image: images/svg/create-black-24dp.png] Calculate the volume for after the eruption
Repeat the process above to calculate the volume for the same area after the eruption. Again, use 669 metres as the Base Level.
Again, make a note of the result for VOLUME.
hafter volume =
Have a look at the two sets of results and compare them.
[image: images/svg/create-black-24dp.png] Looking at your results
What differences are there? What can you say about the change in volume before and after the eruption?
Creating profile graphs
QGIS enables you to draw a profile graph, or cross-section, across your map using z values in your raster surface files or heights above sea-level. You have two elevation layers on your map and can use profile graphs to compare those.
There is a plugin called the Profile Tool which is very simple to use, but which has limitations. If you would like to try that then you’ll probably find it pretty easy to use. Instead, for these exercises, I’ll take you through how to use a plugin called qProf. This allows us to have control over the x and y axes, and to export the graph in such a way that it is possible to display it properly on a layout.
Using the qprof plugin
· You’ll need to install the qProf tool plugin by going to Plugins > Plugin Manager.
The description of this tool talks about plotting geological data, but for the purpose of this exercise we won’t need to use that functionality.
· To open qProf go to Plugins > qProf > qProf.
The qProf window should open as a panel to the right of your map area.
[image: images/three_d/qProfPanel_small.png]
The qProf window.
[image: images/svg/videocam-black-24dp.png] Creating a profile graph in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
The first thing you need to do is select the layer that contains your z or height data.
· Check that the Topography tab is selected at the top of the qProf panel.
· Click on the button to Define source DEMs
· From the list tick the box next to hbefore, or your height layer (not the hillshade layer), and click OK.
Next you need to define the input line, i.e. the line of your profile. We’ll start by using a temporary, or Digitized line.
· Check that the hbefore layer is visible on your map - this shows the extent of your height data.
· Make sure that Digitized line is checked on the qProf dialog, then click on the Digitize line button.
· You are given brief instructions. Click OK when you’ve read them, then on your map:
· left-click at the centre top of the hbefore layer
· then left-click at the centre bottom of the hbefore layer, ensuring that your line goes over the summit of Mount St Helens.
· right-click somewhere on the map to stop drawing the line.
You should end up with a red line across your map. Now you can generate the profile.
· First make sure that DEM input is checked, then click on the Read source data button. Hopefully you’ll get a message saying Data profile read. Click OK to dismiss the message.
· Next click on Calculate profile statistics. You should get a small window full of numbers. Close this, it shows that qProf has successfully created points at regular intervals along the line and assigned a height to them from the DEM.
· Then click the Create topographic profile button. You’ll get a Topographic plot parameters window at this stage.
· Set vertical exaggeration to 1 - you can set it higher if you particularly want to show the shape of the land, but for scientific purposes you will usually need to set it to the real-world exaggeration, which is 1.
· Leave the Plot z max value as whatever qProf has calculated.
· As this is an inland area it is very unlikely that the minimum height will be less than sea-level, so set Plot z min value to 0.
· If you want to change the colour of your line you can click on Elevation line visibility and colours, then on the colour patch. Change the colour if required, then click on OK.
[image: images/three_d/qProfTopoParameters_small.png]
Filling in the Topographic Plot Parameters. Particularly note the vertical exaggeration.
· Now click on OK to generate the profile.
A simple profile window should open. You can resize this to make the plot larger or smaller.
Have a look at your output and compare it to your line on the map then close the window with the cross at the top right.
[image: images/three_d/qProfProfileWindow_small.png]
The generated profile. You can enlarge the window to make the profile larger.
· The x axis shows the distance in map units, which in this case will be metres. You can check this in the project properties if you need to.
· The y axis shows the values of your chosen “surface”. In this case the height data, which is also measured in metres.
· Note that if you have set the vertical exaggeration to anything except 1 the x and the y axes will not be in proportion to one another. Also note that if you follow the instructions further on for adding a profile to a layout, this won’t make any difference as it will end up to scale anyway.
[image: images/svg/create-black-24dp.png] Experiment by drawing different lines
Click on Digitize line again and try drawing a few different lines across your map in any direction you fancy to see what the terrain is like. You’ll need to click on all three buttons in the lower part of the tool again each time.
Adding a second profile to the same graph
It is possible to add multiple layers to provide z values on the same profile graph.
· You also have the hafter height layer on your map. You can show both layers on the same profile to compare before and after the eruption.
· Click on the Define source DEMs button again and this time select both the hbefore and hafter layers, then click OK.
· Now follow the instructions above again to digitise a line across your map then view the profile. Using the Topographic Plot Parameters you can set each profile to a different colour so that you can tell them apart.
The output should look something like the image below. Changing the colour of one of the lines makes it simpler to remember which is which. In my profile the hbefore layer is red and the hafter layer purple.
[image: images/three_d/qProfProfile2_small.png]
The qProf tool with two elevation layers set - hbefore in red and hafter in purple.
When you’ve finished experimenting just close the qProf tool panel. This will clear the settings that you’ve been using.
Using a feature class for the line on the map
So far, you’ve only used a temporary line on the map for the line of the profile. When you close your map, this line will disappear. If you are going to include the profile on the map layout you also need to show the line of the profile on the map. To do this you can create a feature class and digitise a line across the map. It is also possible to use an existing line feature, such as a river or a road to create the profile, but we’ll digitise a line for now.
· Create a new line feature class called ProfileLine and add it to your Layers panel above the other layers. This feature class can be either a shapefile or a layer in a geopackage, it’s up to you. Double-check the data type is line and that you’ve set the CRS to the same as the project - EPSG:26910.
· Digitise a line from north to south across the summit of Mount St Helens.
· Open the qProf tool again in the same way as before.
· Add hbefore and hafter under Input DEM.
· Under Input line click to check next to Line layer.
· Click on Choose layer button and set the Input line layer: to your ProfileLine layer.
As there is only one line in this feature class you don’t need to worry about the other settings.
· Click OK
· Click on the Read source data, Calculate profile statistics and Create topographic profile buttons again to generate the profile, setting vertical exaggeration to 1 and Plot z min value to 0. You can also change the colour of the lines so that you can tell them apart.
The result should look the same as the previous result with two lines.
[image: images/svg/create-black-24dp.png] Checking the data
Have a look at your profile graph. Does this look as you would expect it to? What are the differences between the before and after layers and are they as you would expect?
Saving the profile graph
You can save your profile graph as an image to add to other work, e.g. in Word or PowerPoint.
· If you still have the profile graph open you can close it now.
· Click on the Export tab at the top of the qProf panel.
· Click on the Figure button.
· You can change the size of the image and various other parameters here.
· Click on Choose to navigate to where you want to save the graph and give it a name. For now, give the file name an extension of .tif to save the output as an image.
· Click on Save then OK to actually save it.
· For now keep the qProf dialog open - you’ll use the same profile for the next section.
The resulting tiff file can be added to reports or map layouts as any other image can, but see below for an alternative.
This output is rather basic. It simply gives you the profile without any labels, titles, etc. If you are going to include a profile graph on a map layout or in a report you will need to annotate it with titles, labels, etc.
One way to add annotations is to export the figure as .svg format instead of .tif, open the file in an editor, such as Inkscape, and add the annotations there.
Generating a profile graph in a layout with qprof profile data
Sometimes producing the output you want in GIS can involve looking for alternative ways to do something. This is a prime example. Using the qProf tool it is possible to export the data in a way that allows you to plot the profile as a line on a map. This then opens out the possibility of including it on a layout and using grids to add the axes, labels to add the title, and a key.
[image: images/svg/info-black-24dp.png] Do you need to do this section now?
If you don’t have the time to do this right now I’d suggest missing out this section as it is quite long. Go straight on to the section on viewing 3D topography in QGIS, you can always come back to this section if you need it later, though if you do work through it you’ll be more likely to remember that it’s possible to do this if you need to do it later.
If you do want to do this now the instructions below cover exporting the data from qprof, then importing it to QGIS so that you can set up the profile. There are some ideas for how to annotate and style your profile graph but use the layout techniques that you’ve already covered too.
[image: images/svg/videocam-black-24dp.png] Using profile data to display a profile graph on a layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Exporting a csv file with the profile data
· If you don’t already have qProf set up to show a profile from north to south across Mount St Helens then follow the instructions above again so that you have.
· On the Export tab click on the button to export Topographic profile data.
· Under Profile sources click next to Single DEM and make sure that hbefore is selected [footnoteRef:1498] [1498:  If you want to show two lines it may be best to export them as separate csv files so it’s more flexible when you set up the layout.] 

· Under Output format select csv
· Click on the three dots button to set the location and name for the Output file
· Click OK
· Repeat the above to export a csv file for the hafter layer too.
[image: images/three_d/ExportTopographicProfile_small.png]
The settings to export the topographic profile as a csv file.
· You can close the qProf window now.
· Open your new csv file in a spreadsheet program or text editor to see what it contains. You’ll see that it’s an awful lot of numbers!
[image: images/three_d/ProfileCSV_small.png]
The csv file containing the data for your profile graph.
You should recognise the x and y fields as being the grid coordinates, though with rather a lot of decimal places! The cds2d column gives the distance along the y axis from 0, or the start of the line. The z column gives the height at that point on the profile taken from the original DEM data.
· Close the spreadsheet or text editor without making any changes.
· Return to your map in QGIS.
Adding the csv profile data to a map
You need to add the csv file to your map as data, but we don’t actually want it to appear in the same position as the rest of the map so we won’t be using the grid coordinates.
· Click on the Add spreadsheet layer button - remember you installed and used this to add the lead concentration points to the Cononish map. You’ll need to drop down the file type and choose All files to see the csv file.
· Add the new csv file as your File name and give your output Layer name a name that will mean something to you.
· File Format should be CSV
· This is where what we do needs to differ. Tick Geometry then instead of setting x and y as the Point coordinates use:
· cds2d as the X field
· z as the Y field
· Leave the Geometry CRS as the same as the project - in this case EPSG:26910.
· Click on OK to add the new layer to your map.
[image: images/three_d/CreateLayerFromSpreadsheet_small.png]
Creating a layer from the csv file for the hafter profile graph.
You won’t be able to see the new layer on the map when it is added, but right-click on it in the Layers Panel and Zoom to layer. Now you should be able to see a line of dots across your map. The data has been added at about 0,0 on the CRS that you set, which is fine for our purposes. You’ll also notice that any vertical exaggeration, if it was applied, is no longer present. This is now at a vertical exaggeration of 1.
[image: images/three_d/ProfilePoints_small.png]
The points making up your profile.
Converting the profile points to a single line
The next stage is to convert that row of points to a single line.
· In the Processing toolbox search for Points to Path
· The Input point layer is the imported csv points, e.g. ProfileBefore in my example.
· The Order field is the order the points need to be linked together in. For this it should be prof_id, or something similar which is probably the first field.
· Under Paths give your output line a name - you can save it in the project geopackage.
· Click Run to create the line then Close the tool.
[image: images/three_d/PointsToPath_small.png]
The Points to Path tool to convert the points to a single line.
You can turn off and remove the profile points layer now, and you should be left with a line across the map window. You can now style this in whatever way you wish to in exactly the same way you would style any other vector layer.
[image: images/svg/create-black-24dp.png] Creating a profile for hafter
Repeat the process with the hafter csv file. This should produce another line which appears in the same position on your map as the hbefore line. The two should look very similar to how they appeared on the output of the qProf tool.
Creating a profile on a map layout
Now we come to setting up the profile on a layout in QGIS.
· Make sure that you have done Zoom to layer to the Profile layer in map view
· Open either an existing layout if you have one, or create a new layout.
· Add a new map to the layout in the usual way. It should show your profile. Set the scale and size so that the profile shows as you wish it to. If you want it to match your main map, set both to the same scale.
Adding labels and a grid
Experiment with the usual map elements to see how you can annotate your profile graph.
· To add labels to the axes and lines on the graph add a grid to the window in the usual way.
· You can set the grid interval in the usual way. For a section setting it to 100 metre intervals may work best, but experiment to see what works best for you.
· You can Draw Coordinates on just the axes that you want to.
· Use the Extents on the Item properties for the map to control the lengths of the axes. For example, you can set Y min to 0 to set the scale to start at sea-level.
· Use the Add labels button to add a title and axis labels.
· Add a legend containing only the profile lines to show which is which.
· Don’t forget to Lock layers on the Item Properties to prevent the profile from being changed when you move to other layers.
[image: images/three_d/Profiles_small.png]
A map and profile created within a layout in QGIS. Note that if you set up the profile this way it is simple to set the map and profile to the same scale.
Viewing 3D topography in QGIS
Sometimes being able to view your data in relation to the land surface can really help you to interpret it. QGIS has a plugin which is an effective and simple way of allowing you to do this.
Recently QGIS has gained an inbuilt 3D map viewer. It is being actively developed as of August 2021 and the version in 3.20 of QGIS has more functionality than the version in the Long Term Release (currently 3.16), but for now the plugin I show you below is more reliable. The inbuilt 3D viewer is worth keeping an eye on in future, though.
Installing the Qgis2threejs plugin
You can install the Qgis2threejs plugin in the same way you’ve used for other plugins.
· Open the plugin manager by going to Plugins > Manage and install plugins
· Go to the Not installed tab and search for Qgis2threejs then install the plugin.
[image: images/three_d/Qgis2threejsInstall_small.png]
Installing the Qgis2threejs plugin from the plugin manager.
Creating a 3D view
[image: images/svg/warning-black-24dp.png] Warning
Note that if you have already run the QGIS internal 3D viewer you will need to close it, then close QGIS completely and reopen your project before you run the Qgis2threejs plugin.
To open the plugin:
· Either click on the new button on the toolbar (a triangle symbol)
[image: images/three_d/Qgis2threejsButton_small.png]
The Qgis2threejs button on the toolbar.
· Or go to Web > Qgis2threejs > Qgis2threejs Exporter on the menu bar.
[image: images/svg/videocam-black-24dp.png] Viewing a map in 3D with the Qgis2threejs plugin
This video clip can be found in the module area of Minerva or in the full list of video clips.
The window that opens will have a blank main window and a list of the layers in your map on the left.
· Under the DEM heading in the layers on the left, click to put a tick next to the hbefore layer.
Your map should appear and should already be shown as a 3D view with any layers that you have visible on your main map, visible on this one too.
[image: images/three_d/Qgis2threejsInitialView_small.png]
The Qgis2threejs exporter showing the ticked DEM layer on the left and the map in a 3D view on the right.
· Use your mouse to navigate in the scene. The mouse wheel will let you zoom in and out. If you left-click on the map you get a pop-up menu with the coordinates at that point and an option to zoom in to that point or orbit around it (press Esc to stop orbiting!). Just have a go and see what happens!
· You can also use the navigation tool at the bottom right of the 3D map view - if it isn’t visible go to View > Widgets > Navigation widget and put a tick in the box next to it. It’s a bit limited, but try clicking on one of the coloured dots to see what happens.
[image: images/three_d/Qgis2threejsNavigationWidget_small.png]
The navigation widget showing the orientation of the main axes.
· Press F5 (reset) to get back to the original view.
· To change the vertical exaggeration go to Scene > Scene settings.... Set the Vertical exaggeration to 3 and click Apply to see what happens. Use this setting with care. For a scientific map it’s usually best to stay at 1.0 vertical exaggeration which is the same as the real world.
The DEM settings
There are other settings that you can experiment with.
· Right-click on the DEM layer (hbefore) in the left-hand panel.
· Click on Properties.
Some of the settings here control the quality of the output image.
· Raising the Resampling level increases how much of the data from the original DEM QGIS uses to render the 3D effect. Raise with care - the higher the setting the longer it will take the 3D view to draw. With a lower resolution DEM (such as the Mount St Helens one) this may not make much difference as the more detailed data isn’t there to be resampled.
· If you zoom in to the 3D map it may not look particularly good quality. To increase the quality you can increase the setting for the Texture width (px).
· Try typing 2048 into the box, click Apply and have another look at the map view. For the hbefore and hafter layers you may not see a lot of difference because they aren’t particularly high quality to start with.
· Again, be careful how high you set this - higher numbers will make the 3D view take longer to draw.
[image: images/three_d/Qgis2threejsDEMProperties_small.png]
The DEM Properties panel showing the alterations you can make to the output quality.
Draping an aerial view on the 3D view
Aerial and satellite images can look very effective viewed in 3D.
· Close the 3D window to go back to your main map.
· Use the instructions under XYZ Tile maps in QGIS to add the Bing Aerial XYZ tiles to your Browser panel, then add them to your Mount St Helens map so that they are at the top of the list of layers.
· Open the Qgis2threejs Exporter again and this time tick next to hafter rather than hbefore - untick hbefore too.
· Open the Properties for hafter and set the Texture width (px) to 2048. This makes a noticeable difference to the imagery layer. If you have a powerful computer you could even try 4096. Don’t rush it, though!
[image: images/three_d/3DView_small.png]
The Bing satellite layer draped over the hafter DEM in Qgis2threejs.
Have a look around the result. This is an aerial imagery layer, but you could do the same thing with geological maps or other data layers. For example, try downloading the Geologic map of Mount St. Helens, Washington prior to the 1980 eruption. It’s available as a Compressed GeoTiff from the link and you will be able to unzip that and add it to your map. For that map use the hbefore layer as the DEM height data.
Exporting an image
Once you have a view that shows your data in a way that will enhance the interpretation, you can export it as an image. The image can then be included in reports and map layers in the usual way.
From within the Qgis2threejs window:
· File > Save scene as... > Image (.png)
· You can change the output size here if you wish, then click on Save.
[image: images/three_d/3DExport_small.png]
A view of Mount Saint Helens exported as an image from Qgis2threejs.
Saving a 3D scene as an interactive web page
One of the fun things about Qgis2threejs is that you can export the 3D scene in a way that can be interactively viewed by anyone with an up-to-date web browser. In fact, this was originally the main point of this plugin.
· Go to File > Export to Web...
· Next to Output Directory click on Browse... to browse to the folder where you want to save the web output. I’d suggest you make a new folder within the project folder and call it something like Web.
· Leave the HTML Filename as index.html
· If you wish, enter a Page Title which briefly says what your scene shows.
· Tick next to Enable the Viewer to Run Locally.
· Then click on Export.
[image: images/three_d/3DExportToWeb_small.png]
The Export to Web settings.
Once you’ve done this a set of new files will appear in the folder that you selected, and you’ll see the Log which gives you a list of folders as links.
[image: images/three_d/3DExportToWebLog_small.png]
The Log for Export to Web showing the output folders as clickable links.
Depending on your default web browser, you should be able to click on the link next to Web page file to open a view which looks very like the one you have in Qgis2threejs.
You can also double-click on index.html in the folder.
You can share this with people who don’t have GIS by giving them the whole folder of files and telling them to click on index.html. Do be aware that the data in these is still liable to copyright, though. In particular, data from Digimap shouldn’t be shared with anyone who isn’t a member of UK Higher Education and signed up to the Digimap terms and conditions.
Final output for this chapter
The output for this chapter can be a series of profiles and three-dimensional views of Mount Saint Helens which have been added to a layout along with two-dimensional maps of the mountain before and after the eruption of May 1980.
The profile showing both profile lines can either be included as an image, or as if it is a map, if you tried that out. The 3D views will need to be exported from the viewer as images and imported into the layout.
Export your layout as a pdf or image file and upload it to your GIS portfolio. Alternatively you can upload the exported images separately, but it would be good to see them properly laid out.
If you upload your output in the next week or so I will provide brief feedback on your work.
[image: images/three_d/FinalLayout_small.png]
Example of final layout for this chapter. You can also output individual images or profiles.
Recommended reading: Elevation and 3D mapping
The general books in the module reading list[footnoteRef:1570] include sections on elevation and 3D mapping. [1570:  Reading list available from Minerva and from the module catalogue.] 

· For a quick overview look at Darkes (2017) - pages 46-47 look at Relief.
· Heywood (2011) has a section on Modelling the Third Dimension on pages 99-100.
· Longley (2015) covers User Interation and Representation in 2.5-D and 3-D on pages 282-284.
Further information
· For a video on the qProf plugin see Topographic Profile Graphs with qProf in QGIS on YouTube.
· If you want to find out more about Qgis2threejs see the tutorial by Alasdair Rae.
Dynamic / time data in GIS
Last Modified: 02 Jan 24, 11:46:15
Checked in QGIS version 3.30.
The background to using dynamic or time data in GIS to create an animation will be covered in the lecture, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[image: images/svg/info-black-24dp.png] Optional chapter
Note that this chapter is optional. It adds to your knowledge and experience of GIS and is an engaging way to display and analyse data, but it is not essential.
If you are enjoying the GIS and have time in the final practical, then try working through this or the previous chapter on viewing 3D data to explore some fun techniques and different data.
If you don’t have the time, then don’t feel you have to do this chapter now. If you’re aware these techniques are possible, you can come back to this chapter in the future.
Learning outcomes
When you have completed this section of the workbook you will be able to
· Explore data which includes a dynamic, time component as well as a spatial component.
· Display dynamic data with GIS and graphics tools to demonstrate patterns in time in an engaging fashion.
Introduction to dynamic or time data in QGIS
For most of this course we have been looking at data which displays what is happening at a single moment in time. Many datasets have an additional component - time. If we can display time in GIS it becomes possible to analyse changing patterns. This can be done with a series of static maps, or it is possible to link time series together into an animation. This chapter covers a simple example, but does demonstrate how to generate an animated gif that can be shared with your audience and which can engage them effectively with your data.
Data
We’ll use data from the ArcGIS Living Atlas for these exercises.
Finding dynamic data in ArcGIS Living Atlas
· Go to the web page for the ArcGIS Living Atlas and search for “Recent earthquakes” 
· The list you find should include a “Feature Service” called “Recent Earthquakes” by “esri_livefeeds2”. This is earthquake information covering the world from the USGS (United States Geological Survey).
[image: ../../shared/docs/images/dynamic/ArcGISTile_small.png]
The Recent Earthquakes layer in the ArcGIS Living Atlas of the World.
· Click on the title to go to the web page about the layer. Have a look at the information you are given. In particular look at the sections titled “Consumption Best Practices” and “Update Frequency”.
Adding an ArcGIS Living Atlas layer to QGIS
Instructions for adding data to QGIS are in the optional section on ESRI Living Atlas in the chapter on Finding spatial data to use in GIS but I’ll include brief instructions here too.
· If you want to check what the layer looks like, click the Open in Map Viewer button at top right. Zoom in and out and pan around to check the map.
· Once you are happy that this is the layer you want to use, return to the page containing the information about the layer.
· Look for the URL field, which is usually at the bottom right of the page.
· Hover over the right-hand side of the URL box and click to copy the URL.
Now go into a new map in QGIS.
· In the Browser panel, scroll down to find ArcGIS REST Servers heading. Right-click on the heading and choose New Connection....
This will open a dialog box.
· Fill in the Name as Recent earthquakes (or something which will remind you what the connection is in future).
· In the URL box paste the URL you copied from the Living Atlas web page.
· You don’t need to fill in any further information.
· Click on OK to add the server connection to QGIS.
[image: ../../shared/docs/images/dynamic/ArcGISConnection_small.png]
Adding a connection to an ArcGIS REST Server to QGIS.
You won’t see any changes to your map at this stage, so carry on to the next instructions.
Setting up your map
Once you have added the link to the data feed to the browser in QGIS, look for the two layers available beneath the “Recent earthquakes” heading. You should find a point layer for “Events by magnitude” and a polygon layer for “Shake Intensity”.
· Add the Events by magnitude layer to a new map. Be patient and don’t keep trying to click on things, it can take a while for this layer to load.
· Add a world background by typing “world” into the coordinate box at the bottom of the map window. This should give you a basic map of the countries of the world.
· Save your map to your disk space and with a name that tells you what it contains.
[image: ../../shared/docs/images/dynamic/InitialMap_small.png]
QGIS with the Events by Magnitude and world layers added (your colours and locations of earthquakes may vary). Note the clock symbol next to the earthquake layer in the Layers panel.
This initial earthquakes layer has a clock icon next to it in the layers panel which means it is Temporal data - that is, it includes a date/time field.
· Export the layer to save to a new GeoPackage in the same folder you saved your map into (don’t change the CRS). It causes less server load to keep the data locally and will save you time if QGIS doesn’t keep checking for updates over the web. We don’t need this to keep updating. Don’t worry if the clock icon disappears for the exported layer, we’ll sort that out later.
· Once you’ve exported it, Remove the live layer (the first one you added) from your map.
[image: images/svg/create-black-24dp.png] Explore your data and look for a date/time field
Explore your data by looking at the map and the attribute table.
• What fields will allow you to style by magnitude or depth?
• Is there a column that gives you date and/or time, i.e. temporal, information?
Check the Fields tab in the layer properties. Does the date/time field you’ve picked out have a data type of Date & Time? If so, you can use that field to animate your data.
After looking at the data, the field I’ve picked out to use for date and time is the field titled eventTime.
· Open the attribute table again, sort the date/time column by clicking on the heading and make a note of the earliest and latest dates in your data.
Mine runs from 07/09/2023 to 01/12/2023, but yours will be different to that as it depends on the date you’ve downloaded it.
[image: images/svg/help_outline-black-24dp.png] What are the earliest and latest dates of your data?
Make a note here:
Style the earthquake data
The earthquake data will be a single colour when it is first added to your map, but it is possible to style it to be far more informative.
· Use the mag column to apply a Graduated style to your earthquake data. It’s your choice between graduated colour and graduated size. Which do you think will show this data best?
· Try out some of the Modes, such as Equal interval or Natural breaks to see which shows the variation in earthquake magnitude best on your map.
Setting up Temporal Control
Once you have the data in your map project you can start setting it up to appear dynamically by using the Temporal Controller.
· Open the Layer properties for the earthquakes layer.
· Go to the Temporal tab from the list on the left.
· Click next to Dynamic Temporal Control to activate for this layer.
· If you click Apply now, the little clock icon should appear next to the layer in the Layers panel.
[image: ../../shared/docs/images/dynamic/ClockIconAnno.png]
The Clock icon next to the earthquakes layer in the Layers Panel.
This dialog controls many of the temporal settings for this layer.
· Set Configuration to Single Field with Date/Time - as this matches the field in our layer.
· Set Limits to Include Start, Exclude End (default) - this makes sense for the earthquake data which only has a single date/time.
· Check that Field is set to the field you selected above - in this case eventTime.
· You can choose Event duration depending on how long you think each feature should stay on your map. Given that earthquakes are not long-lasting events, I’m going to set it to 5 minutes in the first place so features don’t stay on the map for too long. You can easily change this later.
· Accumulate features over time means that once a feature has appeared, it stays on your map. I’m going to leave that unticked for now, but again you can change this later.
· Click OK to apply the settings and close the properties window.
[image: ../../shared/docs/images/dynamic/LayerTemporalProperties_small.png]
The Temporal properties window for the earthquakes layer.
Next we need to set up the Temporal Controller panel.
· Either click the Temporal Controller button on the toolbar or go to View > Panels and tick Temporal Controller. The panel should open across the top of your map.
[image: ../../shared/docs/images/dynamic/TemporalController01_small.png]
The Temporal Controller panel when it first opens.
Initially the Temporal Controller will be disabled.
· To enable the Temporal Controller, click on the right-hand button - the one with the small green arrow.
The full range of settings should appear and you should notice fewer symbols on your map.
[image: ../../shared/docs/images/dynamic/TemporalController02_small.png]
The activated Temporal Controller panel with controls to play the dynamic visualisation.
Try out some of the controls:
· You can move the slider manually to see earthquakes at different times.
· Press the Play button to play the animation at the rate controlled by the Step controller.
· Try changing the Step control from the initial value of 1 hours to 1 days.
Changing the rate should speed up the animation as each step (or “frame”) covers a longer period.
If you look at the original ArcGIS Living Atlas page for this data, the Update frequency information tells you that events are available for up to 30 days, but some events are kept for longer.
This means that the data doesn’t have so much coverage more than 30 days before the day you downloaded it.
To get a better idea of the frequency of earthquakes over the last 30 days:
· Set the Animation range so that the first date is 30 days before the last date.
Now try “playing” the animation, it should show just the more complete data.
Adding information to the map with Decorations
To export this data you won’t be able to set up a layout. You’ll be exporting images directly from the map canvas. This means you won’t be able to use the usual layout tools to add extra elements, such as a title.
Instead you can use “Decorations”.
Adding a dynamic title
Let’s start by adding a title which includes the current date of your data:
· Go to View > Decorations > Title Label.
· When the Title Label Decoration window opens, click next to Enable Title Label.
· Type the title you want in the text box, e.g. “Recent earthquakes”. Don’t put a date in yet.
As this view is dynamic, it makes sense to get the dates dynamically from the animation.
· Click on Insert or Edit an Expression.
· At the top of the central box type “time” to seach for time-related expressions. Use the results to compile the following expression in the left-hand box:
format_date( @map_start_time, 'd MMMM yyyy' )
[image: ../../shared/docs/images/dynamic/TitleDateExpression_small.png]
Compiling the expression to display the current date on your animation.
Check below that the Preview is a correctly formatted date, then click on OK to apply it.
· In the Title Label Decoration panel, choose a font, background colour etc for your title.
· Apply allows you to try out what your are setting.
· Select OK once you are happy with it.
[image: ../../shared/docs/images/dynamic/TitleLabelDecorationSettings_small.png]
The Title Label Decoration Settings.
Your title should appear in the location that you’ve chosen on your map window.
Try changing the map with the time slider again. The date should change to show the current date of the data.
Adding copyright information
To add copyright information:
· View > Decorations > Copyright label.
This works in a very similar way to the title, but this time you won’t need to add any dynamic text, so just have a go. You will find information about Credits (Attribution) on the ArcGIS Living Atlas page for this data. If in doubt, add the URL too.
You can add other decorations in this way, but for this map you shouldn’t need to.
Don’t forget to save your map!
[image: images/svg/create-black-24dp.png] Check your animation
Try pressing the Play button on the Temporal Controller and check that everything is working as it should be and you are happy with the speed of animation.
[image: ../../shared/docs/images/dynamic/MapInQGIS_small.png]
The final layout in QGIS with a title and copyright information.
Creating an animated gif to share
Being able to play a dynamic map in QGIS will enable you to spot patterns in time and place, but this will be even more usful if you can export the animation in some way to share with people who don’t have QGIS. Luckily you can.
There are various ways to do this. I’m going to show you how to use entirely open-source software (QGIS and The GIMP), to create an animated gif.
Exporting the dynamic view as frames
The Temporal Controller allows you to save your map as an image for each time step.
Check that your map is set up as you want it to be in QGIS, with the time step set to something that allows changes in your data to be seen relatively quickly. You don’t want this to take too long to run!
To export the images:
· Create a new folder in your map project folder to hold the resulting images.
· In the Temporal Controller Panel, click on the disk icon next to the time period to Export Animation.
· Check the Template, which is the name your output files will have. The #### indicates that the files will be numbered in the order they are generated.
· Select the Output directory as the folder you’ve just created.
· Extent can be a layer, so in this case select the events_by_magnitude layer to keep the size down a little (your extent and output size may vary from the example below because your data may be different).
· You don’t want the output images to be too large, as you need to keep down the size of the final animated file. If your Output width and Output height are both below 1500 px, don’t worry about changing them. Otherwise:
· Click the padlock symbol to the right of Output width and Output height.
· Set the higher of the two numbers to something like 1500 px. The other number should reset automatically in proportion.
· You can experiment with this when you see the final output.
· Make a note of the Output width and Output height - you’ll need these later.
· Tick to Draw active decorations: title label, copyright label (and any others you chose to add).
· Check the Range and the Step.
· Then click Save to export the multiple files.
[image: ../../shared/docs/images/dynamic/ExportMapAnimation_small.png]
The settings to export individual frames for your map animation.
· Wait for the export to complete, then check the images that have been generated. For example, are you happy with the extent?
If necessary, you can delete these, change the settings and generated another batch.
· Save your map and close QGIS.
You’ll need to know the pixel size of your images. If you didn’t make a note of it when exporting the images in QGIS:
· In My Computer, right-click on one of the images and go to Properties.
· Click on the Details tab and look for Dimensions.
[image: images/svg/help_outline-black-24dp.png] What is the pixel size of your images?
Make a note of the Width and Height here:
Obtaining GIMP
· Within the University, or on Windows computers, GIMP 2.10.32.1 is available via AppsAnywhere. Go to AppsAnywhere, search for GIMP, and load in the usual way. These instructions assume version 2.10.32.1 but should work in any higher version.
· GIMP is open-source software and can be installed on Windows, Mac and Linux. GIMP web page.
Creating the animation in GIMP
The instructions below are based on a tutorial on how to create an animated GIF.
· Open GIMP.
· Create a new image - File > New then enter correct size (refer to pixel size of images). Set X resolution and Y resolution under Advanced Options (you’ll probably need to click on it to get the options) - don’t make it too high! 95 dpi should be fine, and keep both the same.
· Click OK to create the new image.
[image: ../../shared/docs/images/dynamic/GimpCreateNewImage_small.png]
Creating a new blank image in GIMP. Your Width and Height will be different - use the sizes you made a note of above.
Now you can add your images to the blank GIMP canvas.
· Add images as “frames” starting with the first image at the “bottom” of the layers.
· You should be able to just drag and drop images from My Computer onto the canvas (not the layer panel!) and each one is added as the next layer up. Select all images in your Explorer by using the short cut Ctrl-A.
· The Layer panel should be visible on the right of the window. If it isn’t, open it with Windows > Dockable Dialogs > Layers.
· Check that all your images are in numerical order with the lowest at the bottom and the highest at the top.
· In the layer panel, right-click on the background layer and Delete layer.
[image: ../../shared/docs/images/dynamic/GimpLayerPanel_small.png]
The order of your images as layers in the layer panel in GIMP. You may not have the same number of images, that doesn’t matter.
· Save the image in the same folder as your map. This will save as an .xcf document.
· To keep size down you can use an indexed colour mode instead of RGB. Image > Mode > Indexed. Stick to defaults for now! For some images this won’t make much difference.
To export the animation
· File > Export As - give the output a name and append .gif as the extension, e.g. EarthquakesAnimation.gif. Just type to replace whatever is there when you open the dialog.
· Then click Export.
· In the dialog that opens choose options as follows:
· Select As animation by ticking in the box next to it.
· Untick GIF comment:, unless you want to add a comment of your own…
· Frame disposal where unspecified should be set to One frame per layer (replace)
· Tick both Use delay entered above for all frames and Use disposal entered above for all frames.
· Change Delay as required to change speed of animation - try starting with something like 300 milliseconds. You don’t want the animation to be too quick!
· Click Export to export the animated gif.
[image: ../../shared/docs/images/dynamic/GimpExportImage_small.png]
The dialog to export an animated gif from GIMP.
Wait while GIMP exports the file - it may take a bit of time so be patient!
You should be able to open the resulting .gif file in a graphics program to check it. It should automatically run when you open it.
[image: images/svg/info-black-24dp.png] Opening an animated gif on Windows
If you don’t have a graphics app that will open the gif and show the animation, try dragging and dropping the .gif file from My Computer into the address bar of your web browser. Depending on security settings, this should work in Edge, Firefox or Chrome.
· Are you happy with the speed?
· To change the speed, Export from GIMP again, changing the Delay as required. I found I needed to change it to 600 milliseconds to slow down the speed.
· What is the file size of your final file?
· If it’s too large, and takes too long to export or crashes GIMP when you do, you may need to export the images from QGIS again, but reducing the height and width as you do so.
[image: ../../shared/docs/images/dynamic/EarthquakesAnimation.gif]
My final animated map of recent earthquakes.
GIS Reading List
Compiled August 2023 for academic year 2023-24.
GIS basics
Heywood, I., Cornelius, S. and Carver, S. 2011. An Introduction to Geographical Information Systems [Online] 4th ed. London: Pearson Prentice Hall. Available from: https://leeds.primo.exlibrisgroup.com/discovery/search?query=any,contains,991012919319705181&tab=AlmostEverything&search_scope=My_Inst_CI_not_ebsco&vid=44LEE_INST:VU1&offset=0.
Longley, P.A., Goodchild, M.F., Maguire, D.J. and Rhind, D.W. 2015. Geographic Information Science and Systems [Online] 4th ed. New York: Wiley. Available from: https://leeds.primo.exlibrisgroup.com/discovery/search?query=any,contains,991019433304805181&tab=AlmostEverything&search_scope=My_Inst_CI_not_ebsco&vid=44LEE_INST:VU1&offset=0.
QGIS-specific instruction
There are lots of online resources for using QGIS. If you want more information then I’ve given in the workbook, or need to do something that isn’t covered here, try some of these.
· QGIS Tutorials and Tips from Ujval Ghandi at Spatial Thoughts. Spatial Thoughts OpenCourseWare includes introductory and advanced courses for QGIS.
YouTube is a fantastic resource for information about specific techniques in QGIS and I’ve referenced several in the course of the workbook. You do, however, need to be careful about the videos you choose to follow, and about the versions of QGIS they use to demonstrate techniques. I have found the following channels to be reliable, informative and regularly updated.
· Hans van der Kwast - Open Educational Resources from an Associate Professor at IHE Delft Institute for Water Education.
· Map Academy - short, straight-to-the-point videos by Alasdair Rae.
· Spatial Thoughts - videos to go with the open GIS courses by Ujval Ghandi. Not all of this channel is about QGIS, but there are still lots of useful videos.
Principles of Cartography
Spence, M. and Darkes, G. 2017. Cartography: an introduction Second edition. London: British Cartographic Society.
A short guide to the basic principles of cartography. It is pretty well a revision guide to the principles of GIS.
I’m not marking this as core because it isn’t available online, but if you’re going to buy just one book about GIS this is the one to go for. Available only from the British Cartographic Society. £12 + £2 p+p.
University of Delft IHE open course on Creating data visualisations with graphs, maps and animations.
GIS for Geology and Environment
Wright, D.J. and Harder, C. (eds.). 2019. GIS for Science: Applying mapping and spatial analytics. Redlands, California, USA: Esri Press. [Accessed 27 May 2021].
A book of case-studies and examples backed up by an impressive range of online resources at https://www.gisforscience.com/ .
Coordinate Systems and Projections
Monmonier, M.S. 2004. Rhumb lines and map wars: a social history of the Mercator projection. Chicago, Ill.: Univ. of Chicago Press.
A readable look at map projections taking the “war” between the Mercator and Peters projections as a starting point.
Inspiration and examples
ESRI 2011. ESRI Conservation Map Book. Redlands, California, USA: ESRI.
Examples of maps produced with ArcGIS - though the software isn’t really relevant. Have a browse and see examples of maps that ESRI consider are “best practice”.
ESRI n.d. ESRI Map Book Gallery. ESRI Map Book Gallery. [Accessed 29 June 2021].
Guerrilla Cartography n.d. Guerrilla Cartography. Guerrilla Cartography. [Accessed 5 July 2021].
PDF atlases available to download - so far atlases around the subjects of Food and Water.
Hebridean Whale & Dolphin Trust n.d. Hebridean Marine Mammal Atlas. Hebridean Whale & Dolphin Trust. [Accessed 18 October 2018].
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